






























































































































































































































































































































































































































































































































































































































































































































































































































Using ResEdit 393 

Type in the hex in Figure 8.51. As you're typing, alphanumeric charac­
ters will appear on the right. When you're done, click on the close box. 
Change the ID of the resource by choosing Get Info from the File menu. 
Change the ID to 0. Build the second C 0 DE resource with the hex in Figure 
8.52. Change the resource ID number of the second COD E resource ID to 1. 
Finally, build a WI ND resource with a resource ID of 400. Use any size or 
window type that you prefer, but make sure that the Vis i bl e and 
goAwayFl ag checkboxes are checked. Save the WI ND and the two CODE 
resources. 

You now have an application. If you double-click on Minimalist, it will 
display the window you created. Clicking anywhere on the screen will 
return you to the Finder. 

r s File Edit Find 

Hord Disk 
D THINK C 

src 
Dra--.=================== 

Minimalist 
DD 
D D COOEs from Minimalist 

D D D c CODE ID = 19514 from Minimalist 
D D 000000 
,,. D 000000 
""' 000010 

D 000010 
D D 000020 

000028 
D D 000030 

000038 
D 000040 

000048 
000050 
000058 
000060 
000068 

Figure 8.50 Blank C 0 0 E resource in Minimalist. 

§0 CODE IO = O from Minimalist 
000000 0000 0028 0000 0200 DDD <DDDD 
000008 0000 0008 0000 0020 aaaaaaa 
000010 0000 3F3C 000 1 A9FO DD?< 0090 
0000 18 
000020 
000028 
000030 
000038 
000040 
000048 
000050 
000058 [§ 000060 
000068 Q] 

Figure 8.51 Minimalist's CODE 0 resource. 

., 
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§0 CODE ID = 1 from Minimalist 
000000 0000 0001 4860 FFFC DDDDHmDD ~ 000008 A86E A8FE A912 A850 it)nit)OSIDilP 
000010 594F 3F3C 0190 42A7 YO?<DeBll 
000018 2F3C FFFF FFFF A9BD /<DDDDSIQ 
000020 554F A974 4A1F 67F8 UOSltJDgD 
000028 A9F4 SID 
000030 
000038 
000040 
000048 
000050 
000058 ; 000060 
000068 

Figure 8.52 Minimalist's C 0 DE 1 resource. 

To get the C 0 DE hex, we wrote a short assembly language program that 
does initialization, draws a window, and quits on a mouse click. Here's the 
code: 

include 'Traps.a' 
main 
pea -4(A5) 
_InitGraf 
_InitFonts 

InitWindows 
InitCursor 

subq #4.sp 
move #400,-(sp) 
clr.l -<sp) 
move.l #-1.-<sp) 
_GetNewWindow 

Try Button 
subq #2.sp 
_Button 
tst.b (Sp)+ 
beq.s TryButton 

ExitToShell 

end 

We don't, in general, recommend this strategy for program development. 
It's best to leave CODE resources to THINK C. 



_J In Review 

Chapter 8 discussed the steps necessary to install the Finder resources into 
your applications. It provided a tutorial for new ResEdit users. 

Chapter 9 discusses the issues you'll face as you start developing your 
own Macintosh applications. We'll start by taking a look at a few Mac 
periodicals you may find useful. We'll talk about Inside Macintosh and 
other Apple technical references. We'll look at Apple's support apparatus 
for Macintosh programmers and developers. 
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The Final 
Chapter 

To successfUlly develop software for the 
Macintosh, you need current technical in­

formation. You need to know how to use 
the standard Macintosh references effec­

tively. You also need to know about the 
different technical support programs 

Apple offers. In this chapter, we'll 
discuss these and other Macintosh 

development issues. 
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THE BASICS OF programming the Macintosh have been laid out in the eight 
preceding chapters. Familiarity with these basics is half the job of becom­
ing a successful developer. The other half is understanding how the 
Macintosh programming world works and knowing where to get the 
information you, as a Macintosh software developer, will need. 

To succeeed in developing software for the Macintosh, you need current 
technical information. You need to be able to use the standard Macintosh 
references effectively. You also need to know about the different technical 
support programs Apple offers. 

In this chapter, we'll investigate the periodicals that are your link to the 
Macintosh community. We'll look at Inside Macintosh and other Mac 
technical texts. We'll look at software tools, from compilers to debuggers. 
We'll also examine Apple's support programs for Macintosh software 
developers. 

The Macintosh Programming Primer is your passport to Mac application 
programming. When you've finished reading this book, join a local Macin­
tosh user's group, and buy a copy of the best Mac programmer's magazine, 
MacTutor. Get involved and write some code! 

Macintosh Periodicals 

Whether you're interested in making a commercial product or a shareware 
product, or just want to know the inside stories of the Mac community, get 
the trades. Mac Week is great, and PCWeek and Info World are good, ifless 
oriented to the Macintosh computer line. All three magazines deliver 
timely dollops of news: the new software packages, scoops on company 
goings-on, and juicy industry gossip. 

The Macintosh programming journal is MacTutor, an invigorating 
monthly discourse on the art of Mac programming. Popular Mac magazines 
includeMacUserandMacWorld.Theirbroadviewpointcanshowyouwhat 
is of interest to Macintosh users, and what's available. 

While you wait for the idea that will make you the seventh richest person 
in the world, you need to learn the Macintosh inside out. To do this, you 
need Inside Macintosh. 

The Essential Inside Macintosh 

The Inside Macintosh technical reference series is written by Apple and 
published by Addison-Wesley. There are six books in the Inside Mac series 
(Volumes I-Vand the Inside MacintoshX-Ref). In Chapter 1, we suggested 
that you could get by with Volumes I and V. 
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We lied. Get them all. 
Volumes I, II, and III represent the Mac technical world as it was before 

the Mac Plus was introduced. All three volumes focus on the original 128K 
Mac, describing interfaces to the ROM routines, memory management, 
hardware specs, and more. 

Volume IV was released after the Mac Plus and the Mac 512KE were 
introduced. Both of these new Macs sported 128K RO Ms (as opposed to the 
128K Macintoshes' 64K ROMs). These larger ROMs contain the routines 
that handle the new, hierarchical file system (HFS), routines that interface 
to the SCSI (Small Computer System Interface) port, and updates to most 
of the 64K ROM routines. Volume IV covers all these changes. 

Volume V was released after the introduction of the Mac SE and the Mac 
II. The Mac II and the SE have 256K ROMs and support features like pop­
up, hierarchical, and scrolling menus; a sophisticated sound manager; new 
text edit routines; and more. Perhaps the biggest change of all was the 
addition of color support to the Mac II ROMs. Volume V covers both the Mac 
SE and the Mac II. 

The Typical Inside Mac Chapter 

One of the best features of the Inside Mac volumes is their consistency. 
Each chapter starts with a table of contents, followed by the "About This 
Chapter" section which gives an overview of what the chapter covers and 
what you should already be familiar with before you continue. 

The next section or sections give an overview of the chapter's technical 
premise-for example, "About the Event Manager" or "About the Window 
Manager." The fundamental concepts are explained in great detail. At first, 
you may be overwhelmed by the wealth of detail, but after a few readings 
(and a little experimentation), you'll warm to the concept. 

Then the chapter's data structures, constants, and essential variables 
are detailed. These are presented in Pascal and/or assembly language. 
ijack in Chapter 2, we presented a set of rules for translating Inside Mac's 
Pascal data structures and calling sequences into C. 

Next come the chapter's Toolbox routines. Each routine's calling 
sequence is presented in Pascal, along with a detailed explanation of the 
uses of the routine. This section includes notes and warnings, as appropri­
ate. 

Some chapters follow the Toolbox routines section with a few additional 
sections. Among these extras are a description of the resources pertinent to 
that chapter and, perhaps, a description of extensions available to the 
advanced programmer. 

Finally, there's a chapter summary, with its unadorned lists of con­
stants, data types, routines, and variables. 
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Appendices and Special Sections 

Inside Macintosh, Volume I, Chapter 1, contains a road map that gives you 
a feel for the basics of the Macintosh and how the Inside Mac volumes work. 
The road map suggests you read Chapters 1 through 4, then read the 
chapters that are relevant to your current development effort. This is sage 
advice. These chapters offer an excellent grounding in Mac basics (or an 
excellent review if you've been at it for awhile). 

Volume III contains three chapters, some appendixes, a glossary, and an 
index. Chapter 1 discusses the Finder (with an emphasis on Finder-related 
resources). Chapter 2 discusses the pre-Mac Plus hardware. Chapter 3 is 
a compendium of all the summary sections from Volumes I and II. Appendix 
A is a handy, if occasionally inaccurate, table of result codes from the 
functions defined in Volumes I and II. The rest of the appendixes in Volume 
III have been superseded by the appendices in the Inside Macintosh X-Ref. 

The Inside Mac X-Ref starts off with a general index covering all five 
Inside Mac volumes, the Macintosh Technical Notes, Programmer's Intro­
duction to the Macintosh Family, Technical Introduction to the Macintosh 
Family, and Designing Cards and Drivers for the Macintosh II and Macin­
tosh SE. The general index is followed by an index of constants and field 
names. Appendix A of theX-Reflists every Toolbox routine that may move 
or purge memory. 

AppendixB of Inside Mac consists of two lists. The first is a list of Toolbox 
routines presented alphabetically by name, with each name followed by the 
routine's trap address, which is the four-byte instruction the compiler 
generates to call the routine. The second is a list of the trap addresses, in 
order, with each trap address followed by the routine name. This informa­
tion is extremely useful if you ever have to look at code in hexadecimal 
format, a likely event if you use TMON or MacsBug, two Mac debuggers. 

Appendix C lists most of the operating system global variables, with 
their memory location and a brief description. Finally, Appendix C is 
followed by a glossary of terms presented in Volumes I through V. 

_J Apple Technical References 

In the first few years of the Mac era, Inside Macintosh was the only 
definitive reference on the Macintosh. Recently, however, Apple has pub­
lished some additional reference texts for the Macintosh, including Tech­
nical Introduction to the Macintosh Family, Programmer's Introduction to 
the Macintosh Family, and Designing Cards and Drivers for the Macintosh 
II and Macintosh SE. These books are all part of Addison-Wesley's Apple 



The Final Chapter 401 

Technical Library. Another excellent source of technical information are 
the Macintosh Technical Notes. 

Macintosh Technical Notes 

Macintosh Technical Notes are published on a regular basis by Apple and 
distributed to developers free of charge. The Tech Notes are a necessity for 
serious Mac developers. They contain technical information that was not 
yet available when the latest volume of Inside Macintosh went to press. For 
example, Tech Note #184 describes the Notification Manager (used in 
chapter 6). Without this Tech Note, developers wouldn't even know the 
Notification Manager existed, let alone know how to use it. 

A timely way to receive Tech Notes if you are not a developer is to become 
a member of APDA, the Apple Programmer's and Developer's Association 
(developers are automatically members of APDA). APDA charges $20 per 
year for membership and they sell most of the technical references men­
tioned in this chapter. They sell the Tech Notes in both hard copy and disk 
formats. For more information on APDA, contact: 

Apple Programmer's and Developer's Association 
Apple Computer, Inc. 

20525 Mariani Avenue, MS: 33-G 
Cupertino, CA 95014-6299 

APDA was formerly an organization independent of Apple and has just 
recently been returned to the fold, so changes in its operation may be 
imminent. 

If you're not either a developer of a member of APDA, you can still get 
Tech Notes by downloading them from Mac-oriented bulletin boards 
around the country. 

Other Books 

There are a number of excellent books on Mac programming. One of the 
most popular is the Macintosh Revealed series, written by Stephen Cher­
nicoff. Volume I of Macintosh Revealed dives right into the Toolbox, 
providing an in-depth tour of the Mac ROM routines. Volume II continues 
the exploration of ROM routines, and additional texts are planned. 

Another excellent reference is Scott Knaster's How to Write Macintosh 
Software. This book is little too advanced for the beginner, but it's worth the 
struggle to get through it. If you plan on writing a lot of Mac code, read this 
book. 
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We're also hard at work on a sequel to the Macintosh Programming 
Primer. We'll address concepts like color QuickDraw, I NIT s, CD EV s, and 
other interesting Toolbox routines with lots of examples and code 
walkthroughs. 

_J Apple's Developer Programs 

_J 

Apple has recently replaced the Certified Developer Program with the 
Apple Partners program. This new program provides additional technical 
support from Apple. Developers accepted into the new Apple Partners 
program receive complete Apple technical documentation, system software 
updates, membership in APDA, access to training classes, and discounts on 
Apple hardware and software. Developers also get a year's subscription to 
AppleLink, Apple's electronic communication network, and access to 
Macintosh Developer Technical Support (see below). However, the orginal 
Certified Developer yearly rate ($0) has also been enhanced to cover the 
services provided ($600). 

You don't have to be a Fortune 500 company to qualify as an Apple 
Partner, but Apple is looking specifically for developers of Apple hardware 
and software who intend to resell their products. It you are interested in 
developing software, but don't have an immediate plan to market it, you 
might consider the Apple Associates Program, a new support program from 
Apple. 

The Apple Associates Program is aimed at educators, in-house develop­
ers and shareware programmers. It provides a basic level of support, 
including AppleLink (one month prepaid), system software upgrades, 
APDA, Tech Notes, and access to other technical information. The Associ­
ates program has a yearly charge of $350. 

If you plan on writing a product for the Mac, the information that you 
receive in either program is invaluable. Call the Developer Programs 
Hotline at ( 408) 97 4-4897 and ask them to send you an application. 

As a developer, there's nothing more satisfying than talking to people 
who have solved, or at least are aware of the technical programs you 
encounter in writing programs. At Apple, these people come from Macin­
tosh Developer Technical Support, or MacDTS. 

Macintosh Developer Technical Support 
and AppleLink 

Macintosh Developer Technical Support is composed of talented Mac 
software engineers dedicated to helping developers with their technical 
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problems. To work with MacDTS, send them a message via MCI Mail. Or 
you can use AppleLink. 

AppleLink is Apple's electronic communication network. It gives access 
to information about Apple products, prices, programs, and policy informa­
tion. You can write to Developer Technical Support at MacDTS on Ap­
pleLink, and they will make every possible effort to answer your question 
within twenty-four hours. (If they can't solve the problem, they'll give you 
a very chic button to wear.) 

Both Apple Partners and Apple Associates receive subscriptions to 
AppleLink: Apple Partners receive a full year's subscription with the 
minimum monthly fees prepaid; Apple Associates receive one month of the 
minimum monthly fee prepaid. 

Besides access to MacDTS, AppleLink affords access to a lot of other 
services. You can download the new system utilities or look at the Help 
Wanted ads posted on the bulletin board. You can send beta versions of your 
products to your evangelist at Apple or to other developers. AppleLink 
makes you a part of the developer community. 

Software Development Tools 

All the applications presented in this book were written in C using the 
THINK C development environment from Symantec. The advantages of 
THINK C lie primarily in its ease of use and the THINK C Debugger. 
Symantec also makes a powerful, yet friendly, Pascal development environ­
ment called THINK Pascal. 

Both THINK environments are basically nonextensible. This means 
that you can't create shell scripts to back up your files automatically, or 
rebuild an older version of your project. You also can't create custom menu 
items that automate your development process. Lightspeed handles most 
of the development cycle so thoroughly that you may not miss these 
features. If you do, you may want to take a look at the Macintosh 
Programmer's Workshop (MPW) from Apple. 

MPW from Apple 

MPW is an extremely powerful developme.nt environment that is totally 
extensible-so extensible, in fact, that several third parties have produced 
compilers that run under MPW. MPW is like a Mac-based UNIX shell. You 
can write shell scripts, tie them to your own menus, and create tools that 
have total access to the Toolbox, yet run inside the Toolbox environment 
with access to all your data. The catch is that MPW is more complex than 
THINK C and, therefore, more difficult to master. MPW also is not cheap, 
typically costing more than three times as much as THINK C or Pascal. 
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Both MPW and THINK have a lot of followers and are supported by 
MacDTS. Whichever way you go, you'll be in good company. 

The THINK C Debugger, TMON, and MacsBug 

Debugging on any computer can be a tedious and frustrating experience. 
Luckily, there are some excellent tools that you can use to fix up your code. 

THINK C 3.0 comes with a source-level debugger. Assuming you use 
MultiFinder with at least two megabytes ofRAM, this debugger fits the bill 
for most bugs. We discuss its capabilities in Appendix D. 

MacsBug is an object-level debugger developed by Motorola for the 
68000 family of processors. For a long time, it was the only debugger 
available for the Mac. If, however, you need a little more horsepower, 
consider TMON. 

TMON is the pro's debugger. Instead of running as a separate program 
under MultiFinder, TMON takes over the processor when it runs. TMON 
preserves your program's run-time environment by not calling any of the 
Mac Toolbox routines (which might alter the state of your program). 
Instead, the folks at ICOM Simulations cleverly wrote their own window 
and menu handlers. Although TMON is somewhat difficult to learn, it's 
worth it. When you run into an exasperatingly unexplainable bug, pop into 
TMON and step through your program. You can set breakpoints, disas­
semble your executable image, and even make changes to your program 
and data. For debugging drivers, IN IT s, and DAs, TMON can't be beat. 

To Boldly Go 

The Macintosh world is accelerating. 
New hardware and software are being designed and marketed faster 

than ever before. Each successive system software version paves the way 
to wonderful things: multimedia, image processing, CD-quality sound, 
voice recognition. There's a feeling that everything is finally arriving. This 
vision may seem daunting, but remember-a few years ago, the Mac was 
an intriguing experiment; the people who gambled on it won big. 

The changes that Apple is making are setting the stage for machines that 
will be as big a jump as the Macintosh was from the Apple II line. In the Mac 
world, you're close to the edge. 

Enjoy it! 



Appendix A 

Glossary 
access path: A description of the route that the File Manager follows to 

access a file; created when a file is opened. 
access path buffer: Memory used by the File Manager to transfer data 

between an application and a file. 
action procedure: A procedure, used by the Control Manager function 

TrackControl, that defines an action to be performed repeatedly for as 
long as the mouse button is held down. 

activate event: An event generated by the Window Manager when a 
window changes from active to inactive or vice versa. 

active control: A control that will respond to the user's actions with the 
mouse. 

active end: In a selection, the location to which the insertion point moves 
to complete the selection. 

active window: The frontmost window on the desktop. 
address: A number used to identify a location in the computer's address 

space. Some locations are allocated to memory, others to 1/0 devices. 
alert: A warning or report of an error, in the form of an alert box, sound from 

the Macintosh's speaker, or both. 
alert box: A box that appears on the screen to give a warning or report an 

error during a Macintosh application. 
alert template: A resource that contains information from which the 

Dialog Manager can create an alert. 
alert window: The window in which an alert box is displayed. 
allocate: To reserve an area of memory for use. 
application font: The font your application will use unless you specify 

otherwise-Geneva, by default. 
application list: A data structure, kept in the Desktop file, for launching 

applications from their documents in the hierarchical file system. For 

Source: Inside MacintoshX-Ref© 1988 Apple Computer, Inc. Reprinted with permission of 
Addison-Wesley Publishing Company. 
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each application in the list, an entry is maintained that includes the 
name and signature of the application, as well as the directory ID of the 
folder containing it. 

application window: A window created as the result of something done 
by the application, either directly or indirectly (as through the Dialog 
Manager). 

asynchronous execution: After calling a routine asynchronously, an 
application is free to perform other tasks until the routine is completed. 

auto-key event: An event generated repeatedly when the user presses 
and holds down a character key on the keyboard or keypad. 

auto-key rate: The rate at which a character key repeats after it's begun 
to do so. 

auto-key threshold: The length of time a character key must be held 
down before it begins to repeat. 

background activity: A program or process that runs while the user is 
engaged with another application. 

bit image: A collection of bits in memory that have a rectilinear represen­
tation. The screen is a visible bit image. 

bit map: A set of bits that represent the position and state of a correspond­
ing set of items; in QuickDraw, a pointer to a bit image, the row width 
of that image, and its boundary rectangle. 

boundary rectangle: A rectangle, defined as part of a QuickDraw bit 
map, that encloses the active area of the bit image and imposes a 
coordinate system on it. Its top left corner is always aligned around the 
first bit in the bit image. 

bundle: A resource that maps local IDs of resources to their actual 
resource IDs; used to provide mappings for file references and icon lists 
needed by the Finder. 

button: A standard Macintosh control that causes some immediate or 
continuous action when clicked or pressed with the mouse. See also 
radio button. 

catalog tree file: A file that maintains the relationships between the files 
and directories on a hierarchical directory volume. It corresponds to 
the file directory on a flat directory volume. 

cdev: A resource file containing device information, used by the Control 
Panel. 

channel: A queue that's used by an application to send commands to the 
Sound Manager. 

character code: An integer representing the character that a key or 
combination of keys on the keyboard or keypad stands for. 

character key: A key that generates a keyboard event when pressed; any 
key except Shift, Caps Lock, Command, or Option. 

character style: A set of stylistic variations, such as bold, italic, and 
underline. The empty set indicates plain text (no stylistic variations). 

character width: The distance to move the pen from one character's 
origin to the next character's origin. 

check box: A standard Macintosh control that displays a setting, either 
checked (on) or unchecked (oft). Clicking inside a check box reverses its 
setting. 

Chooser: A desk accessory that provides a standard interface for device 
drivers to solicit and accept specific choices from the user. 
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clipping: Limiting drawing to within the bounds of a particular area. 
clipping region: Same as clipRgn. 
cl i pRgn:Theregion towhichanapplicationlimitsdrawingina g ra f Po rt. 
closed file: A file without an access path. Closed files cannot be read from 

or written to. 
compaction: The process of moving allocated blocks within a heap zone in 

order to collect the free space into a single block. 
content region: The area of a window that the application draws in. 
control: An object in a window on the Macintosh screen with which the 

user, moving the mouse, can cause instant action with visible results 
or change settings to modify a future action. 

Control Manager: The part of the Toolbox that provides routines for 
creating and manipulating controls (such as buttons, check boxes, and 
scroll bars). 

control definition function: A function called by the Control Manager 
when it needs to perform type-depend~nt operations on a particular 
type of control, such as drawing the control. 

control definition ID: A number passed to control-creation routines to 
indicate the type of control. It consists of the control definition func­
tion's resource ID and a variation code. 

control list: A list of all the controls associated with a given window. 
control record: The internal representation of a control, where the 

Control Manager stores all the information it needs for its operations 
on that control. 

control template: A resource that contains information from which the 
Control Manager can create a control. 

coordinate plane: A two-dimensional grid. In QuickDraw, the grid 
coordinates are integers ranging from -32,767 to 32,767, and all grid 
lines are infinitely thin. 

current resource file: The last resource file opened, unless you specify 
otherwise with a Resource Manager routine. 

cursor: A 16-by-16 bit image that appears on the screen and is controlled 
by the mouse; called the "pointer" in Macintosh user manuals. 

cursor level: A value, initialized by InitCursor, that keeps track of the 
number of times the cursor has been hidden. 

data fork: The part of a file that contains data accessed via· the File 
Manager. 

data mark: In a sector, information that primarily contains data from an 
application. 

date/time record: An alternate representation of the date and time 
(which is stored on the clock chip in seconds since midnight, January 
1, 1904). 

default button: In an alert box or modal dialog, the button whose effect 
will occur if the user presses Return or Enter. In an alert box, it's boldly 
outlined; in a modal dialog, it's boldly outlined or the OK button. 

default directory: A directory that will be used in File Manager routines 
whenever no other directory is specified. It may be the root directory, 
in which case the default directory is equivalent to the default volume. 

default volume: A volume that will receive I/O during a File Manager 
routine call, whenever no other volume is specified. 
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dereference: To refer to a block by its master pointer instead ofits handle. 
Desk Manager: The part of the Toolbox that supports the use of desk 

accessories from an application. 
desk accessory: A "mini-application," implemented as a device driver, 

that can be run at the same time as a Macintosh application. 
desk scrap: The place where data is stored when it's cut (or copied) and 

pasted among applications and desk accessories. 
desktop: The screen as a surface for doing work on the Macintosh. 
Desktop file: A resource file in which the Finder stores the version data, 

bundle, icons, and file references for each application on the volume. 
device driver event: An event generated by one of the Macintosh's device 

drivers. 
device driver: A program that controls the exchange of information 

between an application and a device. 
dial: A control with a moving indicator that displays a quantitative setting 

or value. Depending on the type of dial, the user may be able to change 
the setting by dragging the indicator with the mouse. 

dialog: Same as dialog box. 
dialog box: A box that a Macintosh application displays to request 

information it needs to complete a command, or to report that it's 
waiting for a process to complete. 

Dialog Manager: The part of the Toolbox that provides routines for 
implementing dialogs and alerts. 

dialog record: The internal representation of a dialog, where the Dialog 
Manager stores all the information it needs for its operations on that 
dialog. 

dialog template: A resource that contains information from which the 
Dialog Manager can create a dialog. 

dialog window: The window in which a dialog box is displayed. 
dimmed: Drawn in gray rather than black. 
directory ID: A unique number assigned to a directory, which the File 

Manager uses to distinguish it from other directories on the volume. 
(It's functionally equivalent to the file number assigned to a file; in fact, 
both directory IDs and file numbers are assigned from the same set of 
numbers.) 

directory: A subdivision of a volume that can contain files as well as other 
directories; equivalent to a folder. 

disabled: A disabled menu item or menu is one that cannot be chosen; the 
menu item or menu title appears dimmed. A disabled item in a dialog 
or alert box has no effect when clicked. 

Disk Initialization Package: A Macintosh package for initializing and 
naming new disks; called by the Standard File Package. 

disk-inserted event: An event generated when the user inserts a disk in 
a disk drive or takes any other action that requires a volume to be 
mounted. 

display rectangle: A rectangle that determines where an item is dis­
played within a dialog or alert box. 

document window: The standard Macintosh window for presenting a 
document. 
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double-click time: The greatest interval between a mouse-up and mouse­
down event that would qualify two mouse clicks as a double-click. 

draft printing: Printing a document immediately as it's drawn in the 
printing grafPort. 

drag delay: A length of time that allows a user to drag diagonally across 
a main menu, moving from a submenu title into the submenu itself 
without the submenu disappearing. 

drag region: A region in a window frame. Dragging inside this region 
moves the window to a new location and makes it the active window 
unless the Command key was down. 

drive number: A number used to identify a disk drive. The internal drive 
is number 1, the external drive is number 2, and any additional drives 
will have larger numbers. 

empty handle: A handle that points to a NIL master pointer, signifying 
that the underlying relocatable block has been purged. 

end-of-file: See logical end-of-file or physical end-of-file. 
event: A notification to an application of some occurrence that the appli-

cation may want to respond to. 
event code: An integer representing a particular type of event. 
Event Manager: See Toolbox Event Manager. 
event mask: A parameter passed to an Event Manager routine to specify 

which types of events the routine should apply to. 
event message: A field of an event record containing information specific 

to the particular type of event. 
event queue: The Operating System Event Manager's list of pending 

events. 
event record: The internal representation of an event, through which 

your program learns all pertinent information about that event. 
exception: An error or abnormal condition detected by the processor in the 

course of program execution; includes interrupts and traps. 
external reference: A reference to a routine or variable defined in a 

separate compilation or assembly. 
file: A named, ordered sequence of bytes; a principal means by which data 

is stored and transmitted on the Macintosh. 
file catalog: A hierarchical file directory. 
file control block: A fixed-length data structure, contained in the file­

control-block buffer, where information about an access path is stored. 
file directory: The part of a volume that contains descriptions and 

locations of all the files and directories on the volume. There are two 
types of file directories: hierarchical file directories and flat file direc­
tories. 

File Manager: The part of the Operating System that supports file 1/0. 
file name: A sequence of up to 255 printing characters, excluding colons(:), 

that identifies a file. 
file number: A unique number assigned to a file, which the File Manager 

uses to distinguish it from other files on the volume. A file number 
specifies the file's entry in a file directory. 

file reference: A resource that provides the Finder with file and icon 
information about an application. 
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file type: A four-character sequence, specified when a file is created, that 
identifies the type of file. 

Finder information: Information that the Finder provides to an applica­
tion upon starting it up, telling it which documents to open or print. 

font: A complete set of characters of one typeface, which may be restricted 
to a particular size and style, or may comprise multiple sizes, or 
multiple sizes and styles, as in the context of menus. 

Font Manager: The part of the Toolbox that supports the use of various 
character fonts for QuickDraw when it draws text. 

font number: The number by which you identify a font to QuickDraw or 
the Font Manager. 

font size: The size of a font in points; equivalent to the distance between 
the ascent line of one line of text and the ascent line of the next line of 
single-spaced text. 

fork: One of the two parts of a file; see data fork and resource fork. 
free block: A memory block containing space available for allocation. 
full pathname: A pathname beginning from the root directory. 
global coordinate system: The coordinate system based on the top left 

corner of the bit image being at (0,0). 
go-away region: A region in a window frame. Clicking inside this region 

of the active window makes the window close or disappear. 
graf Port: A complete drawing environment, including such elements as 

a bit map, a subset of it in which to draw, a character font, patterns for 
drawing and erasing, and other pen characteristics. 

graphics device: A video card, a printer, a display device, or an offscreen 
pixel map. Any of these device types may be used with Color Quick­
Draw. 

Gray Rgn: The global variable that in the multiple screen desktop describes 
and defines the desktop, the area on which windows can be dragged. 

grow image: The image pulled around when the user drags inside the grow 
region; whatever is appropriate to show that the window's size will 
change. 

grow region: A window region, usually within the content region, where 
dragging changes the size of an active window. 

handle: A pointer to a master pointer, which designates a relocatable block 
in the heap by double indirection. 

heap: The area of memory in which space is dynamically allocated and 
released on demand, using the Memory Manager. 

hierarchical menu: A menu that includes, among its various menu 
choices, the ability to display a submenu. In most cases the submenu 
appears to the right of the menu item used to select it, and is marked 
with a filled triangle indicator. 

highlight: To display an object on the screen in a distinctive visual way, 
such as inventing it. 

hotSpot: The point in a cursor that's aligned with the mouse location. 
icon: A 32-by-32 bit image that graphically represents an object, concept, 

or message. 
icon list: A resource consisting of a list of icons. 
icon number: A digit from 1 to 255 to which the Menu Manager adds 256 

to get the resource ID of an icon associated with a menu item. 
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inactive control: A control that won't respond to the user's actions with 
the mouse. An inactive control is highlighted in some special way, such 
as dimmed. 

inactive window: Any window that isn't the frontmost window on the 
desktop. 

indicator: The moving part of a dial that displays its current setting. 
interface routine: A routine called from Pascal whose purpose is to trap 

to a certain Toolbox or Operating System routine. 
International Utilities Package: A Macintosh package that gives you 

access to country-dependent information such as the formats for 
numbers, currency, dates, and times. 

invert: To highlight by changing white pixels to black and vice versa. 
invisible control: A control that's not drawn in its window. 
invisible window: A window that's not drawn in its plane on the desktop. 
item: In dialog and alert boxes, a control, icon, picture, or piece of text, each 

displayed inside its own display rectangle. See also menu item. 
item list: A list of information about all the items in a dialog or alert box. 
item number: The index, starting from 1, of an item in an item list. 
IWM: "Integrated Woz Machine"; the custom chip that controls the 3 1/2-

inch disk drives. 
job dialog: A dialog that sets information about one printing job; associ­

ated with the Print command. 
jump table: A table that contains one entry for every routine in an 

application and is the means by which the loading and unloading of 
segments is implemented. 

key code: An integer representing a key on the keyboard or keypad, 
without reference to the character that the key stands for. 

key-down event: An event generated when the user presses a character 
key on the keyboard or keypad. 

key-up event: An event generated when the user releases a character key 
on the keyboard or keypad. 

keyboard equivalent: The combination of the Command key and another 
key, used to invoke a menu item from the keyboard. 

keyboard event: An event generated when the user presses, releases, or 
holds down a character key on the keyboard or keypad; any key-down, 
key-up, or auto-key event. 

List Manager: The part of the Operating System that provides routines for 
creating, displaying, and manipulating lists. 

local coordinate system: The coordinate system local to a graf Port, 
imposed by the boundary rectangle defined in its bit map. 

local I D: A number that refers to an icon list or file reference in an 
application's resource file and is mapped to an actual resource I 0 by a 
bundle. 

localization: The process of adapting an application to different lan­
guages, including converting its user interface to a different script. 

lock: To temporarily prevent a relocatable block from being moved during 
heap operation. 

lock bit: A bit in the master pointer to a relocatable block that indicates 
whether the block is currently locked. 

locked file: A file whose data cannot be changed. 
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locked volume: A volume whose data cannot be changed. Volumes can be 
locked by either a software flag or a mechanical setting. 

logical end-of-file: The position of one byte past the last byte in a file; 
equal to the actual number of bytes in the file. 

main event loop: In a standard Macintosh application program, a loop 
that repeatedly calls the Toolbox Event Manager to get events and then 
responds to them as appropriate. 

main screen: On a system with multiple display devices, the screen with 
the menu bar is called the main screen. 

main segment: The segment containing the main program. 
master pointer: A single pointer to a relocatable block, maintained by the 

Memory Manager and updated whenever the block is moved, purged, 
or reallocated. All handles to a relocatable block refer to it by double 
indirection through the master pointer. 

Memory Manager: The part of the Operating System that dynamically 
allocates and releases memory space in the heap. 

menu: A list of menu items that appears when the user points to a menu 
title in the menu bar and presses the mouse button. Dragging through 
the menu and releasing over an enabled menu item chooses that item. 

menu bar: The horizontal strip at the top of the Macintosh screen that 
contains the menu titles of all menus in the menu list. 

menu definition procedure: A procedure called by the Menu Manager 
when it needs to perform type-dependent operations on a particular 
type of menu, such as drawing the menu. 

menu ID: A number in the menu record that identifies the menu. 
menu item: A choice in a menu, usually a command to a current applica­

tion. 
menu list: A list containing menu handles for all menus in the menu bar, 

along with information on the position of each menu. 
Menu Manager: The part of the Toolbox that deal with setting up menus 

and letting the user choose from them. 
menu title: A word or phrase in the menu bar that designates one menu. 
modal dialog: A dialog that requires the user to respond before doing any 

other work on the desktop. 
modeless dialog: A dialog that allows the user to work elsewhere on the 

desktop before responding. 
mounted volume: A volume that previously was inserted into a disk drive 

and had descriptive information read from it by the File Manager. 
mouse-down event: An event generated when the user presses the mouse 

button. 
mouse-up event: An event generated when the user releases the mouse 

button. 
network event: An event generated by the AppleTalk Manager. 
null event: An event reported when there are no other events to report. 
offspring: For a given directory, the set of files and directories for which 

it is the parent. 
on-line volume: A mounted volume with its volume buffer and descriptive 

information contained in memory. 
open file: A file with an access path. Open files can be read from and 

written to. 
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open permission: Information about a file that indicates whether the file 
can be read from, written to, or both. 

Operating System: The lowest-level software in the Macintosh. It does 
basic tasks such as 1/0, memory management, and interrupt handling. 

Operating System Utilities: Operating System routines that perform 
miscellaneous tasks such as getting the date and time, finding out the 
user's preferred speaker volume and other preferences, and doing 
simple string comparison. 

page rectangle: The rectangle marking the boundaries of a printed page 
image. The boundary rectangle, portRect, and clipRgn of the printing 
grafPort are set to this rectangle. 

panel: An area of a window that shows a different interpretation of the 
same part of a document. 

part code: An integer between 1 and 253 that stands for a particular part 
of a control (possibly the entire control). 

partial pathname: A pathname beginning from any directory other than 
the root directory. 

path reference number: A number that uniquely identifies an individual 
access path; assigned when the access path is created. 

pathname: A series of concatenated directory and file names that identi­
fies a given file or directory. See also partial pathname and full 
pathname. 

pattern: An 8-by-8 bit image, used to define a repeating design (such as 
stripes) or tone (such as gray). 

physical end-of-file: The position of one byte past the last allocation block 
of a file; equal to 1 more than the maximum number ofbytes the file can 
contain. 

picture: A saved sequence of QuickDraw drawing commands (and, option­
ally, picture comments) that you can play back later with a single 
procedure call; also, the image resulting from these commands. 

pixel: A dot on a display screen. Pixel is short for picture element. 
plane: The front-to-back position of a window on the desktop. 
point: The intersection of a horizontal grid line and a vertical grid line on 

the coordinate plane, defined by a horizontal and a vertical coordinate; 
also, a typographical term meaning approximately 1172 inch. 

polygon: A sequence of connected lines, defined by QuickDraw line-
drawing commands. 

pop-up menu: A menu not located in the menu bar, which appears when 
the user presses the mouse button in a particular place. 

port: See grafPort. 
portBits: The bit map of a grafPort. 
portRect: A rectangle, defined as part of a grafPort, that encloses a subset 

of the bit map for use by the grafPort. 
post: To place an event in the event queue for later processing. 
print record: A record containing all the information needed by the 

Printing Manager to perform a particular printing job. 
Printer Driver: The device driver for the currently installed printer. 
printer resource file: A file containing all the resources needed to run the 

Printing Manager with a particular printer. 
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Printing Manager: The routines and data types that enable applications 
to communicate with the Printer Driver to print on any variety of 
printer via the same interface. 

printing grafPort: A special grafPort customized for printing instead of 
drawing on the screen. 

purgeable block: A relocatable block that can be purged from the heap. 
queue: A list of identically structured entries linked together by pointers. 
QuickDraw: The part of the Toolbox that performs all graphic operations 

on the Macintosh screen. 
radio button: A standard Macintosh control that displays a setting, either 

on or off, and is part of a group in which only one button can be on at 
a time. 

RAM: The Macintosh's random access memory, which contains exception 
vectors, buffers used by hardware devices, the system and application 
heaps, the stack, and other information used by applications. 

reallocate: To allocate new space in the heap for a purged block, updating 
its master pointer to point to its new location. 

reference number: A number greater than 0, returned by the Resource 
Manager when a resource file is opened, by which you can refer to that 
file. In Resource Manager routines that expect a reference number, 0 
represents the system resource file. 

region: An arbitrary area or set of areas on the QuickDraw coordinate 
plane. The outline of a region should be one or more closed loops. 

release. To free an allocated area of memory, making it available for reuse. 
relocatable block: A block that can be moved within the heap during 

compaction. 
resource: Data or code stored in a resource file and managed by the 

Resource Manager. 
resource attribute: One of several characteristics, specified by bits in a 

resource reference, that determine how the resource should be dealt 
with. 

resource data: In a resource file, the data that comprises a resource. 
resource file: The resource fork of a file. 
resource fork: The part of a file that contains data used by an application 

(such as menus, fonts, and icons). The resource fork of an application 
file also contains the application code itself. 

resource header: At the beginning of a resource file, data that gives the 
offsets to and lengths of the resource data and resource map. 

resource ID: A number that, together with the resource type, identifies a 
resource in a resource file. Every resource has an ID number. 

Resource Manager: The part of the Toolbox that reads and writes 
resources. 

resource name: A string that, together with the resource type, identifies 
a resource in a resource file. A resource may or may not have a name. 

resource specification: A resource type and either a resource ID or a 
resource name. 

resource type: The type of a resource in a resource file, designated by a 
sequence of four characters (such as 'MENU' for a menu). 

result code: An integer indicating whether a routine completed its task 
successfully or was prevented by some error condition (or other special 
condition, such as reaching the end of a file). 
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resume procedure: A procedure within an application that allows the 
application to recover from system errors. 

ROM: The Macintosh's permanent Read-Only Memory, which contains the 
routines for the Toolbox and Operating System, and the various system 
traps. 

root directory: The directory at the base of a file catalog. 
row width: The number of bytes in each row of a bit image. 
Scrap Manager: The part of the Toolbox that enables cutting and pasting 

between applications, desk accessories, or an application and a desk 
accessory. 

scrap: A place where cut or copied data is stored. 
scrap file: The file containing the desk scrap (usually named "Clipboard 

File"). 
SCSI: See Small Computer Standard Interface. 
SCSI Manager: The part of the Operating System that controls the 

exchange of information between a Macintosh and peripheral devices 
connected through the Small Computer Standard Interface (SCSI). 

segment: One of several parts into which the code of an application may 
be divided. Not all segments need to be in memory at the same time. 

selection range: The series of characters (inversely highlighted), or the 
character position (marked with a blinking caret), at which the next 
editing operation will occur. 

signature: A four-character sequence that uniquely identifies an applica­
tion to the Finder. 

Small Computer Standard Interface (SCSI): A specification of me­
chanical, electrical, and functional standards for connecting small 
computers with intelligent peripherals such as hard disks, printers, 
and optical disks. 

solid shape: A shape that's filled in with any pattern. 
Sound Driver: The device driver that controls sound generation in an 

application. 
sound procedure: A procedure associated with an alert that will emit one 

of up to four sounds from the Macintosh's speaker. Its integer parame­
ter ranges from 0 to 3 and specifies which sound. 

source transfer mode: One of eight transfer modes for drawing text or 
transferring any bit image between two bit maps. 

stack: The area of memory in which space is allocated and released in LIFO 
(last-in-first-out) order. 

Standard File Package: A Macintosh package for presenting the stan­
dard user interface when a file is to be saved or opened. 

startup screen: When the system is started up, one of the display devices 
is selected as the startup screen, the screen on which the "happy 
Macintosh" icon appears. 

structure region: An entire window; its complete "structure." 
style: See character style. 
style dialog: A dialog that sets options affecting the page dimensions; 

associated with the Page Setup command. 
subdirectory: Any directory other than the root directory. 
submenu delay: The length of time before a submenu appears as a user 

drags through a hierarchical main menu; it prevents rapid flashing of 
submenus. 
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System Error Handler: The part of the Operating System that assumes 
control when a fatal system error occurs. 

system error alert: An alert box displayed by the System Error Handler. 
system error ID: An ID number that appears in a system error alert to 

identify the error. 
system event mask: A global event mask that controls which types of 

events get posted into the event queue. 
system font: The font that the system uses (in menus, for example). Its 

name is Chicago. 
system font size: The size of text drawn by the system in the system font; 

12 points. 
system heap: The portion of the heap reserved for use by the Operating 

System. 
system resource: A resource in the system resource file. 
system resource file: A resource file containing standard resources, 

accessed if a requested resource wasn't found in any of the other 
resource files that were searched. 

system window: A window in which a desk accessory is displayed. 
target device: An SCSI device (typically an intelligent peripheral) that 

receives a request from an initiator device to perform a certain opera­
tion. 

thumb: The Control Manager's term for the scroll box (the indicator of a 
scroll bar). 

tick: A sixtieth of a second. 
Toolbox: Same as User Interface Toolbox. 
Toolbox Event Manager: The part of the Toolbox that allows your 

application program to monitor the user's actions with the mouse, 
keyboard, and keypad. 

Toolbox Utilities: The part of the Toolbox that performs generally useful 
operations such as fixed-point arithmetic, string manipulation, and 
logical operations on bits. 

transfer mode: A specification of which Boolean operation QuickDraw 
should perform when drawing or when transferring a bit image from 
one bit map to another. 

trap dispatcher: The part of the Operating System that examines a trap 
word to determine what operation it stands for, looks up the address of 
the corresponding routine in the trap dispatch table, and jumps to the 
routine. 

trap word: An unimplemented instruction representing a call to a Toolbox 
or Operating System routine. 

type coercion: Many compilers feature type coercion (also known as 
typecasting), which allows a data structure of one type to be converted 
to another type. In many cases, this conversion is simply a relaxation 
of type-checking in the compiler, allowing the substitution of a differ­
ently typed but equivalent data structure. 

unlock: To allow a relocatable block to be moved during heap compaction. 
unmounted volume: A volume that hasn't been inserted into a disk drive 

and had descriptive information read from it, or a volume that previ­
ously was mounted and has since had the memory used by it released. 

unpurgeable block: A relocatable block that can't be purged from the 
heap. 
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update event: An event generated by the Window Manager when a 
window's contents need to be redrawn. 

update region: A window region consisting of all areas of the content 
region that have to be redrawn. 

User Interface Toolbox: The software in the Macintosh ROM that helps 
you implement the standard Macintosh user interface in your applica­
tion. 

version data: In an application's resource file, a resource that has the 
application's signature as its resource type; typically a string that gives 
the name, version number, and date of the application. 

vertical blanking interval: The time between the display of the last pixel 
on the bottom line of the screen and the first one on the top line. 

virtual key codes: The key codes that appear in keyboard events. 
visible control: A control that's drawn in its window (but may be 

completely overlapped by another window or other object on the 
screen). 

visible window: A window that's drawn in its plane on the desktop (but 
may be completely overlapped by another window or object on the 
screen). 

visRgn: The region of the grafPort, manipulated by the Window Manager, 
that's actually visible on the screen. 

volume: A piece of storage medium formatted to contain files; usually a 
disk or part of a disk. A 3.5-inch Macintosh disk is one volume. 

volume attributes: Information contained on volumes and in memory 
indicating whether the volume is locked, whether it's busy (in memory 
only), and whether the volume control block matches the volume 
information (in memory only). 

volume name: A sequence of up to 27 printing characters that identifies 
a volume; followed by a colon (:) in File Manager routine calls, to 
distinguish it from a file name. 

window: An object on the desktop that presents information, such as a 
document or a message. 

window class: In a window record, an indication of whether a window is 
a system window, a dialog or alert window, or a window created directly 
by the application. 

window definition function: A function called by the Window Manager 
when it needs to perform certain type-dependent operations on a 
particular type of window, such as drawing the window frame. 

window definition ID: A number passed to window-creation routines to 
indicate the type of window. It consists of the window definition 
function's resource ID and a variation code. 

window frame: The structure region of a window minus its content region. 
window list: A list of all windows ordered by their front-to-back positions 

on the desktop. 
Window Manager: The part of the Toolbox that provides routines for 

creating and manipulating windows. 
Window Manager port: A grafPort that has the entire screen as its 

portRect and is used by the Window Manager to draw window frames. 
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window record: The internal representation of a window, where the 
Window Manager stores all the information it needs for its operations 
on that window. 

window template: A resource from which the Window Manager can 
create a window. 

word wraparound: Keeping words from being split between lines when 
text is drawn. 

working directory: An alternative way ofreferring to a directory. When 
opened as a working directory, a directory is given a working directory 
reference number that's used to refer to it in File Manager calls. 

working directory control block: A data structure that contains the 
directory ID of a working directory, as well as the volume reference 
number of the volume on which the directory is located. 

working directory reference number: A temporary reference number 
used to identify a working directory. It can be used in place of the 
volume reference number in all File Manager calls; the File Manager 
uses it to get the directory ID and volume reference number from the 
working directory control block. 
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Code Listings 
The following pages contain complete 

listings of all the source code presented 
in Chapters 1-9. The listings are pre­

sented in order by Chapter. Each listing 
contains comments detailing the new 

features found in that program. Remem­
ber, you can send in the coupon in the 
back of the book for a disk containing 

the complete set of Macintosh 
Primer applications. 



Chapter 2, Hello.c 

#include <stdio.h> 

main ( ) 
I 

printf ("Hello, World"); /* The Unix way ... */ 

Chapter 3, Hello2.c 

#define BASE_RES_IO 400 
#define NIL_POINTER OL 
#define MOVE_TO_FRONT -lL 
#define REMOVE_ALL_EVENTS 0 

#define HORIZONTAL_PIXEL 30 
#define VERTICAL_PIXEL 50 

WindowPtr gPictureWindow: /* We'll draw in this window */ 

/*********************** Main *************/ 

main ( ) 
I 

ToolBoxlnit(): /* Standard Toolbox initialization */ 
Windowlnit(); /* Setup the window */ 

while ( !Button() ) : /* ~Jait for a press of the mouse */ 
I* button ... 

/*********************************** ToolBoxlnit */ 

Tool Box I nit() 
I 

InitGraf( &thePort ): 
I nit Fonts(): 
FlushEvents( everyEvent. REMOVE_ALL_EVENTS ): 
InitWindows(): 
InitMenus(): 
TEinit(): 
InitDialogs( NIL_POINTER ); 
InitCursor(): 

/*********************Windowlnit**************/ 

Windowlnit() 
I 

gPictureWindow = GetNewWindow( BASE_RES_ID , NIL_POINTER. 
MOVE_TO_FRONT ); /* Load the WIND resource */ 

420 

*I 
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ShowWindow( gPictureWindow ); /* Make the WIND 
visible */ 

SetPort( gPictureWindow ); /* We'll start drawing in 

MoveTo( HORIZONTAL_PIXEL, VERTICAL_PIXEL ); 
DrawString{"\pHello, World"); 

Chapter 3, Mondrian.c 

#define BASE_RES_ID 400 
#define NIL_POINTER OL 
#define MOVE_TO_FRONT -lL 
#define REMOVE_ALL_EVENTS 0 

~Ji ndowPtr 
long 

gDrawWindow; 
gFillColor = blackColor: 

/******************************** main *********/ 

main ( ) 
I 

ToolBoxinit(); 
Windowlnit(): 
Mainloop(); 

/*********************************** ToolBoxlnit */ 

ToolBoxinit() 
I 

InitGraf{ &thePort ) ; 
InitFonts(); 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
InitWindows(): 
InitMenusC): 
TEI nit(); 
InitDialogs( NIL_POINTER ); 
InitCursor(): 

/******************************** Windowlnit *********/ 

Windowlnit() 
I 

gPictureWindow */ 

gDrawWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER, 
MOVE_TO_FRONT ) ; 

ShowWindow( gDrawWindow ): 
SetPort( gDrawWindow ); 
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/******************************** Mainloop *********/ 

Mainloop() 
I 

GetDateTime( &randSeed ); /*Use the current time as a 
seed for the random number generator */ 

while ( ! Button() ) 
I 

DrawRandomRect(): /* 
if ( gFillColor == blackColor ) 

gFillColor whiteColor: 
else 

gFillColor = blackColor; 

Draw a random shape */ 
/* Alternate drawing */ 
/* between black and */ 

/*white ... 

/******************************** DrawRandomRect *********/ 

DrawRandomRect() 
( 

Rect myRect: 

RandomRect( &myRect, gDrawWindow ); /*Generate a random rectangle 
that fits within the bounds of gDrawWindow 

ForeColor( gFillColor ); 
Pai ntOva 1 ( &my Re ct ) : /* Paint an oval filled with gFillColor, 

*I 

*I 

the size of myRect. We could call 
other shape drawing routines (like 
PainRect()) instead of PaintOvalC) ... 

*I 

/******************************** RandomRect *********/ 

RandomRect( 
Rect 

myRectPtr, boundingWindow 
*myRectPtr: 
boundingWindow: l~i ndowPt r 

I 
I* 
* 
*I 

A window's portRect is a Rect the size of the window ... 

myRectPtr->left = Randomize( boundingWindow->portRect.right 
- bound i ngWi ndow- >po rt Rect. 1 eft ) : 

myRectPtr->right = Randomize( boundingWindow->portRect.right 
- boundi ngWi ndow- >portRect. left ) : 

myRectPtr->top = Randomize( boundingWindow->portRect.bottom 
- boundingWindow->portRect.top ); 

myRectPtr->bottom = Randomize( boundingWindow->portRect.bottom 
- boundingWindow->portRect.top ); 

/******************************** Randomize *********/ 

Randomize ( range ) 
int range: 
I 

long rawResult: 
rawResul t = Random(); /* Random() returns a random number 

between -32767 and 32767 */ 
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if < rawResult < 0 ) rawResult *= -1: /* We could call abs(), 
but abs() is not part of the Toolbox. If 
you need it, make sure to add the math 
1 i bra ry to your project. Otherwise. your 
project won't link ... */ 

return( CrawResult * range) I 32768 ); /* We'll return a number 
between 0 and range-1 */ 

Chapter 3, ShowPict.c 

#define BASE_RES_ID 400 
#define NIL_POINTER OL 
#define MOVE_TO_FRONT -ll 
#define REMOVE_ALL_EVENTS 0 

PicHandle 
WindowPtr 

gThePicture; 
gPictureWindow: 

/******************************** main *********/ 

main ( ) 
I 

ToolBoxlnit(); 
Windowlnit(); 
LoadPi cture(); 
DrawMyPicture( gThePicture, gPictureWindow ); 

while ( !Button() ) ; 

/*********************************** ToolBoxlnit */ 

ToolBoxlnit() 
I 

InitGraf ( &the Port ) : 
InitFonts(); 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
InitWindows(); 
InitMenus(); 
TEinit(); 
InitDialogs( NIL_POINTER ); 
InitCursor(); 

/******************************** Windowlnit *********/ 

Windowinit() 
I 

gPictureWindow = GetNewWindow( BASE_RES_IO, NIL_POINTER, 
MOVE_ TO_FRONT ) : 

ShowWindow( gPictureWindow >: 
SetPort( gPictureWindow ); 
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!******************************** LoadPicture *********/ 

LoadPicture() 
I 

gThePicture = GetPicture( BASE_RES_ID ): 

/******************************** DrawMyPicture *********/ 

DrawMyPicture( thePicture, pictureWindow 
PicHandle thePicture: 
WindowPtr pictureWindow; 
I 

Rect myRect: 

myRect = pictureWindow->portRect: 
CenterPict< thePicture. &myRect >: /* Pass the window's portRect 

to CenterPict() via myRect, as well as a handle 
to the picture to be centered. CenterPict() 
will modify myRect to be a Rect the size of the 
Picture, centered in the window. */ 

DrawPicture( thePicture, &myRect >: 

/******************************** CenterPict *********/ 

CenterPict( thePicture, myRectPtr 
PicHandle thePicture: 
Rect *myRectPtr: 
I 

Rect wi ndRect. pi ctureRect: 

windRect = *myRectPtr: 
pictureRect = (**( thePicture )).picFrame: /* Two interesting 

facts: 
1) picFrame is a field in the picture 

data structure. It is a Rect, the 
size of the picture, with the same 
coordinates as the picture had when 
it was created. 

2) ANSI C allows the direct assignment of 
one data structure to another of the 
same type. This allows us to copy 
one Rect to another with one 
statement. Some compi 1 ers may not 
support this feature. It sure makes 
life easier! */ 

myRectPtr->top = (windRect.bottom - windRect.top -
CpictureRect.bottom - pictureRect.top))/ 2 + 
windRect.top; 

myRectPtr->bottom = myRectPtr->top + 
CpictureRect.bottom - pictureRect.top): 

myRectPtr->left = (windRect.right - windRect.left -
(pictureRect.right - pictureRect.left))/ 2 + 

windRect.left: 
myRectPtr->right = myRectPtr->left + CpictureRect.right -

pictureRect.left); 



Appendi.x B: Code Listings 

Chapter 3, Flying Line.c 

I* 
* 
* 
* 

Try using different values for NUM_LINES. gDeltaTop, gDeltaBottom. 
gDeltaLeft, and gDeltaRight. This will alter the shape and 
behavior of the Flying Line. 

*/ 

#define NUM_LINES 
#define NIL_POINTER 
#define MOVE_TO_FRONT 
#define REMOVE_ALL_EVENTS 
#define NIL_STRING 
#define NIL_TITLE 
//define VI SIBLE 
#define NO_GO_AWAY 
#define NIL_REF_CON 

WindowPtr 
Re ct 

gLineWindow; 
glines[ NUM_LINES ]: 

50 /* Try 100 or 150 */ 
OL 
-ll 
0 
"\p" 
NIL_STRING 
TRUE 
FALSE 
NIL_POINTER 

int 
int 
int 

gDeltaTop=3. gDeltaBottom=3: /* These four are the */ 
gDeltaleft=2. gDeltaRight=6: /* key to flying line! */ 
gOldMBarHeight; 

/******************************** main *********/ 

main ( ) 
I 

ToolBoxlnit(); 
Wi ndowlnit(): 
Lineslnit(); 
MainLoop(); 

/*********************************** ToolBoxlnit */ 

Tool Boxlnit() 
I 

InitGraf( &thePort ); 
I nit Fonts(): 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
InitWindowsC>: 
InitMenus<>: 
TEinit(); 
InitDialogs( NIL_POINTER ); 
InitCursor(): 

/******************************** Windowlnit *********/ 

Wi ndowlnit() 
I 

Re ct 
RgnHandle 

totalRect, mBarRect: 
mBarRgn: 
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I* 
* 
* 
* 
* 
*I 

I* 
* 
* 
* 
*I 

gOldMBarHeight = MBarHeight: 
MBarHeight = O; 
glineWindow = NewWindow< NIL_POINTER. &CscreenBits.bounds), 

NIL_TITLE, VISIBLE, plainDBox. MOVE_TO_FRONT, NO_GO_AWAY, 
NI L_REF _CON ) : 

We use NewWindowC) instead of GetNewWindow() because we want a 
window the size of the screen. NewWindow() allows you to specify 
the size of your window. With GetNewWindow(), the window size is 
pulled from the WIND resource. 

SetRect( &mBa rRect. screenBi ts. bounds.left. screenBi ts. bounds. top, 
screenBits.bounds.right, screenBits.bounds.top+gOldMBarHeight ): 

The following 4 lines of code are for demonstration purposes only. 
The thought police have prohibited the modification of a window's 
visRgn under MultiFinder. Reuse this code at your own risk!!! 

mBarRgn = NewRgn(): 
RectRgn( mBarRgn, &mBarRect ); 
UnionRgn( gLineWindow->visRgn, mBarRgn, gLineWindow->visRgn >: 
DisposeRgn( mBarRgn ); 

SetPort( gLineWindow >: 
FillRect< &CgLineWindow->portRect), black >: /* Change black to 

ltGray. *I 
PenMode( patXor ): /* <-and comment out this line */ 

/******************************** Lineslnit *********/ 

Lineslnit() 
I 

int i: 

HideCursor(): 
GetDateTimeC &randSeed ); /*Reseed the random number generator*/ 
RandomRect( &Cglines[ 0 ]), gLineWindow >: 
Drawline( 0 ): /*Generate and draw the first line*/ 
for ( i=l; i<NUM_LINES: i++ ) 
I 

glines[ i J = glines[ i-1 ]; /* Copy the previous line, */ 
Recalcline( i >: /* modify it, */ 
Drawl i ne( i ) : I* and draw the new line *I 

/******************************** Mainloop *********/ 

Mainloop() 
I 

int i: 

while 
I 

! Button () ) 

Drawline( NUM_LINES - 1 ); /* Erase the last line (because 
we used patXor mode) */ 
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for ( i=NUM_LINES-1; i>O; i-) 
glines[ i J = glines[ i-1 J: /*Bump each line one*/ 

Recalcline( 0 ); /* Modify the first line and */ 
Drawline( 0 ); /* redraw it */ 

I 
MBarHeight = gOldMBarHeight; I* Once the button is clicked, 

we better reset the menubar 
height, else we won't be able 
to click in it */ 

/******************************** RandomRect *********/ 

RandomRect( myRectPtr, boundingWindow 
Re ct *myRectPt r: 
WindowPtr boundingWindow: 
{ 

myRectPtr->left = Randomize( boundingWindow->portRect.right 
- bound i ngWi ndow- >po rt Re ct.left ) : 

myRectPtr->right = Randomize( boundingWindow->portRect.right 
- boundingWindow->portRect.left ); 

myRectPtr->top = Randomize( boundingWindow->portRect.bottom 
- boundingWindow->portRect.top ); 

myRectPtr->bottom = Randomize( bound i ngWi ndow- >portRect. bottom 
- boundingWindow->portRect.top ); 

/******************************** Randomize *********/ 

Randomize( range ) 
int range: 
{ 

1 ong rawResul t; 

rawResult =Random(); 
if ( rawResult < 0 ) rawResult *= -1: 
return( (rawResult * range) I 32768 ): 

/******************************** Recalcline *********/ 

Recalcline( i ) 
int i: 
{ 

g Li n es [ i ] . top += g Delta Top ; 
if ( ( glines[ i ].top< gLineWindow->portRect.top) II 

( glines[ i ].top > gLineWindow->portRect.bottom ) ) 

gDe ltaTop *= -1; 
g Li n es [ i ] . top += 2 * g Del ta Top : 

gLines[ i ].bottom += gDeltaBottom: 
if ( ( glines[ i ].bottom < gLineWindow->portRect.top ) I I 

( glines[ i ].bottom > glineWindow->portRect.bottom ) ) 

gOeltaBottom *= -1: 
glines[ i ].bottom+= 2*gDeltaBottom: 
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g Lines [ i ] . 1 eft += gDe 1 ta Left; 
if<< gLines[ i ].left< gLineWindow->portRect.left) II 

( glines[ i ].left> gLineWindow->portRect.right 

gDeltaleft *= -1: 
glines[ i ].left+= 2*gDeltaLeft: 

gLines[ i ].right += gDeltaRight: 
if ( < glines[ i ].right< gLineWindow->portRect.left ) I I 

C gLines[ i ].right > gLineWindow->portRect.right 

gDeltaRight *= -1: 
gLines[ i ].right += 2*gDeltaRight: 

!******************************** DrawLine *********/ 

DrawLineC i ) 
int i : 
I 

MoveToC gLines[ ].left. glines[ i ].top >:/*Move to first 

LineToC gLines[ ].right, gLines[ i ].bottom ): /* Draw line to 
point */ 

second point */ 

Chapter 4, EventTutor.c 

/idefi ne BASE_RES_ID 400 
/idef i ne NI L_PO INTER OL 
#define MOVE_TO_FRONT -ll 
/idef i ne REMOVE_ALL_EVENTS 0 

/fdef i ne LEAVE_WHERE_IT_IS FALSE 
#define NORMAL_UPDATES TRUE 

/idef i ne SLEEP OL 
#define NIL_MOUSE_REGION OL 
lfdef i ne WNE_TRAP_NUM Ox60 
#define UNIMPL_TRAP_NUM Ox9F 
/!define SUSPEND_RESUME_BIT OxOOOl 
/fdefi ne ACTIVATING 1 
/fdefi ne RESUMING 1 

/idefi ne TEXT_FONT_SIZE 12 

#define DRAG_ THRESHOLD 30 
/fdef i ne MIN_WINDOW_HEIGHT 50 
#define MIN_WINDOW_WIDTH 50 
/fdefi ne SCROLL_BAR_PIXELS 16 

/idefi ne ROWHEIGHT 15 
#define LEFTMARGIN 10 
lfdef i ne STARTROW 0 
/idefi ne HORIZONTAL_OFFSET 0 
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PicHandle 
WindowPtr 
Boolean 
EventRecord 
int 

gPictureHandle: 
gPi ctWi ndow. gEventWi ndow: 
gDone, gWNEimplemented; 
gTheEvent: 
gCurRow. gMaxRow: 
gDragRect. gSizeRect: Re ct 

/******************************** main *********/ 

main ( ) 
I 

ToolBoxlnit(); 
WindowlnitC>: 
LoadPictureC>: 
SetUpDragRect(): 
SetUpSizeRect(): 

Mainloop(): 

/*********************************** ToolBoxlnit */ 

Tool Box I nit(> 
{ 

InitGraf ( &the Port ) : 
InitFonts<>: 
FlushEvents( everyEvent. REMOVE_ALL_EVENTS >: 
InitWindows(); 
I nitMenus (): 
TElnit(): 
lnitDialogs( NIL_POINTER ): 
InitCursor(): 

/******************************** Windowlnit *********/ 

Wi ndowlnit() 
( 

I* 
*Start by loading the two windows from the resource file ... 
*/ 

/* 

gPictWindow = GetNewWindow( BASE_RES_ID. NIL_POINTER, 
MOVE_ TO_FRONT ) : 

gEventWindow = GetNewWindow( BASE_RES_ID+l, NIL_POINTER, 
MOVE_ TO_FRONT ) : 

SetPort( gEventWindow ): 
SetupEventWindow(): 

* Make both windows visible ... 
*/ 

/* 
* 
*/ 

ShowWindow( gEventWindow ): 
ShowWindow( gPictWindow ): 

Finally, make gEventWindow the active window ... 

SelectWindow< gEventWindow ): 
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/******************************** SetupEventWindow *********/ 

SetupEventWindow() 
{ 

Rect eventRect: 

/* 
* Set up gMaxRow: it determines when gEventWindow is scrolled. 
* Set up gCurRow: it holds the current vertical pixel value. 
*I 

I* 
* 
* 
*/ 

eventRect = gEventWindow->portRect; 
gMaxRow eventRect.bottom - eventRect.top - ROWHEIGHT: 
gCurRow STARTROW: 

Set the gEventWindow font to monaco, and the gEventWindow 
text size to TEXT_FONT_SIZE ... 

TextFontC monaco ); 
TextSize( TEXT_FONT_SIZE ); 

/******************************** LoadPicture *********/ 

LoadPicture() 
{ 

I* Load the picture <to center in gPictWindow) */ 
gPictureHandle = GetPictureC BASE_RES_ID ); 

/******************************** SetUpDragRect *********/ 

SetUpDragRect() 
{ 

I* 
* 
* 
* 
* 
* 
* 
*I 

We'll use gDragRect to limit the dragging area of a window. This 
means that when a user clicks on the title bar of a window and 
drags it around the screen, they will be forced to leave 
DRAG_THRESHOLD pixels of the window on the screen. This prevents 
the user from dragging all but a few pixels of a window off the 
screen (which makes that window mighty tough to find later on). 

gDragRect = screenBits.bounds: 
gDragRect.left += DRAG_THRESHOLD; 
gDragRect.right -= DRAG_THRESHOLD: 
gDragRect.bottom -= DRAG_THRESHOLD: 

/******************************** SetUpSizeRect *********/ 

SetUpSizeRect() 
( 
/* 
* 
* 
* 
* 
* 
*I 

We'll use gSizeRect to control the size of a window. This 
means that when a user tries to resize a window with a grow box 
(like gPictWindow) gSizeRect will determine the minimum height 
and width of the window, and the maximum height and width of the 
window. 
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gSizeRect.top = MIN_WINDOW_HEIGHT; 
gSizeRect.left = MIN_WINDOW_WIDTH; 

gSizeRect.bottom = screenBits.bounds.bottom -
screenBits.bounds.top; 

gSizeRect.right = screenBits.bounds.right -
screenBits.bounds.left; 

/******************************** MainLoop *********/ 

MainLoop() 
{ 

I* 
* 
* 
* 
*I 

I* 

gDone = FALSE; 

Is WaitNextEvent() implemented? If it is, the address of the 
WaitNextEvent() trap will be different than the standard, 
"unimplemented" trap ... 

gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) != 
NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) ); 

* Don't wait for a mouse click. Retrieve and process events 
* instead! 
*I 

while ( gDone == FALSE 
{ 

HandleEvent(); 

/************************************* HandleEvent */ 

HandleEvent() 
{ 
I* 
* We'll see this routine in all "proper" Macintosh applications. 
* First. we' 11 retrieve an event ... 
*I 

I* 
* 
*I 

if ( gWNEimplemented ) 

else 
{ 

WaitNextEvent( everyEvent, &gTheEvent, SLEEP. 
NIL_MOUSE_REGION ); 

SystemTask(); 
GetNextEvent( everyEvent, &gTheEvent ); 

... then. we' 11 process the event. 

switch 
{ 

gTheEvent.what ) 

case nullEvent: 
/*DrawEventSt ring ( "\pnul l Event" ) ; *I 
/* Uncomment the previous line for a burst of 

flavor! */ 
break; 
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I* 
* 
* 
* 
*I 
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case mouseDown: 
DrawEventString( "\pmouseDown" ); 
HandleMouseDown(): 
break; 

case mouseUp: 
DrawEventString( "\pmouseUp" ): 
break: 

case keyDown: 
DrawEventString( "\pkeyDown" ): 
break: 

case keyUp: 
DrawEventStri ng( "\pkeyUp" ) : 
break: 

case autoKey: 
DrawEventStringC "\pautoKey" ); 
break: 

case updateEvt: 
if ( (WindowPtr)gTheEvent.message == gPictWindow ) 
{ 

else 

I 
break: 

case diskEvt: 

DrawEventString( "\pupdateEvt: gPictWindow" ): 
BeginUpdate( gTheEvent.message ); 
DrawMyPicture(gTheEvent.message,gPictureHandle): 
EndUpdateC gTheEvent.message ); 

DrawEventString( "\pupdateEvt: gEventWindow" ): 
BeginUpdateC gTheEvent.message ); 
I* 
* We won't handle updates to gEventWindow, 
* but we still need to empty the gEventWindow 
* Update Region so the Window Manager will stop 
* queueing UpdateEvts. 
* We do this with calls to BeginUpdate() 
*and EndUpdate(). 
*I 

EndUpdate( gTheEvent.message ); 

DrawEventString( "\pdi skEvt" ) : 
break: 

case activateEvt: 
if ( (WindowPtr)gTheEvent.message == gPictWindow ) 
l 

If gPictWindow was activated or deactivated, we better redraw the 
grow box (as well as the scroll bar outlines. We do this because 
active and inactive windows have different looking grow boxes. 

DrawGrowlconC gTheEvent.message ); 
if ( C gTheEvent.modifiers & activeFlag ) 

ACTIVATING ) 

I 
else 

DrawEventString( 
"\pactivateEvt: activating gPictWindow"): 

DrawEventString( 
"\pactivateEvt: deactivating gPictWindow" 
) : 



Appendix B: Code Listings 

I* 
* 
* 
* 
* 
* 
*I 

else 

l 

if ( ( gTheEvent.modifiers & activeFlag ) == 

else 

ACTIVATING ) 
DrawEventString( 
"\pactivateEvt: activating gEventWindow" 
) : 

DrawEventString( 
ff\pactivateEvt: deactivating gEventWindow" 

) ; 

break: 
case networkEvt: 

DrawEventString( ff\pnetworkEvt" ); 
break; 

case driverEvt: 
DrawEventStri ng ( "\pdri verEvt" ) : 
break: 

case applEvt: 
DrawEventString( "\papplEvt" ) : 
break: 

case app2Evt: 
DrawEventString( "\papp2Evt" ); 
break: 

case app3Evt: 
DrawEventStri ng ( "\papp3Evt" ) : 
break: 

case app4Evt: 

app4Evts are like Trojan horses for suspend, resume, and mouse 
moved events. The actual event type is specified by the 
appropriate bit in the event's message field. For more info 
on these events (especially on mouse moved events) read Apple's 
"Programmer's Guide to MultiFinder". 

if ( gTheEvent.message & SUSPEND_RESUME_BIT ) == 
RESUMING ) 

DrawEventString( "\pResume event" ); 
else 

OrawEventString( "\pSuspend event" ); 
break: 

/********************************** DrawEventString *******/ 

DrawEventString( s ) 
Str255 s: 
I 
/* if we're at the bottom of gEventWindow, scroll the window. */ 

if gCurRow > gMaxRow ) 
I 

I 
else 
I 

I 

ScrollWindow(); 

gCurRow += ROWHEIGHT: 

MoveTo( LEFTMARGIN, gCurRow ); 
DrawStri ng( s ) : 
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/********************************** ScrollWindow *******/ 

Scrol lWindow() 
I 

/* 
* 
* 
* 
* 
* 
*I 

RgnHandle tempRgn; 

tempRgn = NewRgn(); 

We use ScrollRect() to scroll all the pixels in gEventWindow 
up one row. The newly created rectangular region at the bottom of 
the window will be stored in tempRgn. We could use tempRgn to 
do some smart updating of our window. only refreshing the area 
of the window specified by tempRgn. 

ScrollRect( &gEventWindow->portRect. HORIZONTAL_OFFSET, -
ROWHEIGHT, tempRgn ); 

DisposeRgn( tempRgn ); /* Free up the memory used by tempRgn */ 

!************************************* HandleMouseDown */ 

HandleMouseDown() 
I 

/* 

WindowPtr 
short int 
long 
Graf Ptr 

whichWindow; 
thePart; 
windSize: 
oldPort: 

* First. find out which window the mouse click occurred in. 
*Then, find out what part of the window the mouse click 
* occurred in. 
*I 

/* 
* 
*I 

thePart = FindWindow( gTheEvent.where, &whichWindow ): 
switch ( thePart ) 
I 

case inSysWindow : 

Probably a desk accessory window ... 

SystemClick( &gTheEvent, whichWindow ): 
break: 

case i nDrag : 
I* Drag the window around the screen, limited by gDragRect */ 

DragWindow( whichWindow, gTheEvent.where. &gDragRect); 
break; 

case inContent: 
I* Bring the clicked on window to the front */ 

SelectWindow( whichWindow ); 
break: 

case inGrow: 
I* First. let the user specify the new size of the window ... */ 

I* 

windSize = GrowWindow( whichWindow, gTheEvent.where. 
&gSizeRect ); 

if ( windSize != 0 ) 
I 

* ... If they resize the window. temporarily make the window the 
* window the current port, erase the window, and use InvalRect() 
* to make sure an update event is generated for the window. 
*/ 
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I* 
* 
* 
* 
* 
*I 

/* 
* 
* 
*I 

I 
break: 

case inGoAway 

GetPort( &oldPort ); 
SetPort( whichWindow ): 
EraseRect( &whichWindow->portRect ); 
SizeWindow( whichWindow, LoWord( windSize ), 

HiWord( windSize ), NORMAL_UPDATES ); 
I nva l Rect < &whi chWi ndow->portRect ) ; 
SetPort( oldPort ); 

Important!!! Normally, we'll. only set gDone to TRUE when Quit is 
selected from the File menu. For the currect handling of 
the inGoAway case. refer to the WindowMaker application in 
Chapter 7. 

gDone = TRUE; 
break: 

case inZoomln: 
case inZoomOut: 

Handling a click in the zoom box is similar to handling the 
resizing of a window. 

if TrackBox(whichWindow, gTheEvent.where, thePart) ) 
I 

I 
break: 

GetPort( &oldPort ); 
SetPortC whichWindow ); 
EraseRect( &whichWindow->portRect ): 
ZoomWindow( whichWindow, thePart, 

LEAVE_WHERE_IT_IS ); 
InvalRect< &whichWindow->portRect ); 
SetPort( oldPort ); 

/******************************** DrawMyPicture *********/ 

OrawMyPicture( drawingWindow, thePicture ) 
WindowPtr drawingWindow; 
PicHandle thePicture; 
{ 

I* 
* 
* 
* 
* 
*I 

Rect drawi ngCl i pRect. myRect: 
Graf Ptr ol dPort; 
RgnHandle tempRgn: 

We start by temporarily making the window specified in the 
drawingWindow parameter the current port. We also store the 
window's clipping region in tempRgn. Next, we erase the window 
and redraw the Growlcon. 

GetPort( &oldPort ); 
SetPort( drawingWindow ): 
tempRgn = NewRgnC>: 
GetClip( tempRgn ): 
EraseRect( &drawingWindow->portRect ) ; 
DrawGrowlcon( drawingWindow ): 
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I* 
* 
* 
* 
*I 

Next. we create a clip rectangle that doesn't cover the scroll 
bar areas (or the size box either). We use this rectangle as 
our clipping region and center and draw the picture. 

/* 
* 
* 
*I 

drawingClipRect = drawingWindow->portRect; 
drawingClipRect.right ·= SCROLL_BAR_PIXELS; 
drawingClipRect.bottom ·= SCROLL_BAR_PIXELS; 

myRect = drawingWindow·>portRect; 
Center Pi ct( thePi cture, &myRect ) : 
ClipRect( &drawingClipRect ); 
DrawPictureC thePicture, &myRect >: 

Finally, we restore the original clip region, free up the memory 
used by tempRgn, and reset the original port. 

SetClip( tempRgn ); 
DisposeRgn( tempRgn ); 
SetPort( oldPort ); 

!**~***************************** CenterPict *********/ 

CenterPict( thePicture, myRectPtr 
PicHandle thePicture; 
Rect *myRectPtr: 
I 

Rect wi ndRect, pi ctureRect; 

windRect = *myRectPtr; 
pictureRect = (**( thePicture )).picFrame; 
myRectPtr->top = CwindRect.bottom - windRect.top · 

CpictureRect.bottom - pictureRect.top))/ 2 + 
windRect.top; 

myRectPtr->bottom = myRectPtr->top + 
(pictureRect.bottom - pictureRect.top): 

myRectPtr->left = (windRect.right - windRect.left · 
CpictureRect.right - pictureRect.left))/ 2 + 

windRect.left: 
myRectPtr->right = myRectPtr->left + CpictureRect.right -

pictureRect.left): 

Chapter 5, Timer.c 

#define BASE_RES_ID 
#define NIL_POINTER 
#define MOVE_TO_FRONT 
#define REMOVE_ALL_EVENTS 

#define PLAIN 
#define PLAIN_ITEM 
#define BOLD_ITEM 
#define ITALIC_ITEM 
#define UNDERLINE_ITEM 
#define OUTLINE_ITEM 
#define SHADOW_ITEM 

400 
OL 
-ll 
0 

0 
I 
2 
3 
4 
5 
6 
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//define INCLUDE_SECONDS TRUE 

//define ADO_CHECK_MARK TRUE 
//define REMOVE_CHECK_MARK FALSE 

1/defi ne DRAG_ THRESHOLD 30 

1/define MIN_SLEEP OL 
/ldefi ne NIL_MOUSE_REGION OL 

#define WNE_TRAP_NUM Ox60 
#define UNIMPL_TRAP_NUM Ox9F 

//define OUIT_ITEM 1 
/ldefi ne ABOUT_ITEM 1 
/ldefi ne NOT_A_NORMAL_MENU -1 
#define APPLE_MENU_ID BASE_RES_ID 
#define FI LE_MENU_ID BASE_RES_ID+l 
//define FONT_MENU_ID 100 
1/define STY LE_MENU_I D 101 

/ldefi ne CLOCK_LEFT 12 
#define CLOCK_ TOP 25 
I/define CLOCK_SIZE 24 

#define ABOUT_ALERT 400 

gClockWindow: WindowPtr 
Boolean 
1 ong 
Event Record 
MenuHandle 
int 

gDone. gWNEimplemented: 
gCurrentTime. gOldTime: 
gTheEvent: 

Rect 
Style 

gAppleMenu. gFontMenu, gStyleMenu: 
glastFont: 
gDragRect: 
gCurrentStyle = PLAIN: 

!******************************** main *********/ 

main ( ) 
{ 

ToolBoxinit(): 
Windowinit(): 
SetUpDragRect(); 
MenuBarinit(): 
Mainloop(): 

!*********************************** ToolBoxinit */ 

Tool Box I nit() 
{ 

InitGraf( &thePort ) : 
InitFonts(); 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
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InitWindows(); 
InitMenus(); 
TEini t(); 
InitDialogs( NIL_POINTER ); 
Ini tCursor(): 

Macintosh Programming Primer 

/************************************ Windowlnit */ 

Windowlnit() 
I 

gClockWindow = GetNewWindow( BASE_RES_IO, NIL_POINTER, 

SetPort( gClockWindow ); 
ShowWindow( gClockWindow ); 

TextSize( CLOCK_SIZE ); 

MOVE_ TO_FRONT ) ; 

!******************************** SetUpDragRect *********/ 

SetUpDragRect() 
I 

gDragRect = screenBits.bounds; 
gDragRect.left += DRAG_THRESHOLD; 
gOragRect.right -= DRAG_THRESHOLD; 
gOragRect.bottom -= DRAG_THRESHOLD: 

/*********************************** MenuBarlnit */ 

MenuBarlnit() 
I 

I* 
* 
* 
* 
* 
*I 

I* 
* 
* 
* 
* 
*I 

I* 

Handle myMenuBar; 

First. we'll load the MBAR resource, which specifies the MENUs 
to use in myMenuBar. Next. make myMenuBar the current menu bar. 
Put handles to their respective menus in the globals gAppleMenu. 
gFontMenu, and gStyleMenu for later use. 

myMenuBar = GetNewMBar( BASE_RES_IO ): 
SetMenuBar( myMenuBar ): 
gAppleMenu = GetMHandle( APPLE_MENU_ID ); 
gFontMenu = GetMenu( FONT_MENU_ID ): 
gStyleMenu = GetMenu( STYLE_MENU_ID ); 

Add the heirarchical menu, gFontMenu, to the menu list. 
We set up the Special MENU resource so that the Font and 
Style menus would automatically be added as hierarchical 
submenus to the Special menu. 

InsertMenu( gFontMenu, NOT_A_NORMAL_MENU ); 

* We also add all the FONTs to the font menu. 
*I 

AddResMenu( gFontMenu. 'FONT' >: 
InsertMenu( gStyleMenu, NOT_A_NORMAL_MENU ): 
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I* 
* Put a check mark next to Plain on the Style submenu and 
* Add all the desk accessory names to the apple menu. 
*I 

I* 

Checkltem( gStyleMenu, PLAIN_ITEM. TRUE ); 
AddResMenu( gAppleMenu, 'DRVR' ); 
DrawMenuBar(); 

* We' 11 start off using the first font on the menu. By 
* calling HandleFontChoice(), we simulate the user selecting 
* the first font from the font menu ... 
*I 

gLastFont = 1: 
Handl eFontChoi ce( gLastFont ) : 

/******************************** MainLoop *********/ 

Main Loop () 
I 

gDone = FALSE: 
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) != 

NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) ); 
while ( gDone == FALSE ) 
I 

HandleEvent(); 

/************************************* HandleEvent */ 

HandleEvent() 
I 

I* 

char theCha r: 

if ( gWNEimplemented ) 

else 
{ 

WaitNextEvent( everyEvent. &gTheEvent, MIN_SLEEP, 
NIL_MOUSE_REGION ); 

SystemTask<>: 
GetNextEvent( everyEvent. &gTheEvent ); 

switch ( gTheEvent.what 
{ 

case nullEvent: 

* Since the clock needs to be updated on a regular basis <and not 
* just when an update event is generated), we'll check the clock 
* every time we get a null event. 
*I 

Handl eNul 1 (): 
break: 

case mouseDown: 
HandleMouseDown(); 
break: 

case keyDown: 
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/* 
* 
* 
* 
* 
* 
* 
*I 
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case autoKey: 
theChar = gTheEvent.message & charCodeMask: 
if (( gTheEvent.modifiers & cmdKey ) != 0) 

HandleMenuChoice( MenuKey( theChar ) ); 
break; 

case updateEvt: 

We don't need to do anything about updateEvts but we must 
call Begin and EndUpdate() so the Window Manager won't keep 
generating update events. The problem is, if the Window 
Manager keeps generating updateEvts, the event queue will 
eventually fill up, and the Event Manager won't be able to 
generate any nullEvts. 

BeginUpdate( gTheEvent.message ); 
EndUpdateC gTheEvent.message ); 
break: 

/******************************** HandleNull *********/ 

HandleNull() 
I 
I* 
* 
* 
* 
*/ 

Check the time, compare it against the last time you 
checked. If the time (which is measured in seconds) 
changed, update the clock. 

GetDateTime( &gCurrentTime ); 
if < gCurrentTime != gOldTime 
I 

DrawClock( gClockWindow ): 

/******************************** DrawClock *********/ 

DrawClock( theWindow ) 
WindowPtr theWindow: 
I 

Str255 myTimeString; 

IUTi meStri ng ( gCurrentTi me. I NCLUDE_SECONDS, my Ti meStri ng ) : 
EraseRect( &C theWindow->portRect ) ): 
MoveTo( CLOCK_LEFT. CLOCK_TOP ); 
Drawstring( myTimeString ); 
gOldTime = gCurrentTime: 

/************************************* HandleMouseDown */ 

HandleMouseDown() 
{ 

WindowPtr 
short int 
1 ong int 

whichWindow: 
thePart: 
menuChoice, windSize: 
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thePart = FindWindow( gTheEvent.where, &whichWindow ); 
switch ( thePart ) 
I 

case inMenuBar: 
menuChoice = MenuSelect( gTheEvent.where ); 
HandleMenuChoice( menuChoice ): 
break: 

case inSysWindow : 
SystemClick( &gTheEvent, whichWindow ): 
break: 

case i nDrag : 
DragWi ndow( whi chWi ndow. gTheEvent. where. &gDragRect): 
break: 

case inGoAway : 
gDone = TRUE: 
break: 

/************************************* HandleMenuChoice */ 

HandleMenuChoice( menuChoice 
long int menuChoice: 
I 
I* 
* 
* 
* 
*/ 

menuChoice is 4 bytes. 2 bytes of which contain the resource 
ID of the selected menu, and 2 bytes of which contain the 
selected item number. 

int theMenu: 
int the Item: 

if menuChoice != 0 ) 
( 

theMenu = HiWord( menuChoice ): 
theltem = LoWord( menuChoice ); 
switch ( theMenu ) 
I 

case APPLE_MENU_ID : 
HandleAppleChoice( 
break: 

case FI LE_MENU_ID : 
HandleFileChoice< 
break; 

case FONT_MENU_ID : 
HandleFontChoice( 
break: 

case STYLE_MENU_ID: 
HandleStyleChoice( 
break: 

I 
HiliteMenu( 0 ) : 

the Item 

theltem 

the Item 

the Item 

/******************************** HandleAppleChoice 

HandleAppleChoice( theltem ) 
int the Item: 
( 

) : 

) : 

) ; 

) : 

*******/ 
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I* 
* 
* 
*I 

St r255 accName; 
int accNumber; 
short int itemNumber: 
DialogPtr AboutDialog; 

switch ( theltem ) 
I 

case ABOUT_ITEM 

Alerts are extremely easy to do. Dialog boxes are 
much more complex (they're explained in Chapter 6). 
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NoteAlert( ABOUT_ALERT, NIL_POINTER ); 
break: 

default : 
I* 
* If the selection was not "About 

Desk Accessory ... 
open the selected 

* 
*I 

Getltem( gAppleMenu, theltem, accName ): 
accNumber = OpenDeskAccC accName ); 
break: 

/******************************** 

HandleFileChoice( theltem 
int the Item: 
I 

switch ( theltem ) 
I 

HandleFileChoice 

I* 
* 
* 

This is the correct way to exit an application: by 
selecting Quit from the File menu! 

*I 
case QUIT_ITEM : 

gDone = TRUE: 
break; 

/******************************** 

HandleFontChoice( theltem ) 
int the Item: 
I 

int fontNumber: 
Str255 font Name: 

HandleFontChoice 

*******/ 

*******/ 

I* Uncheck the old font, check the newly selected font */ 
Checkltem( gFontMenu, gLastFont, REMOVE_CHECK_MARK ); 
Checkltem( gFontMenu, theltem. ADD_CHECK_MARK ); 
gLastFont = theltem; 
Getltem< gFontMenu , theltem , fontName ); 
GetFNum( fontName , &fontNumber ); 

I* Change the font to the selected font ... */ 
TextFont( fontNumber ); 
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/******************************** HandleStyleChoice *******/ 

HandleStyleChoice( theltem ) 
int the Item: 
{ 

I* 
* gCurrentStyle accumulates the style changes made via the 
* Style menu. 
*I 

I* 
* 
* 
* 
*I 

switch( theitem 
{ 

case PLAIN_ITEM: 
gCurrentStyle = PLAIN: 
break: 

case BOLD_ITEM: 
if ( gCurrentStyle & bold ) 

gCurrentStyle bold: 
else 

gCurrentStyle I= bold: 
break: 

case ITALIC_ITEM: 
if ( gCurrentStyle & italic ) 

gCurrentStyle italic; 
else 

gCurrentStyle I= italic: 
break: 

case UNDERLINE_ITEM: 
if ( gCurrentStyle & underline ) 

gCurrentStyle underline; 
else 

gCu rrentStyl e I= under 1 i ne: 
break: 

case OUTLINE_ITEM: 
if ( gCurrentStyle & outline ) 

gCurrentStyle outline; 
else 

gCurrentStyle I= outline: 
break: 

case SHADOW_ITEM: 
if ( gCurrentStyle & shadow ) 

gCurrentStyle shadow: 
else 

gCurrentStyle I= shadow: 
break; 

Check or uncheck the appropriate items from the Style 
menu, then change the current text face to that encoded 
in gCurrentStyle. 

CheckStyles(); 
TextFace( gCurrentStyle ): 

/******************************** CheckStyles *******/ 

CheckStyles() 
I 
I* 
* 
* 
*I 

Check or uncheck each item on the Style menu, depending on 
the contents of gCurrentStyle. 
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/fdefi ne 
I/define 
I/define 
I/define 

I/define 
/fdefi ne 

#define 

//define 
I/define 

#define 
#define 

I/define 
#define 
#define 
I/define 
//define 
//define 
//define 
I/define 
fldef i ne 

Boolean 
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Checkltem( gStyleMenu, PLAIN_ITEM. gCurrentStyle == PLAIN ); 
Checkltem( gStyleMenu. BOLO_ITEM. gCurrentStyle & bold >: 
Checkltem( gStyleMenu. ITALIC_ITEM. gCurrentStyle & italic ); 
Checkltem( gStyleMenu. UNDERLINE_ITEM. gCurrentStyle & underline>: 
Checkltem( gStyleMenu. OUTLINE_ITEM, gCurrentStyle & outline ); 
Checkltem( gStyleMenu. SHADOW_ITEM, gCurrentStyle & shadow ); 

Chapter 5, Popup.c 

BASE_RES_I 0 400 
NI L_PO INTER OL 
MOVE_TO_FRONT -ll 
REMOVE_ALL_EVENTS 0 

MIN_SLEEP OL 
NIL_MOUSE_REGION OL 

DRAG_ THRESHOLD 30 

WNE_TRAP_NUM Ox60 
UNIMPL_TRAP_NUM Ox9F 

POPUP_MENU_ID BASE RES_ID 
NOT_A_NORMAL_MENU -1 

POPUP_LEFT 100 
POPUP _TOP 35 
POPUP_RIGHT 125 
POPUP_BOTTOM 52 
SHADOW_PIXELS 1 
RIGHT_MARGIN 5 
BOTTOM_MARGIN 4 
LEFT_MARGIN 5 
PIXEL_FOR_TOP _ LINE 1 

int 
MenuHandle 
Event Record 
Re ct 

gDone. gWNEimplemented; 
gPopUpltem = 1, gPopUpLabelWidth: 
gPopUpMenu: 
gTheEvent; 
gPopUpRect, gLabelRect, gDragRect; 

!*********************** Main *************/ 

main ( ) 
I 

Tool Boxlnit(); 
Windowlnit(): 
SetUpDragRect < >: 
MenuBarlnit(); 
DrawPopUp(); 
Main Loop ( ) : 
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/*********************************** ToolBoxlnit */ 

Tool Box I nit() 
I 

InitGraf{ &thePort >: 
InitFonts(): 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
InitWindows(); 
InitMenus C): 
TEinit(); 
lnitOialogs( NIL_POINTER ); 
lnitCursor<): 

/*********************Windowlnit**************/ 

Windowlnit() 
{ 

WindowPtr 

popUpWindow 

popUpWindow: 

GetNewWindow( BASE_RES_IO , NIL_POINTER, 
MOVE_TO_FRONT ) ; 

ShowWindow< popUpWindow >: 
SetPortC popUpWindow ); 
TextFont( systemFont ); 
TextModeC srcCopy ); 

/******************************** SetUpOragRect *********/ 

SetUpOragRectC) 
{ 

gOragRect = screenBits.bounds: 
gOragRect.left += ORAG_THRESHOLD: 
gOragRect.right -= DRAG_THRESHOLO; 
gOragRect.bottom -= ORAG_THRESHOLO; 

/*********************MenuBarlnit**************/ 

MenuBarlnit() 
I 
I* 
* 
* 
* 
* 
* 
*I 

Just as we did with the hierarchical menus in Timer, 
we load the MENU, and add it to the menu list via the 
call to InsertMenu(). Next, we get the popup label 
from the menu data structure and calculate its width in 
pixels. We'll use this information later. 

gPopUpMenu = GetMenu( POPUP_MENU_IO ); 
InsertMenuC gPopUpMenu, NOT_A_NORMAL_MENU ); 
Hlock( gPopUpMenu >: 
gPopUplabe l Width = Stri ngWi dth ( (**gPopUpMenu). menuData ) : 
HUnl ock( gPopUpMenu ) : 
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/********************* DrawPopUp **************/ 

DrawPopUp() 
{ 

I* 
* 
* 
* 
* 
*I 

I* 
* 
* 
*/ 

DrawPopUp() will draw the popup outline, its 1-pixel 
drop shadow, the popup label, and set glabelRect, 
which we'll invert when the popup is selected. DrawPopUp() 
will also be called to handle updateEvts. 

SetRect( &gPopUpRect, POPUP_LEFT, POPUP_TOP, 
POPUP_RIGHT, POPUP_BOTTOM ); 

FrameRect( &gPopUpRect ); 

MoveTo( gPopUpRect.left+SHADOW_PIXELS, gPopUpRect.bottom ); 
LineTo< gPopUpRect.right, gPopUpRect.bottom >: 
LineTo( gPopUpRect.right, gPopUpRect.top+SHADOW_PIXELS ); 

MoveTo( gPopUpRect.left - gPopUplabelWidth - RIGHT_MARGIN, 
gPopUpRect.bottom - BOTTOM_MARGIN ); 

Hlock( gPopUpMenu ); 
Drawstring( C**gPopUpMenu) .menuData ) : 
HUnlock( gPopUpMenu >: 

glabelRect.top ~ gPopUpRect.top + PIXEL_FOR_TOP_LINE; 
gLabelRect.left = gPopUpRect.left - gPopUpLabelWidth 

- LEFT_MARGIN - RIGHT_MARGIN; 
gLabelRect.right = gPopUpRect.left: 
gLabelRect.bottom = gPopUpRect.bottom: 

After the background is drawn, we can draw the current 
menu value, in this case, a number. 

DrawPopUpNumber(); 

/********************* DrawPopUpNumber **************/ 

DrawPopUpNumber() 
{ 

I* 
* 
* 
*I 

Str255 menultem; 
int itemleftMargin; 

Get the menu item corresponding to gPopUpltem, 
calculate the margin, and draw it ... 

Getltem( gPopUpMenu, gPopUpltem, &menultem ); 
itemLeftMargin = ( gPopUpRect.right - gPopUpRect.left -

StringWidth( menultem ) ) I 2; 
MoveTo( gPopUpRect.left + itemLeftMargin, 

gPopUpRect.bottom - BOTTOM_MARGIN ); 
Drawstring( menultem ); 
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/******************************** MainLoop *********/ 

MainLoop() 
{ 

gDone = FALSE: 
gWNElmplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) != 

NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) ); 
while ( gDone == FALSE ) 
{ 

HandleEvent(); 

/************************************* HandleEvent */ 

HandleEvent() 
I 

if ( gWNEimplemented ) 

else 
{ 

WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP. 
NIL_MOUSE_REGION ); 

SystemTask(); 
GetNextEvent( everyEvent, &gTheEvent ); 

switch C gTheEvent.what ) 
I 

case mouseDown: 
HandleMouseDown(): 
break: 

case updateEvt: 
Begi nUpdate( gTheEvent. message ) : 
DrawPopUp (): 
EndUpdate( gTheEvent.message >: 
break: 

/************************************* HandleMouseDown */ 

HandleMouseDown() 
I 

I* 
* 
* 
* 
*I 

WindowPtr 
short int 
long int 
Point 

whichWindow: 
thePart. i: 
theChoice: 
myPoi nt. popUpUpperLeft: 

thePart = FindWindow( gTheEvent.where, &whichWindow >: 
switch < thePart ) 
I 

case inContent: 

If the mouse was clicked in the window. copy the Point. 
convert it to the window's local coordinate system, and 
check to see if its inside gPopUpRect. If so ... 

myPoint = gTheEvent.where: 
GlobalToLocal( &myPoint ): 
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I* 
* 
* 
*I 

I* 
* 
* 
*/ 

//define 
/ldefi ne 
/ldefi ne 
//define 
/ldefi ne 
/ldefi ne 

//define 
//define 

/ldefi ne 

/ldefi ne 
/ldefi ne 
/ldefi ne 
I/define 
//define 
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if ( PtlnRect( myPoint, &gPopUpRect ) ) 
( 

... Invert the label, call PopUpMenuSelect, uninvert the 
label. Finally, handle the selection. 

l 

InvertRect( &glabelRect ); 
popUpUpperLeft.v = gPopUpRect.top + 

PIXEL_FOR_TOP_LINE: 
popUpUpperLeft.h = gPopUpRect.left: 
LocalToGlobal( &popUpUpperleft ): 
theChoice = PopUpMenuSelect( gPopUpMenu, 

popUpUpperleft.v, popUpUpperleft.h, 
gPopUpltem ): 

InvertRect( &glabelRect ); 
if ( LoWordC theChoice ) > O ) 
I 

gPopUpltem = LoWord( theChoice ): 
DrawPopUpNumber(): 
for ( i=O; i<gPopUpltem: i++ ) 

SysBeepC 20 ): 

break; 
case inSysWindow: 

SystemClick( &gTheEvent. whichWindow ): 
break: 

case inDrag: 
DragWindowC whichWindow, gTheEvent.where, &gDragRect): 
break: 

case inGoAway : 

Again, this is not the way "proper" Macintosh applications 
exit. We would normally use a Quit item in the File menu. 

gDone = TRUE; 
break: 

Chapter 6, Reminder.c 

BASE_RES_ID 400 
ABOUT_ALERT 401 
BAD_SYS_ALERT 402 
NIL_POINTER OL 
MOVE_TO_FRONT -ll 
REMOVE_ALL_EVENTS 0 

MIN_SLEEP OL 
NIL_MOUSE_REGION OL 

DRAG_ THRESHOLD 30 

SAVE_BUTTON 1 
CANCEL_BUTTON 2 
TIME_FIELD 4 
S_OR_M_FIELD 5 
SOUND_ON_BOX 6 
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#define ICON_ON_BOX 
#define ALERT_ON_BOX 
//define SECS_RAD IO 
#define MINS_RADIO 

//define DE FAUL T_SECS_ID 
#define DEFAULT_MINS_ID 

#define ON 
#define OFF 

#define SECONDS 
#define MINUTES 
#define SECONDS_PER_MINUTE 

#define TOP 
#define LEFT 

//define MARK_APPLICATION 

#define APPLE_MENU_ID 
#define FI LE_MENU_ID 
//define ABOUT _I TEM_ID 

#define CHANGE_ ITEM 
//define START _STOP _ITEM 
//define KI LL_I TEM 
//define OUIT_ITEM 

#define SYS_VERSION 

7 
8 
10 
11 

401 
402 

1 
0 

0 
1 
60 

25 
12 

BASE_RES_ID 
BASE_RES_ID+l 
1 

1 
2 
3 
4 

I* Version Number of SysEnvirons */ 

DialogPtr gSettingsDialog: 
gDragRect: Re ct 

Boolean 
char 
StringHandle 
NM Rec 
MenuHandle 
EventRecord 

gDone, gCounting, gNotify_set: 
gSeconds_or_minutes = SECONDS: 
gNoti fyStrH. gDefaultSecsH. gDefaultMi nsH: 
gMyNMRec: 
gAppleMenu, gFileMenu: 
gTheEvent: 

struct 
{ 

Str255 timeString; 
int sound: 
int icon: 
int alert; 
int secsRadio: 
int minsRadio: 

savedSettings: 

/******************************** main *********/ 

main< ) 
I 

I* 
* 
* 
*I 

ToolBoxlnit(); 

Since we'll be using the Notification Manager. we have to make 
sure System 6.0 or later is installed. 
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if 
I 

Sys60rlater () ) 

Dialoglnit(); 
MenuBarlnit(); 
SetUpOragRect(); 
Notifylni t(); 
Mainloop(); 

/*********************************** ToolBoxlnit */ 

ToolBoxlnit() 
I 

InitGraf( &thePort ) ; 
Ini tFonts(): 
Fl ushEvents ( everyEvent, REMOVE_ALL_EVENTS ) ; 
I ni tWi ndows (); 
I nitMenus (); 
TEinit(); 
InitDialogs( NIL_POINTER ); 
Ini tCursor(); 

/******************************** Sys60rlater *********/ 

int Sys60rlater() 
I 

OS Err 
SysEnvRec 

status; 
SysEnvOata; 
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I* 
* 
* 
*I 

SysEnvirons() is documented in (V:5-6). We're interested in 
the systemVersion field. 

status = SysEnvirons( SYS_VERSION. &SysEnvData ); 
if (( status != noErr ) I I < SysEnvData.systemVersion < Ox0600 )) 
I 

I 
else 

StopAlert( BAD_SYS_ALERT, NIL_POINTER ); 
return( FALSE ) : 

return( TRUE ); 

/******************************** Dialoglnit *********/ 

Di a 1 og In it ( ) 
I 

int 
Re ct 
Handle 

itemType; 
itemRect; 
itemHandle; 

I* These 2 'STR 's hold the default values for minutes 
and seconds */ 

gOefaultSecsH GetString( OEFAULT_SECS_IO ); 
gOefaultMinsH = GetString( DEFAULT_MINS_IO ); 
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I* 
* 
* 
* 
* 
*/ 

I* 

Load gSettingsDialog with GetNewDialog{). You can treat 
it like a WindowPtr. If you want to draw in the Dialog 
window, use SetPort first to make the dialog port the current 
port. 

gSettingsDialog = GetNewDialog( BASE_RES_ID, NIL_POINTER, 
MOVE_TO_FRONT ) : 

* Get a handle to the dialog items to be initialized with 
* GetDitem{), use SetCtlValue{) to set the control's value. 
*/ 

GetDitemC gSettingsDialog, SECS_RADIO, &itemType, &itemHandle, 
&i temRect ) : 

SetCtlValue< itemHandle, ON >: 
GetDitem< gSettingsDialog, SOUND_ON_BOX. &itemType, &itemHandle, 

&itemRect ); 
SetCtlValue{ itemHandle, ON >: 
GetDitem( gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle, 

&itemRect ); 
SetCtlValue( itemHandle, ON >: 
GetDitem( gSettingsDialog, ALERT_ON_BOX. &itemType, &itemHandle, 

&itemRect >: 
SetCtlValue< itemHandle, ON ); 

!*********************************** MenuBarlnit */ 

MenuBarlnit() 
{ 

Handle myMenuBar: 

myMenuBar = GetNewMBar{ BASE_RES_ID ); 
SetMenuBar( myMenuBar ): 
gAppleMenu = GetMHandle( APPLE_MENU_IO ); 
AddResMenu< gAppleMenu, 'DRVR' ): 
gFileMenu = GetMHandle( FILE_MENU_ID ); 
DrawMenuBar(); 

/******************************** SetUpDragRect *********/ 

SetUpDragRect() 
{ 

gDragRect = screenBits.bounds: 
gDragRect.left += DRAG_THRESHOLD; 
gDragRect.right -= DRAG_THRESHOLD: 
gDragRect.bottom -= DRAG_THRESHOLO; 

/******************************** Notifylnit *********/ 

Notifylnit() 
I 
I* Initialize the notification data structure */ 

gNotifyStrH = GetString{ BASE_RES_ID ); I* The Alert string */ 
gMyNMRec.qType = nmType; /* All notifs use this type */ 
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gMyNMRec.nmMark = MARK_APPLICATION: /* mark the applications 
entry in the apple menu */ 

gMyNMRec.nmResp = NIL_POINTER: /* don't use a response 
routine */ 

/******************************** MainLoop *********/ 

MainLoop() 
I 
I* 
* gCounting is TRUE while the countdown is happening. gNotify_set 
* is TRUE while the notification is set. 
*/ 

gDone = FALSE: 
gCounting = FALSE: 
gNotify_set = FALSE; 

while ( gDone == FALSE 
I 

HandleEvent(); 

/************************************* HandleEvent */ 

HandleEvent() 
I 

/* 
* 
* 
*/ 

char theCha r: 

Because we're running System 6.0 or later, we don't need 
to check for WaitNextEvent(). 

WaitNextEvent( everyEvent, &gTheEvent. MIN_SLEEP. 

switch ( gTheEvent.what ) 
! 

case mouseDown: 
HandleMouseDown(); 
break: 

case keyDown: 
case autoKey: 

NIL_MOUSE_REGION ); 

theChar = gTheEvent.message & charCodeMask; 
if (( gTheEvent.modifiers & cmdKey ) != O ) 

HandleMenuChoice( MenuKey( theChar ) >: 
break; 

/************************************* HandleMouseDown */ 

HandleMouseDown() 
I 

WindowPtr 
short int 
1 ong int 

whichWindow: 
thePart; 
menuChoice, windSize: 
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thePart = FindWindow( gTheEvent.where, &whichWindow ); 
switch C thePart ) 
I 

case inMenuBar: 
menuChoice = MenuSelect( gTheEvent.where ); 
HandleMenuChoice( menuChoice ); 
break: 

case inSysWindow : 
SystemClick( &gTheEvent. whichWindow ): 
break: 

case inDrag : 
DragWindow( whichWindow, gTheEvent.where, &gDragRect); 
break: 

case inGoAway : 
gDone = TRUE: 
break; 

/************************************* HandleMenuChoice */ 

HandleMenuChoice( menuChoice 
long int menuChoice: 
I 

int theMenu: 
int the Item: 

if menuChoice != 0 ) 
I 

theMenu = HiWord( menuChoice ): 
theltem = LoWord( menuChoice ); 
switch ( theMenu ) 
I 

} 

case APPLE_MENU_ID : 
HandleAppleChoice( theltem ): 
break: 

case FILE_MENU_ID : 
HandleFileChoice( theltem ): 
break: 

HiliteMenu( 0 ): 

/******************************** HandleAppleChoice 

HandleAppleChoice< theltem ) 
int the Item: 
{ 

Str255 
int 
short int 

accName: 
accNumber: 
itemNumber: 

switch < theltem ) 
I 

case ABOUT_ITEM_ID : 

*******/ 

NoteAlert( ABOUT_ALERT, NIL_POINTER ); 
break: 
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default : 
Getltem( gAppleMenu. theltem. accName >: 
accNumber = OpenDeskAccC accName ); 
break: 

/******************************** HandleFileChoice *******/ 

HandleFileChoice( theltem ) 
int the Item: 
{ 

/* 
* 
* 
* 
* 
*I 

Str255 timeString: 
long countDownTime: 
int i temType: 
Rect i temRect: 
Handle itemHandl e: 

switch ( theltem ) 
( 

case CHANGE_ITEM : 
I* Change Settings */ 
HandleDialog(); 
break: 

case START_STOP_ITEM : 
I* Start or Stop the Countdown */ 
if ( gCounting ) /* Stop Countdown */ 
( 

Setltem( gFileMenu,theltem,"\pStart Countdown"): 
gCounting = FALSE: 

else /* Start Countdown */ 

Start the countdown by unhilighting the menu, getting the time 
field from the settings dialog, disabling the "Change Settings" 
menu item, changing "Start Countdown" to "Stop Countdown" and. 
finally. calling CountDown(). 

HiliteMenu( 0 ); 
GetDitem( gSettingsDialog. TIME_FIELD. 

&itemType, &itemHandle, &itemRect ); 
GetlText( itemHandle, &timeString ); 
StringToNum( timeString, &countDownTime ); 

Disableltem( gFileMenu, CHANGE_ITEM ); 
/* Disable Change Settings */ 

SetitemC gFileMenu, theltem,"\pStop Countdown"): 
CountDown( countDownTime ); 

I* Once Countdown() returns. reenable "Change Settings", 
change "Stop Countdown" to "Start Countdown" */ 

Enableltem( gFileMenu, CHANGE_ITEM ); 
/* Reenable Change Settings */ 

Setltem( gFileMenu,theltem,"\pStart Countdown"); 
I 
break: 

case KI LL_ITEM : 
I* Kill Notification */ 
NMRemove( &gMyNMRec >: 
HUn 1 ock ( gNot i fyStrH ) : 
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I* 
* 
* 
* 
* 
* 
*I 

Disableltem( gFileMenu, KILL_ITEM ); 
gNotify_set = FALSE: 
break: 

case QUIT_ITEM : 

There is a call to HandleEvent() inside Countdown(), so the Quit 
item might be selected during the countdown. Setting gCounting 
to FALSE will cause us to drop out of the Countdown() event 
loop. Setting gDone to TRUE will drop us out of the main event 
1 oop. 

gCounting = FALSE: 
gOone = TRUE: 
break: 

!******************************** HandleDialog *********/ 

HandleDialog() 
I 

I* 
* 
* 
*I 

int 
1 ong 
Str255 
int 
Re ct 
Handle 

itemHit, dialogDone 
alarmDelay: 
delayString: 
itemType: 
itemRect: 
itemHandle: 

FALSE; 

ShowWindow( gSettingsDialog ); 
SaveSettings(); 

while ( dialogDone 
I 

FALSE 

call ModalDialog() to find out which item was hit, then 
process that item. 

ModalDialog( NIL_POINTER, &itemHit ); 
switch ( itemHit ) 
I 

case SAVE_BUTTON: 
HideWindow( gSettingsDialog ): 
dialogDone = TRUE: 
break: 

case CANCEL_BUTTON: 
Hi deWi ndow( gSett i ngsOi a 1 og ) : 
RestoreSettings(); 
dialogDone = TRUE: 
break: 

case SOUND_ON_BOX: 
GetDltem( gSett i ngsDi a 1 og. SOUND_ON_BOX. 

&itemType, &itemHandle, &itemRect ); 
/* This is a nice technique for flipping the value of checkboxes */ 

SetCtlValue( itemHandle. 

break: 
case ICON_ON_BOX: 

! GetCtlValue< itemHandle ) >: 

GetDitem( gSettingsDialog, ICON_ON_BOX. 
&itemType, &itemHandle, &itemRect >: 

SetCtlValue( itemHandle, 
! GetCtlValue( itemHandle ) ); 

break: 
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I* 
* 
* 
*I 

I* 
* 
* 
*I 
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case ALERT_ON_BOX: 
GetDitem( gSettingsDialog, ALERT_ON_BOX. 

&itemType, &itemHandle. &itemRect ); 
SetCtlValue( itemHandle. 

break: 
case SECS_RADIO: 

! GetCtlValue( itemHandle ) ); 

Turn off the minutes radio button, turn on the seconds 
radio button. Change the string from ·minutes" to ·seconds". 

gSeconds_or_minutes = SECONDS: 
GetDitem( gSettingsDialog, MINS_RADIO, 

&itemType, &itemHandle, &itemRect ); 
SetCtlValue< itemHandle, OFF ); 
GetDitem( gSettingsDialog, SECS_RADIO, 

&itemType, &itemHandle, &itemRect ); 
SetCtlValue( itemHandle, ·oN ); 
GetD I tern( gSet ti ngsDi a 1 og. S_OR_M_F I ELD. 

&itemType, &itemHandle. &itemRect ); 
SetIText< itemHandle. "\pseconds" >: 
GetDitem( gSettingsDialog, TIME_FIELD. 

&itemType, &itemHandle, &itemRect ); 
HLock( gDefaultSecsH ); 
SetIText( itemHandle, *gDefaultSecsH ); 
HUnlockC gDefaultSecsH ); 
break: 

case MINS_RADIO: 

Turn off the seconds radio button. turn on the minutes 
radio button. Change the string from ·seconds" to "minutes". 

gSeconds_or_minutes = MINUTES: 
GetDitem( gSetti ngsDi al og, SECS_RADIO, 

&itemType, &itemHandle, &itemRect ); 
Set Ct 1Va1 ue( i temHandl e. OFF ) : 
GetDitem( gSettingsDialog, MINS_RADIO. 

&itemType, &itemHandle, &itemRect ); 
SetCtlValue( itemHandle, ON); 
GetDitem( gSettingsDialog, S_OR_M_FIELD, 

&itemType, &itemHandle, &itemRect ); 
SetlText( itemHandle, ·\pminutes" ); 
GetDitem( gSettingsDialog, TIME_FIELD, 

&itemType, &itemHandle, &itemRect ); 
HLock( gDefaul tMi nsH ) : 
Set!Text( itemHandle. *gDefaultMinsH ); 
HUnl ock( gDefaul tMi nsH ) : 
break: 

/************************************* SaveSettings */ 

SaveSettings() 
I 

int i temType: 
Rect itemRect: 
Handle itemHandl e: 
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/* 
* 
* 
*I 

Fill the savedSettings data structure with all the current 
settings. If the user Cancels, we can restore the data. 

GetDitem( gSettingsDialog, TIME_FIELD. &itemType, &itemHandle, 
&itemRect >: 

Get!Text( itemHandle, &CsavedSettings.timeString) ); 
GetDitem( gSettingsDialog, SOUND_ON_BOX, &itemType, &itemHandle, 

&itemRect ); 
savedSettings.sound = GetCtlValue( itemHandle ); 
GetDitem< gSettingsDialog, ICON_ON_BOX, &itemType, &itemHandle, 

&itemRect ); 
savedSettings.icon = GetCtlValue( itemHandle ); 
GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle, 

&itemRect ); 
savedSettings.alert = GetCtlValue( itemHandle ); 
GetDitem( gSettingsDialog, SECS_RADIO. &itemType, &itemHandle, 

&itemRect ); 
savedSettings.secsRadio = GetCtlValue( itemHandle ); 
GetDitem( gSettingsDialog, MINS_RADIO, &itemType. &itemHandle, 

&itemRect ); 
savedSettings.minsRadio = GetCtlValue( itemHandle ); 

/************************************* RestoreSettings */ 

RestoreSettings() 
{ 

/* 
* 
* 
* 
*/ 

int i temType; 
Rect i temRect; 
Handle itemHandle: 

Use the information in the savedSettings data structure to 
restore the fields in the settings dialog. Usually occurs 
as the result of the user hitting the Cancel button. 

GetDitem( gSettingsDialog, TIME_FIELD, &itemType. &itemHandle, 
&itemRect ); 

Set!Text( itemHandle, savedSettings.timeString ); 
GetDitem( gSettingsDialog. SOUND_ON_BOX. &itemType, &itemHandle, 

&itemRect ); 
SetCtlValue( itemHandle, savedSettings.sound >: 
GetDitem( gSett i ngsDi a 1 og. ICON_ON_BOX. &i temType. &itemHandl e. 

&itemRect ); 
SetCtlValue( itemHandle, savedSettings.icon ); 
GetDitem< gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle, 

&itemRect >: 
SetCtlValue( itemHandle, savedSettings.alert ); 
GetDltem( gSettingsDialog, SECS_RADIO. &itemType, &iternHandle, 

&itemRect >: 
SetCtlValue( itemHandle, savedSettings.secsRadio >: 
GetDitem< gSettingsDialog, MINS_RADIO, &itemType. &itemHandle, 

&itemRect >: 
SetCtlValue( itemHandle, savedSettings.minsRadio ); 

if savedSettings.secsRadio == ON ) 
I 

GetDitem( gSettingsDialog, S_OR_M_FIELD, &itemType, 
&itemHandle, &itemRect ); 
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else 
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Set IT ext ( itemHandl e, "\pseconds" ) ; 

GetDitem( gSettingsDialog, S_OR_M_FIELD, &itemType, 
&itemHandle. &itemRect ); 

SetIText( itemHandle, "\pminutes" >: 

/******************************** Count Down *******/ 

CountDownC numSecs 
long numSecs: 
I 

long 
Str255 
WindowPtr 

myTime, oldTime, difTime; 
myTimeString; 
countDownWindow: 

I* Load the countDownWindow. set its attributes ... */ 
countDownWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER. 

I* 
* 
* 
* 
*I 

SetPort( countDownWindow ); 
ShowWindow( countDownWindow >: 
TextFace< bold >: 
TextSi ze< 24 ) : 

MOVE_TO_FRONT ) ; 

Get the time in seconds. Convert countdown time to seconds 
if it's in minutes. Finally, turn on the countdown flag, 
so the rest of the program knows we're counting ... 

GetDateTime( &myTime ); 
oldTime = myTime: 
if ( gSeconds_or_minutes == MINUTES ) 

numSecs *= SECONDS_PER_MINUTE: 
gCounting =TRUE: 

I* The counting event loop ... */ 
while ( ( numSecs > 0 ) && ( gCounting ) ) 
( 

HandleEvent(): 
if C gCounting ) 
I 

MoveTo( LEFT, TOP ); 
GetDateTime( &myTime ): 
if ( myTime != oldTime ) 
I 

difTime = myTime - oldTime; 
numSecs = numSecs - difTime; 
oldTime = myTime: 
NumToString( numSecs , myTimeString ); 
EraseRect ( &CcountDownWindow->portRect) ) : 
Drawstring( myTimeString ); 
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I* If we haven't canceled, set the notification, turn off 
the counting flag. hide the counting window ... */ 

if C gCount i ng ) 
SetNotification(); 

gCounting = FALSE: 
HideWindow< countDownWindow ): 

/******************************** SetNotification *******/ 

SetNotification() 
I 

I* 
* 
* 
*I 

int itemType: 
Rect i temRect: 
Handle itemHandle: 

If there was already a notification set, remove it, 
unlock the notify string. 

if gNotify_set ) 
I 

NMRemoveC &gMyNMRec ): 
HUnlock( gNotifyStrH ); 

I* Set the various fields of the notification data structure ... */ 
GetDitem( gSettingsDialog, ICON_ON_BOX. &itemType. &itemHandle, 

&itemRect ): 
if < GetCtlValue( itemHandle ) ) 

I* 
* 
* 
* 
* 
*I 

I* 

gMyNMRec.nmSicon = GetResource( "SICN', BASE_RES_ID ); 
else 

gMyNMRec.nmSicon = NIL_POINTER: 

GetDitem( gSettingsDialog, SOUND_ON_BOX. &itemType, &itemHandle, 
&i temRect ) : 

if < GetCtlValueC itemHandle ) ) 
gMyNMRec. nmSound GetResource( • snd · BASE RES_ID ) : 

else 
gMyNMRec.nmSound = NIL_POINTER: 

GetDitem( gSettingsDialog, ALERT_ON_BOX, &itemType, &itemHandle, 
&itemRect ); 

if C GetCtlValueC itemHandle > ) 
( 
Since we'll be dereferencing the Handle to a Pointer, we better 
lock gNotifyStrH. First, we'll call MoveHHi() to defragment 
the heap as much as possible. If we were using the handle as is, 
or using the handled data (as a value). we wouldn't need to lock 
the handle. 

I 
else 

MoveHHi ( gNot i fyStrH ) : 
Hlock( gNotifyStrH >: 
gMyNMRec.nmStr *gNotifyStrH: 

gMyNMRec.nmStr = NIL_POINTER; 

* Install the notification on the notification queue, enable the 
* "Kill Notification" item, turn on the notification flag. 
*I 
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/ldefine 
I/define 
#define 
I/define 

#define 
//define 

/ldefine 
/ldefine 
I/define 

I/define 
#define 
#define 
//define 

//define 
//define 
//define 

I/define 

//define 
I/define 
//define 

//define 
//define 

#define 

/ldefi ne 
//define 

NMinstall( &gMyNMRec ); 
Enableltem( gFileMenu, KILL_ITEM ); 
gNotify_set = TRUE; 

Chapter 7, WindowMaker.c 

BASE_RES_ID 400 
NI L_POINTER OL 
MOVE_TO_FRONT -ll 
REMOVE_ALL_EVENTS 0 

APPLE_MENU_ID 400 
FILE_MENU_ID 401 

ABOUT_ITEM 1 
ABOUT_ALERT 400 
ERROR_ALERT_ ID 401 

NO_MBAR BASE_RES_ID 
NO_MENU BASE_RES_ID+l 
NO_PICTURE BASE_RES_ID+2 
NO_WIND BASE_RES_ID+3 

NEW_ ITEM 1 
CLOSE_ITEM 2 
QUIT_ITEM 3 

DRAG_ THRESHOLD 30 

WINDOW_HOME_LEFT 5 
WINDOW_HOME_TOP 45 
NEW_WINDOW_OFFSET 20 

MIN_SLEEP OL 
NIL_MOUSE_REGION OL 

LEAVE_WHERE_IT_IS FALSE 

WNE_TRAP_NUM Ox60 
UNIMPL_TRAP_NUM Ox9F 

#define NIL_STRING "\p" 
#define HOPELESSLY_FATAL_ERROR "\pGame over, man!" 

Boolean 
Event Record 
MenuHandle 
PicHandle 
Re ct 
int 

gDone, gWNEimplemented; 
gTheEvent; 
gAppleMenu: 
gMyPicture: 
gDragRect; 
gNewWindowleft = WINDOW_HOME_LEFT, 

gNewWindowTop = WINDOW_HOME_TOP; 
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/******************************** main *********/ 

main() 
I 

ToolBoxlnit(): 
MenuBarlnit(): 
LoadPicture(); 
SetUpDragRect (): 

Mainloop(); 

/*********************************** ToolBoxlnit */ 

ToolBoxlnit() 
{ 

InitGraf( &thePort >: 
I nit Fonts (): 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
InitWindowsC): 
InitMenus<): 
TEinit(}: 
lnitDialogs( NIL_POINTER >: 
InitCursor(); 

!*********************************** MenuBarlnit */ 

MenuBarlnit() 
I 

I* 
* 
* 
* 
* 
* 
* 
* 
*I 

Handle myMenuBar: 

This is an example of error handling in a Macintosh program. 
If you want to write an application for public consumption, 
you must do error handling. The question is, how much is 
enough? The answer: you should feel pretty certain that a 
user will never get the dreaded bomb box. Even if your 
application reaches a point of no return, you should at the 
least put up a fatal error alert. then exit to the Finder. 

if ( ( myMenuBar = GetNewMBar( BASE_RES_ID ) ) NIL_POINTER 
ErrorHandler( NO_MBAR >: 

SetMenuBar( myMenuBar ): 
if ( ( gAppleMenu = GetMHandleC APPLE_MENU_ID ) ) == NIL_POINTER ) 

ErrorHandlerC NO_MENU ); 
AddResMenu( gAppleMenu. 'DRVR' >: 
DrawMenuBarC>: 

/******************************** LoadPicture *********/ 

LoadPicture() 
{ 

I* 
* 
* 
*I 

Functions that return error codes are great candidates 
for error checking! 

if ( ( gMyPicture = GetPicture( BASE_RES_ID ) ) == NIL_POINTER ) 
ErrorHandlerC NO_PICTURE ); 
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!******************************** SetUpDragRect *********/ 

SetUpDragRect() 
I 

gDragRect = screenBits.bounds; 
gDragRect.left += DRAG_THRESHOLD; 
gDragRect.right -= DRAG_THRESHOLD: 
gDragRect.bottom -= DRAG_THRESHOLD; 

/******************************** MainLoop *********/ 

MainLoop() 
{ 

gOone = FALSE; 
gWNEimplemented = ( NGetTrapAddress( WNE_TRAP_NUM, ToolTrap ) != 

NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) ); 
while ( gDone == FALSE ) 
{ 

HandleEvent(); 

/************************************* HandleEvent */ 

HandleEvent() 
I 

char theCha r: 

if ( gWNEimplemented ) 

else 
I 

WaitNextEvent( everyEvent, &gTheEvent, MIN_SLEEP, 
NIL_MOUSE_REGION ); 

SystemTask(); 
GetNextEvent( everyEvent, &gTheEvent ); 

switch C gTheEvent.what ) 
I 

case mouseDown: 
HandleMouseDown(); 
break; 

case keyDown: 
case autoKey: 

theChar = gTheEvent.message & charCodeMask: 
if (( gTheEvent.modifiers & cmdKey ) != 0) 

HandleMenuChoice( MenuKey( theChar ) ); 
break; 

case updateEvt: 
BeginUpdate( gTheEvent.message ); 
DrawMyPictureC gMyPicture, gTheEvent.message ); 
EndUpdate( gTheEvent.message ); 
break; 
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/************************************* HandleMouseDown */ 

HandleMouseDown() 
I 

I* 
* 
* 
* 
* 
* 
* 
*I 

WindowPtr 
short int 
long int 

whichWindow; 
thePart; 
menuChoice, windSize; 

thePart = FindWindow( gTheEvent.where, &whichWindow ); 
switch < thePart ) 
{ 

case inMenuBar: 
menuChoice = MenuSelectC gTheEvent.where ); 
HandleMenuChoice( menuChoice ); 
break; 

case inSysWindow: 
SystemClick( &gTheEvent, whichWindow ); 
break; 

case inDrag: 
DragWindow( whichWindow, gTheEvent.where, &gDragRect); 
break; 

case inGoAway: 

In previous programs, we've used the goAway box to exit the 
application. This was evil and incorrect! The goAway box is 
a signal to close the window and should behave just as if the 
user selected Close from the File menu. We'll use 
DisposeWindow() to close the window and free up the memory used 
by the window. 

DisposeWindow( whichWindow ); 
break; 

/************************************* HandleMenuChoice */ 

HandleMenuChoice( menuChoice 
long int menuChoice: 
I 

int theMenu: 
int the Item: 

if menuChoice != 0 > 
I 

theMenu = HiWord( menuChoice ); 
theltem = LoWord( menuChoice ); 
switch ( theMenu ) 
I 

} 

case APPLE_MENU_ID : 
HandleAppleChoice( theltem ); 
break: 

case FILE_MENU_ID : 
HandleFileChoice( theltem ); 
break; 

HiliteMenu( 0 ); 
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/******************************** HandleAppleChoice *******/ 

HandleAppleChoice( theitem ) 
int the Item: 
I 

Str255 accName: 
int accNumber: 

switch theltem ) 
I 

case ABOUT_ITEM : 
NoteAlert( ABOUT_ALERT, NIL_POINTER ); 
break: 

default : 
GetitemC gAppleMenu. theltem. accName >: 
accNumber = OpenDeskAcc< accName ); 
break: 

/******************************** HandleFileChoice *******/ 

HandleFileChoiceC theltem ) 
int the Item: 
I 

WindowPtr whichWindow: 
switch < theltem ) 
I 

case NEW_ITEM : 
CreateWindow<): 
break: 

case CLOSE_ITEM : 
if ( ( whichWindow = FrontWindow() ) != NIL_POINTER 

DisposeWindow( whichWindow ); 
break; 

case OUIT_ITEM : 
I* This is the corect time to exit the application! */ 

gDone = TRUE: 
break: 

!************************************ CreateWindow */ 

CreateWindow() 
I 

/* 
* 
* 
* 
* 
* 
* 
* 
*I 

WindowPtr theNewestWindow: 

One of the most important features of this application is its 
ability to create a large number of windows, limited only 
by the memory available on the machine. We put up an error 
message if we can't allocate enough memory to open the window. 
Your application may want to put up an Alert, but allow the 
user to continue. The true test of your application us. how 
well it performs under stress. 
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I* 
* 
* 
* 
*! 

if ( ( theNewestWindow = GetNewWindowC BASE_RES_ID. NIL_POINTER. 
MOVE_TO_FRONT ) ) == NIL_POINTER 

ErrorHandler< NO_WIND ); 

New windows are created down and to the right by NEW_WINDOW_OFFSET 
pixels. If the new window will be created too close to the edge 
of the screen, move back to the upper left ... 

if (((screenBits.bounds.right-gNewWindowleft) < DRAG_THRESHOLD) I I 
((screenBits.bounds.bottom-gNewWindowTop) < DRAG_THRESHOLD)) 

gNewWindowleft = WINDOW_HOME_LEFT: 
gNewWindowTop = WINDOW_HOME_TOP: 

MoveWindowC theNewestWindow, gNewWindowLeft. gNewWindowTop, 
LEAVE_WHERE_IT_IS ): 

gNewWindowleft += NEW_WINDOW_OFFSET: 
gNewWindowTop += NEW_WINDOW_OFFSET: 
ShowWindow( theNewestWindow ); 

/******************************** DrawMyPicture *********/ 

DrawMyPicture( thePicture, pictureWindow 
PicHandle thePicture: 
WindowPtr pictureWindow; 
I 

Rect myRect: 

myRect = pictureWindow->portRect; 
CenterPictC thePicture, &myRect >: 
SetPortC pictureWindow ): 
DrawPicture( thePicture. &myRect ): 

!******************************** CenterPict *********/ 

CenterPict( thePicture. myRectPtr 
PicHandle thePicture: 
Rect *myRectPtr; 
I 

Rect windRect, pictureRect: 

windRect = *myRectPtr: 
pictureRect = (**( thePicture )).picFrame: 
myRectPtr->top = CwindRect.bottom - windRect.top -

CpictureRect.bottom - pictureRect.top))/ 2 + 
windRect.top; 

myRectPtr->bottom = myRectPtr->top + 
CpictureRect.bottom - pictureRect.top); 

myRectPtr->left = CwindRect.right - windRect.left -
CpictureRect.right - pictureRect.left))/ 2 + 

wi ndRect. 1 eft: 
myRectPtr->right = myRectPtr->left + (pictureRect.right -

pictureRect.left); 
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/******************************** ErrorHandler *********/ 

ErrorHandl er( stri ngNum ) 
int stringNum: 
I 

/* 
* 
* 
* 
* 
*I 

StringHandle errorStringH: 

Load the error message from the resource fork. Use ParamText() 
to make it the first parameter. This will replace "AO" in a 
text item of a dialog box. If we couldn't get the string, we're 
in deep trouble, so we put up the HOPELESSLY_FATAL_ERROR ... 

if errorStringH = GetString( stringNum ) ) == NIL_POINTER ) 

else 
I 

I 

ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING, 
NIL_STRING ); 

HLock( errorStringH ): 
ParamText( *errorStringH, NIL_STRING, NIL_STRING, 

NIL_STRING ); 
HUnlockC errorStringH ) : 

StopAlert( ERROR_ALERT_ID, NIL_POINTER ); 
I* ExitToShell() returns to the calling program immediately. */ 

ExitToShell <): 

Chapter 7, ShowClip.c 

#define BASE_RES_ID 
#define NIL_POINTER 
#define MOVE_TO_FRONT 
#define REMOVE_ALL_EVENTS 

/tdef i ne ERROR_ALERT_ID 
#define NO_WIND 
#define EMPTY_SCRAP 

#define NIL_STRING 

400 
OL 
-ll 
0 

BASE_RES_ID 
BASE_RES_ID 
BASE_RES_ID+l 

"\p" 
#define HOPELESSLY_FATAL_ERROR "\pGame over, man!" 

WindowPtr gClipWindow: 

/******************************** main *********/ 

main() 
I 

ToolBoxlnit(): 
Windowlnit(): 
Mainloop(): 
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/******************************** ToolBoxlnit *********/ 

Tool Boxlnit() 
I 

lnitGraf( &thePort ) : 
InitFonts(); 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
InitWindows(); 
InitMenus(); 
TEinit(); 
InitDialogs( NIL_POINTER ); 
InitCursor(): 

/******************************** Windowlnit *********/ 

Windowlnit() 
I 

if ( ( gClipWindow = GetNewWindow( BASE_RES_ID, NIL_POINTER, 
MOVE_TO_FRONT ) ) == NIL_POINTER ) 

ErrorHandler( NO_WIND ); 
ShowWindow( gClipWindow ); 
SetPort( gClipWindow ): 

/******************************** Mainloop *********/ 

Mainloop() 
I 

I* 
* 
* 
* 
* 
*I 

/* 
* 
* 
*I 

Re ct 
Handle 

myRect; 
clipHandle: 

1 ong int 1 ength, offset: 

clipHandle NewHandle( 0 ): 

GetScrap() resizes clipHandle to hold the scrap data of the 
specified type. While TEXT and PICT are the primary types, you 
can design your own scrap type or use other folks' types, but 
if you do, you better know what's at the other end of the handle. 

if ( ( length= GetScrapC clipHandle, 'TEXT'. &offset ) ) < O 
I 

I 
else 
I 

if (( length= GetScrapC clipHandle, 'PICT' .&offset )) < 0 ) 
ErrorHandler( EMPTY_SCRAP ); 

else 
I 

myRect = gClipWindow->portRect; 
CenterPictC clipHandle, &myRect >: 
DrawPicture( clipHandle, &myRect ): 

HLock( clipHandle ): 

We used TextBox() to draw the text in the current port {that's 
why we used the OuickDraw global thePort), left justified. 
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TextBox( *clipHandle, length. &CthePort->portRect), 
teJustLeft ); 

HUnlock( clipHandle ); 

while ( !Button() ) ; 

/******************************** CenterPict *********/ 

CenterPict( thePicture, myRectPtr 
PicHandle thePicture; 
Rect *myRectPtr; 
I 

Rect wi ndRect, pi ctureRect; 

windRect = *myRectPtr: 
pictureRect = (**( thePicture )).picFrame: 
myRectPtr->top = (windRect.bottom - windRect.top -

CpictureRect.bottom - pictureRect.top))/ 2 + 
windRect.top; 

myRectPtr->bottom = myRectPtr->top + 
(pictureRect.bottom - pictureRect.top); 

myRectPtr->left = CwindRect.right - windRect.left -
CpictureRect.right - pictureRect.left))/ 2 + 

windRect.left: 
myRectPtr->right = myRectPtr->left + CpictureRect.right -

pictureRect.left); 

/******************************** ErrorHandler *********/ 

ErrorHandlerC stringNum ) 
int stringNum; 
I 

StringHandle errorStringH; 

if C errorStringH = GetString( stringNum ) ) == NIL_POINTER ) 

else 
I 

I 

ParamTextC HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING, 
NIL_STRING ): 

HLockC errorStri ngH ) ; 
ParamText( *errorStringH, NIL_STRING, NIL_STRING, 

NIL_STRING ); 
HUnlock( errorStringH ) ; 

StopAlert( ERROR_ALERT_ID, NIL_POINTER ); 
ExitToShell(); 
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I* 
* 
* 
*I 

Chapter 7, PrintPICT.c 

Notice the #include of "PrintMgr.h". LightspeedC will not 
automatically include this one for you. 

#include "PrintMgr.h" 

#define HEADER_SIZE 512 
#define NIL_POINTER OL 
#define BASE_RES_ID 400 
//define REMOVE_ALL_EVENTS 0 

//define ERROR_ALERT_ID BASE_RES_ID 
#define CANT_OPEN_FILE BASE_RES_ID 
#define GET_EOF _ERROR BASE_RES_ID+ 1 
//define HEADER_TOO_SMALL BASE_RES_ID+2 
//define OUT_OF_MEMORY BASE_RES_ID+3 
//define CANT_READ_HEADER BASE_RES_ID+4 
//define CANT_READ_PICT BASE_RES_ID+5 

#define NIL_PRPORT NIL_POINTER 
//define NI L_IOBUFFER NIL_POINTER 
#define N IL_DEVBUF NI L_PO INTER 

#define NIL_STRING "\p" 
#define IGNOREO_STRING 
#define NIL_FILE_FILTER 
#define NIL_DIALOG_HOOK 
#define DONT_SCALE_OUTPUT 
#define HOPELESSLY_FATAL_ERROR 

Boolean 
THPrint 

DoDialogs(); 
gPrintRecordH: 

NI L_STRING 
NIL_POINTER 
NIL_POINTER 
NI L_POINTER 
"\pGame over. man!" 

/******************************** main *********/ 

main() 
I 

SFReply reply: 

ToolBoxlnit(): 
Printlnit(); 

· GetFileNameC &reply ): 
if ( reply.good ) /* The User didn't hit Cancel */ 
I 

if DoDialogs() ) /* Again, the User didn't hit Cancel */ 
I 

PrintPictFile( &reply>: 
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/*********************************** ToolBoxlnit */ 

ToolBoxlnit() 
I 

InitGraf{ &thePort ) ; 
Initfonts(); 
Fl ushEvents( everyEvent, REMOVE_ALL_EVENTS ) : 
In it W i n d ow s ( ) ; 
I nitMenus (); 
TEinit(); 
InitDialogs( NIL_POINTER ); 
Ini tCursor(); 

/******************************** ~rintlnit *********/ 

Pri ntinit() 
I 
/* 
* 
* 
*I 

Allocate a new print record, open the chosen printer driver and 
load the default values from the printer resource file ... 

gPrintRecordH = CTHPrint)NewHandle( sizeof( TPrint ) ); 
PrOpen(): 
PrintDefault( gPrintRecordH ) ; 

/******************************** GetFileName *******/ 

GetFileName( replyPtr ) 
SFReply *replyPtr: 
{ 

I* 
* 
* 
* 
*I 

Point 
SFTypel i st 
int 

myPoint: 
typelist: 
numTypes: 

Prompt the user to open a file of type 'PICT', putting the dialog 
myPoint. IGNORED STRING is a prompt parameter that is ignored 
by SFGetFile(). 

myPoint.h = 100; 
my Point. v = 100: 
typeList[ 0 ] = 'PICT'; 
numTypes = 1; 
SFGetFil e( my Point, I GNORED_STRI NG, NI L_FI LE_F IL TER, numTypes, 

&typelist, NIL_DIALOG_HOOK, replyPtr ): 

/******************************** DoDialogs *******/ 

Boolean DoDialogs() 
I 
/* 
* 
* 
* 
* 

PrStlDialog() puts up the standard Page Setup dialog box, 
recording the changes in the print record handled by 
gPrintRecordH. PrJobDialog() puts up the print job dialog box, 
letting the user set things like number of copies, page ranges, 
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* 
* 
* 
*I 

etc., depending on the printer type. PrJobDialog() will return 
TRUE if the user wants to continue with the print (didn't 
hit the Cancel button). 

Pr St lDi al og( gPri ntRecordH ) : 
return< PrJobOialog( gPrintRecordH ) ); 

/******************************** PrintPictFile *******/ 

PrintPictFile( replyPtr ) 
SFReply *replyPtr: 
I 

int 
TPPrPort 
TPrStatus 
PicHandle 
char 
long 

srcFile; 
printPort: 
printStatus: 
thePict; 
pictHeader[ HEADER_SIZE ]: 
pictSize, headerSize: 

/* 
* FSOpen() opens the PICT file. GetEOF() sets pictSize to the 
* size of the file. FSRead() attempts to read the 512 byte header 
* that describes the rest of the file. Once the header is read, 
* we're ready to read the rest of the picture in. 
*I 

/* 
* 
* 
* 
* 
*I 

if ( FSOpen( (*replyPtr).fName, (*replyPtr).vRefNum, &srcFile ) 
!= noErr ) 

ErrorHandler( CANT_OPEN_FILE ); 

if ( GetEOF< srcFile, &pictSize ) != noErr 
ErrorHandler( GET_EOF_ERROR ); 

headerSize = HEADER_SIZE: 
if ( FSRead( srcFile, &headerSize, pictHeader 

ErrorHandler( CANT_READ_HEADER ); 
!= noErr ) 

Make sure there were at least HEADER_SIZE bytes in the file. If 
not, exit via ErrorHandler(). We won't use the header info in 
this program, so we'll adjust pictSize to the size of the picture 
without the header. 

if ( ( pictSize -= HEADER_SIZE ) <= 0 ) 
{ 

ErrorHandler( HEADER_TOO_SMALL ); 

/* Allocate enough memory for the picture ... */ 
if < ( thePict = (PicHandle)NewHandleC pictSize ) ) 

== NIL_POINTER ) 

ErrorHandler( OUT_OF_MEMORY ): 

/* Lock the picHandle. since we'll need to dereference it to a 
Pointer to use in the call to FSRead(). */ 

Hlock( the Pi ct ) : 

I* Read in the Picture, and close the file ... */ 

471 



472 

/* 
* 
* 
* 
*I 

if ( FSRead( srcFile, &pictSize, *thePict 
ErrorHandler( CANT_READ_PICT ); 

FSClose( srcFile ); 

Macintosh Programming Primer 

!= noErr ) 

Open a new print document, and a new page within that doc. 
Draw the picture on the print page, close the page, and close 
the doc. Finally, print the print doc. Wasn't that easy!!! 

printPort = PrOpenDoc( gPrintRecordH, NIL_POINTER, NIL_POINTER ); 
PrOpenPage( printPort, DONT_SCALE_OUTPUT ); 
DrawPicture< thePict, &(**( thePict )).picFrame ); 
PrCl osePage( pri ntPort ) : 
PrCloseDoc( printPort ): 

PrPicFile( gPrintRecordH, NIL_PRPORT, NIL_IOBUFFER, NIL_DEVBUF, 
&pri ntStatus ) : 

!******************************** ErrorHandler *********/ 

ErrorHandler( stringNum ) 
int stringNum: 
{ 

//define 
//define 
//define 
#define 
#define 
#define 
//define 

//define 
//define 

#define 
#define 

StringHandle errorStringH; 

if C errorStringH = GetString{ stringNum ) ) == NIL_POINTER ) 
ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING, 

NIL_STRING ); 
else 
I 

) 

Hlock( errorStringH ); 
ParamText( *errorStringH, NIL_STRING, NIL_STRING, 

NIL_STRING ) : 
HUnlock( errorStringH ); 

StopAlert( ERROR_ALERT_ID, NIL_POINTER ); 
ExitToShel l (): 

Chapter 7, Pager.c 

BASE_RES_ID 400 
NI L_PO INTER OL 
MOVE_TO_FRONT -ll 
REMOVE_ALL_EVENTS 0 
SCROLL_BAR_PIXELS 16 
DRAG_ THRESHOLD 30 
NI L_ACT ION_PROC NIL - POINTER 

MIN_SLEEP OL 
NIL_MOUSE_REGION OL 

WNE_TRAP_NUM Ox60 
UNIMPL_TRAP_NUM Ox9F 
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#define ERROR_ALERT_ID 
#define NO_WIND 
#define NO_PICTS 
#define CANT_LOAD_PICT 

#define NIL_STRING 
#define NIL_TITLE 
/Ide f i n e V I S I B LE 
#define START_VALUE 
#define MIN_VALUE 
#define NIL_REF_CON 

BASE_RES_ID 
BASE_RES_ID 
BASE_RES_ID+l 
BASE_RES_ID+2 

"\p" 
NIL_STRING 
TRUE 
1 
1 
NI L_PO INTER 

#define HOPELESSLY_FATAL_ERROR "\pGame over, man!" 

WindowPtr 
Control Handle 
Boolean 

gPictWindow: 
gScrollBarHandle; 
gDone, gWNEimplemented; 
gTheEvent; Event Record 

Re ct gDragRect; 
pascal void Scroll Proc(): 

!******************************** main *********/ 

main ( ) 
( 

ToolBoxlnit(); 
Windowlnit(); 
SetUpDragRect (); 
SetUpScrollBar(); 
Mainloop(); 

/*********************************** ToolBoxlnit */ 

ToolBoxlnit() 
( 

InitGraf ( &thePort ) : 
InitFonts(); 
FlushEvents( everyEvent, REMOVE_ALL_EVENTS ); 
InitWindows(); 
InitMenus(); 
TEinit(); 
InitDialogs( NIL_POINTER ); 
InitCursor<): 

/******************************** Windowlnit *********/ 

Windowlnit() 
I 

if ( ( gPictWindow ~ GetNewWindow( BASE_RES_ID, NIL_POINTER. 
MOVE_TO_FRONT ) ) == NIL_POINTER ) 

ErrorHandler( NO_WIND ); 
SelectWindow( gPictWindow ); 
ShowWindow( gPictWindow ); 
SetPort( gPictWindow ); 
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/******************************** SetUpDragRect *********/ 

SetUpDragRect() 
I 

gDragRect = screenBits.bounds; 
gOragRect.left += DRAG_THRESHOLD; 
gDragRect.right -= DRAG_THRESHOLD; 
gDragRect.bottom -= DRAG_THRESHOLD: 

/********************************** SetUpScrollBar *******/ 

SetUpScrollBar() 
I 

I* 
* 

* 
* 
* 
*/ 

Rect vScrollRect; 
int numPictures; 

Find out how many PICT resources are available. Remember. 
re~ources will be available from any open resource files, 
including the System file and the application·s resource 
fork. 

if C < numPictures = CountResources( 'PICT'))<= 0) 
ErrorHandler( NO_PICTS ); 

I* Set up the scroll bar Rect. Make it fit within the window */ 
vScrollRect = gPictWindow->portRect: 
vScrollRect.top -= l; 
vScrollRect.bottom +=l; 
vScrollRect.left = vScrollRect.right-SCROLL_BAR_PIXELS+l; 
vScrollRect.right += 1: 

I* Create a new scroll bar with NewControl () */ 
gScrollBarHandle = NewControl( gPictWindow, &vScrollRect. 

NIL_TITLE, VISIBLE, START_VALUE, MIN_VALUE. 
numPictures. scrollBarProc, NIL_REF_CON); 

/******************************** Mainloop *********/ 

Mai hloop() 
I 

gDone = FALSE; 
gWNEimplemented = C NGetTrapAddressC WNE_TRAP_NUM, ToolTrap ) != 

NGetTrapAddress( UNIMPL_TRAP_NUM, ToolTrap ) ); 
while ( gDone == FALSE ) 
I 

HandleEvent(); 

/************************************* HandleEvent */ 

HandleEvent() 
I 

if ( gWNEimplemented ) 

else 
I 

WaitNextEventC everyEvent. &gTheEvent, MIN_SLEEP, 
NIL_MOUSE_REGION ); 
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/* 
* 
* 
*I 

Systemlask(); 
GetNextEvent( everyEvent, &glheEvent ); 

switch ( gTheEvent.what ) 
I 

case mouseDown: 
HandleMouseDown(); 
break; 

case updateEvt: 

DrawControls() draws all the controls currently visible in the 
specified window. We then update the window contents. 

Beg i nUpdate < gTheEvent. message ) ; 
DrawControls< gTheEvent.message ); 
UpdateMyWindow( gTheEvent.message ); 
EndUpdate( gTheEvent.message ); 
break; 

/************************************* HandleMouseDown */ 

HandleMouseDown() 
I 

/* 

WindowPtr whichWindow; 
short int thePart; 
Point thePoint; 
Control Handle theControl; 

thePart = FindWindow( gTheEvent.where. &whichWindow ); 
switch ( thePart ) 
I 

case inSysWindow : 
SystemClick( &gTheEvent, whichWindow ): 
break; 

case i nDrag : 
DragWi ndow( wh i chWi ndow, gTheEvent. where. &gOragRect); 
break; 

case inContent: 

* FindControl () is very similar to FindWindow() in that it 
* determines which control. if any, thePoint was found in ... 
*/ 

I* 
* 
* 
* 
* 
* 
* 
* 
* 
*I 

thePoint = gTheEvent.where; 
GlobalToLocal( &CthePoint) ); 
thePart = FindControl( thePoint. whichWindow, 

&theControl ) : 
if theControl == gScrollBarHandle ) 
I 

If thePoint was in our control, find out if it was in the thumb. 
If it was. call TrackControl() to drag an outline of the thumb up 
and down (in this case) the scroll bar. ~~hen the thumb is 
released, update the window using the new control value. If any 
other part of the control was used, call TrackControl() with a 
pointer to ScrollProc(), since we may need to scroll before 
the user releases the mouse button (for example, if they click 
in the scroll bar arrows. 
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if 
{ 

thePart == inThumb ) 

I 
break: 

case inGoAway 

I 
else 
I 

gDone = TRUE: 
break: 

thePart = TrackControl( theControl, 
thePoint, NIL_ACTION_PROC ); 

UpdateMyWindow( whichWindow ): 

thePart = TrackControl( theControl, 
the Point, &Scro 11 Proc ) : 

UpdateMyWindow( whichWindow ); 

/********************************** ScrollProc *******/ 

pascal void ScrollProc(theControl, theCode) 
Control Handle theControl: 
int theCode: 
I 

I* 
* 
* 
* 
* 
* 
*I 

int curControlValue, maxControlValue, minControlValue; 

Get the min, max. and current values of the scroll bar. If the 
page down or down button areas were pressed, increase the value 
of the control. If the page up or up button areas were pressed, 
decrease the value of the control. Finally, update the control 
to this new value with SetCtlValue() ... 

maxControlValue 
curControlValue 
minControlValue 

Get Ct l Max ( theContro l ) : 
GetCtlValue( theControl >: 
GetCtlMin( theControl >: 

switch ( theCode > 
{ 

I 

case inPageDown: 
case inDownButton: 

if ( curControlValue < maxControlValue 
I 

curControlValue += 1: 
I 
break: 

case inPageUp: 
case inUpButton: 

if ( curControlValue > minControlValue 
I 

curControlValue -= 1: 

SetCtlValue( theControl, curControlValue >: 
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/********************************** UpdateMyWindow *******/ 

UpdateMyWindowC drawingWindow ) 
WindowPtr drawingWindow: 
I 

/* 
* 
* 
* 
* 
* 
*I 

currentPicture: PicHandle 
Re ct 
RgnHandle 

drawi ngCl i pRect. myRect: 
tempRgn; 

UpdateMyWindow() works in a similar fashion to the DrawPicture() 
routine in EventTutor <Chapter 4). Basically, we temporarily 
reset the windows clipping region to not include the area covered 
by the scroll bar. We center the picture, draw it, and reset the 
original clip region. 

tempRgn = NewRgn(): 
GetClip( tempRgn >: 

myRect = drawingWindow->portRect: 
myRect.right -= SCROLL_BAR_PIXELS: 
EraseRect( &myRect >: 

currentPicture = (PicHandle)GetlndResource( 'PICT'. 
GetCtlValue( gScrollBarHandle ) >: 

if ( currentPicture == NIL_POINTER ) 
ErrorHandler( CANT_LOAD_PICT ); 

CenterPict( currentPicture, &myRect >: 

drawingClipRect = drawingWindow->portRect: 
drawingClipRect.right -= SCROLL_BAR_PIXELS: 
Cl i pRect( &drawi ngCl i pRect ) : 

DrawPicture( currentPicture, &myRect ); 

Set Clip ( tempRgn ) : 
DisposeRgnC tempRgn ); 

/******************************** CenterPict *********/ 

CenterPictC thePicture, myRectPtr 
PicHandle thePicture: 
Rect *myRectPtr: 
I 

Rect wi ndRect. pi ctureRect: 

windRect = *myRectPtr: 
pictureRect = (**( thePicture )).picFrame; 
myRectPtr->top = CwindRect.bottom - windRect.top -

CpictureRect.bottom - pictureRect.top))/ 2 + 
windRect.top; 

myRectPtr->bottom = myRectPtr->top + 
(pictureRect.bottom - pictureRect.top); 

myRectPtr->left = (windRect.right - windRect.left -
CpictureRect.right - pictureRect.left))/ 2 + 

wi ndRect. 1 ef t: 
myRectPtr->right = myRectPtr->left + (pictureRect.right -

pictureRect.left); 
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!******************************** ErrorHandler *********/ 

ErrorHandler( stringNum ) 
int stringNum; 
{ 

StringHandle errorStringH; 

if ( errorStringH = GetString( stringNum ) ) == NIL_POINTER ) 
ParamText( HOPELESSLY_FATAL_ERROR. NIL_STRING, NIL_STRING, 

NIL_STRING ); 
else 
{ 

Hlock( errorStri ngH ) : 
ParamText( *errorStringH, NIL_STRING, NIL_STRING. 

HUnl ock( errorStri ngH ) ; 
} 
StopAlert( ERROR_ALERT_ID, NIL_POINTER ); 
ExitToShel l <); 

Chapter 7, Sounder.c 

#define NIL_POINTER 
//define BASE_RES_ID 
//define REMOVE_ALL_EVENTS 
//define NI L_SOUNO_CHANNEL 
//define SYNCHRONOUS 

//define ERROR_ALERT _ID 
/fdefi ne CANT_LOAD_BEEP _SNO 
//defineCANT_LOAO_MONKEY_SNO 
//define CANT_LOAO_KLANK_SND 
//defineCANT_LOAD_BOING_SND 

DL 
400 
0 
NIL_POINTER 
FALSE 

BASE_RES_ID 
BASE_RES_ID 
BASE_RES_ID+l 
BASE_RES_I0+2 
BASE_RES_ID+3 

//define NIL_STRING "\p" 
//defineHOPELESSLY_FATAL_ERROR"\pGame over. man!" 

//define BEEP _SNO 
/ldefi ne MONKEY _SND 
/fdefi ne KLANK_SNO 
/ldefi ne BO I NG_SND 

1 
2 
3 
4 

/******************************** main *********/ 

main ( ) 
I 

Tool Box I nit(); 
Ma keSound (); 

/*********************************** ToolBoxlnit */ 

ToolBoxlnit() 
I 

InitGraf( &thePort ); 
InitFontsC): 

NIL_STRING ); 
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Fl ushEvents ( everyEvent. REMOVE_ALL_EVENTS ) : 
I nitWi ndows (): 
InitMenus(); 
TEinit(); 
InitDialogs( NIL_POINTER ) : 
lnitCursor(): 

/******************************** MakeSound *********/ 

MakeSound() 
I 

/* 
* 
* 
* 
* 
* 
* 
*I 

Handle soundHandl e: 

The key to this program is the sound routine SndPlay(). We 
are loading the 'snd · resources normally found in the system 
file. Since the Mac System file didn't always have these 'snd • 
resources, older systems may cause the error messages to appear. 
Check out the Sound Manager (Chapter 27) in Volume V for more 
detail ... 

if ( ( soundHandl e = GetResource( · snd ·• BEEP _SND ) 
== NIL_POINTER ) 

ErrorHandler( CANT_LOAO_BEEP_SND ); 
SndPl ay( NI L_SOUND_CHANNEL. soundHandl e. SYNCHRONOUS ) ; 

if< ( soundHandle = GetResource( 'snd •. MONKEY_SND ) ) 
== NI L_POI NTER ) 

ErrorHandler( CANT_LOAO_MONKEY_SND ): 
SndPl ay ( N IL_SOUND_CHANNEL. soundHandl e, SYNCHRONOUS ) ; 

if ( ( soundHandle = GetResource( 'snd ·. KLANK_SND)) 
== NIL_POINTER ) 

ErrorHandler( CANT_LOAD_KLANK_SND ); 
SndPl ay( NIL_SOUND_CHANNEL. soundHandl e. SYNCHRONOUS ) ; 

if<< soundHandle = GetResource( 'snd ·. BOING_SND)) 
== NIL_POINTER ) 

ErrorHand 1 er ( CANT _LOAD_BO I NG_SND ) ; 
SndPl ay( NI L_SOUND_CHANNEL. soundHandl e. SYNCHRONOUS ) ; 

/******************************** ErrorHandler *********/ 

ErrorHandler( stringNum ) 
int stringNum: 
I 

StringHandle errorStringH; 

if ( errorStringH = GetString( stringNum ) ) == NIL_POINTER ) 

else 
I 

I 

ParamText( HOPELESSLY_FATAL_ERROR, NIL_STRING, NIL_STRING, 
NIL_STRING ); 

Hlock( errorStringH ); 
ParamText( *errorStringH, NIL_STRING, NIL_STRING, 

NIL_STRING ) ; 
HUnlock( errorStringH ); 

StopAlert( ERROR_ALERT_ID. NIL_POINTER ); 
ExitToShell (): 
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Command 
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This appendix summarizes some of the 
basic operations of THINK C, Version 3.0 
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THINK C Is a simple but powerful programming environment. This appendix 
provides an overview of its operations. 

The Project Menu 

THINK C keeps track of all of the library files and code files that you are using in 
a Project file. To create a project, select New Project from the Project menu, and 
type in a project name. (Create a folder for your project first to keep your files 
together.) To open an existing project, use Open Project. If you have a project open, 
and you want to look at another project, use Close Project. If you choose Close & 
Compact, the project file will be compressed. This makes it smaller, but means 
that it takes longer to open. The Set Project Type ••• menu item brings up a dialog 
box, which allows you to define the kind of project that you want to have (Figure 
C.1). There are four types of projects: applications, desk accessories, device drivers 
and code resources. 

APPLICATIONS 

Normally, the first radio button should be clicked on, as standalone applications are 
usually what you'll be building in THINK C. You can key in the File Type and 
Creator for your application. The default for the File Type is APPL: your applica­
tions should use this. Other types of projects may have other File Types. In the 
Primer, we have been selecting the Creator name using ResEdit. You can do it here 
instead. 

® Rpplication 

O Desk Rccessory 

O Deuice Driuer 

O Code Resource 

File Type I RPPL 

Creator IRIMI 
D Separate STRS 

Partition (K) ~ 

MF Rttrs ~ I 0000 I 
(( OK J) ( Cancel J 

Figure C.1 Project Type dialog box. 
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The Project Type dialog box also lets you select the level of MultiFinder 
friendliness that you intend your application to have (Figure C.2). 

The pop-up menu allows you to set three flags. MultiFinder Aware means that 
your application will conform to Apple's MultiFinder guidelines. This means that 
your application will respond properly to suspend/resume events. Background 
Null Events means that your program will get null events when it is running in the 
background, and Suspend and Resume Events means that your program will get 
suspend/resume events as well as the normal activate/deactivate events. The 
MultiFinder flags may also be keyed in hex in the field to the right. 

Early versions of THINK C 3.0 had a bug where the Suspend and Resume 
Events and the MultiFinder Aware flags were swapped. To check for this 
problem, examine the SI Z E resource in your THINK C-created application. 
All MultiFinder options are currently stored in the SI Z E resource, and may 
be easily changed in ResEdit. 

In the Partition field, you can key in the preferred amounts of RAM that your 
application will need in MultiFinder. If the Separate STRS check box is checked, 
THINK C will place string literals and floating point constants in a ST R ff resource 
instead of a DAT A resource. Do this if you think you'll have more than 32K worth of 
string literals or floating point constants. 

® Application 

O Desk Accessory 

0 Oeuice Driuer 

O Code Resource 

File Type I APPL 

Creator lf'''"I 
0 Separate STRS 

Partition (K) ~ 

Y"'Background Null Euents 
Y"'Suspend & Resume Euents 

lseoo I 
( Cancel 

Figure C.2 MultiFinder flags pop up menu. 

) 
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DESK ACCESSORIES AND DEVICE DRIVERS 

If your project is a desk accessory, or a device driver (like a printer driver), your 
dialog box is somewhat different (Figure C.3). 

Both desk accessories and device drivers have the same fields; desk accessories 
have a default File Type and Creator of D FI L and OMO V. The Multi-Segment 
check box allows you to have up to 31 segments on your device driver or desk 
accessory. 

The Name field contains the name of the desk accessory or device driver 
resource. THINK C will add a null byte to the beginning of your desk accessory (a 
convention). It will also place a period before the device driver name if you don't put 
one there. 

The Type ofresource created is defaulted to DR V R for both kinds of projects. The 
ID of the resource for desk accessories is defaulted to 12. The Font DIA Mover will 
handle ID number conflicts, so this number need not be changed. 

CODE RESOURCE 

THINK C allows you to build C 0 DE resources. This comes in really handy for 
building I N IT s, W DEF s and c de vs. The code resource project type has the same 
basic fields as the desk accessories. If the Custom Header check box is unchecked, 
THINK C builds a 16-byte header for your C 0 DE resource that places the address 
of your resource into register AO and branches to your ma i n ( ) function. The At tr s 
field allows you to select the standard resource attributes for your code resource. 
You can also use ResEdit to set these flags. 

O Application 

® Desk Accessory 

0 Oeuice Driuer 

O Code Resource 

Name 11 

Type lonun I 
( OK ) 

File Type I OF IL 

Creator I DMOU 

D Multi-Segment 

ID _11_2 __ 

(( Cancel ] 

Figure C.3 Desk Accessories/Device Drivers dialog box. 
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MORE ON THE PROJECT MENU 

The next few menu items on the Project menu are Remove Objects, Bring up to 
Date and Check Link. 

Remove Objects will remove object code for all files in your project. Be sure to 
do this for all your projects built with older versions of THINK C. By removing all 
the objects from a project, you are dramatically reducing the size of the project (until 
you put the objects back in) and you are also ensuring that your project uses the 
current version of all your link libraries (like MacTraps). Bring Up to Date 
compiles source code and loads library files thathaven,t been compiled or loaded yet. 
Check Link checks the link-worthiness of your project without running it. 

Build Library takes the current project and saves it as a binary library, so it 
can be used by other projects. Build Application ••• (or Desk Accessory, Device 
Driver, or Code Resource) saves the project as a standalone application (or desk 
accessory, device driver, or C 0 DE resource), depending on the project type chosen. 

If you set the Use Debugger flag, the debugger will automatically run when you 
run your application (in MultiFinder). The final menu item, Run, runs your 
application. If you run your application under MultiFinder, THINK C runs your 
application as a separate entity. 

The File Menu 

Once you've created your project, you're ready to type in your source code. THINK 
Chas a number of formatting facilities that should save you some time. Most of the 
options in the File menu are self-explanatory (Figure C.4). 

New XN 
Open... XO 
Open Selection XO 
Close 

Saue XS 
Saue Rs .•• 
Soue R Copy As •.• 
Reuert 

Page Setup ••• 
Print ••• 

Transfer ••• 
Quit XQ Figure C.4 THINK C's File menu. 
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To create a new file, select New. To open an existing file, choose Open. You can 
also open a file by double-clicking its name in the Project window. If a file name is 
highlighted in an edit window, Open Selection will open the file. Close will close 
your file; you are prompted to save or discard your changes if any have been made. 
Save will save the current file you're working on. Save As will save your current 
file under a new name and change the name in the Project window. Save A Copy 
As will save your current file under a different name and use the original file. 
Revert will return the current file to the saved version of that file. Print Setup 
puts up the standard Print Setup dialog box to choose printing options. Print prints 
your current file with the name, date, time and page number at the top. Transfer 
allows you to go directly to another program without going back to the Finder. Quit 
allows you to leave THINK C; you are prompted to save changes in your current 
files. 

The Edit Menu 

The Edit Menu provides options for working on your current file (Figure C.5). 
The Undo, Cut, Copy, Paste, Clear, and Select All menu items are the 

standard text editing options available on most Macintosh applications. Set Tabs 
& Font ••• (Figure C.6) puts up a dialog box that allows you to select the tab size 
(usually, one tab every four character positions), as well as the font type and size. 

Undo HZ 

Cut HH 
Copy HC 
Paste HU 
Clear 
Select Rll 

Set Tabs & Font ••• 
Shift Left H[ 
Shift Right HI 
Balance HB 

Options ••• Figure C.5 THINK C's Edit menu. 
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Tabs: - ~ OK D ( Cancel ) 

Font: Monaco ~ I 9 

The quick brown fox jumps over the lazy dog. 

Figure C.6 Tabs & Font dialog box. 

Shift Left and Shift Right will move selected text one tab to the right or left. 
Balance will highlight the code balanced by the nearest(), [], or (} before and after 
the cursor position. 

The Options ••• menu item (Figure C. 7) brings up a dialog box that allows you 
to set the default options for five different areas of THINK C. 

Search Options has three options to set. These all affect the defaults used by 
options under the Search menu. Selecting the Match Words check box lets you 
search for whole words instead of parts of words. Wrap Around means that the 
entire file will be searched, not just from the cursor to the end of the file. Ignore 
Case lets you ignore upper and lower case in searching. 

Preferences lets you set four options (Figure C.8). The Confirm Auto-Make 
check box, when checked, always brings up the Br i n g Pro j e ct up to Date? 
dialog box when the project is being compiled. If it is not checked, THINK C will 
automatically update the project. When not checked, Confirm Saves always saves 
changes to the current document without asking. Always Compact always saves 

®This Project »Copy» 0 New Projects 

® Search Options 
O Preferences 
O Code Generation 
O Compiler Flags 
O Source Debugger 

OK l 
Figure C. 7 Search options. 

D Match Words 
D Wrap Around 
1811 gnore Case 

( Cancel J 
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®This Project »Copy» 0 New Projects 

O Search Options 
® Preferences 
O Code Generation 
0 Compiler Flags 
0 Source Debugger 

OK 

Figure C.8 Preferences. 

181 Confirm Auto-Make 
181 Confirm Saues 
D Always Compact 
D More Memory 

( Cancel J 

the current project using a compression algorithm. When checked, More Memory 
will cause THINK C to try to work around a Mac that keeps running out of memory. 

Code Generation (Figure C.9) allows you to set five options. The Macsbug 
Symbols should be set if you plan to use a symbolic debugger like MacsBug or 
TMON. When Profile is checked, THINK C collects timing statistics about your 
functions. If the 68020 flag is set, THINK C will use the 020 instruction set, when 
the 68881flag is set, floating point coprocessor code will be generated as well. If the 
<MacHeaders> option is set, THINK C automatically uses the MacHeaders file for 
every project. 

Compiler Flags (Figure C.10) has two options. If Check Pointer Types is 
selected, THINK C generates compiler errors for pointer types that don't match. 
The Require Prototypes flag makes THINK C strict about type checking with 
respect to function calls and their arguments. 

®This Project »Copy» O New Projects 

0 Search Options 
O Preferences 
® Code Generation 
O Compiler Flags 
O Source Debugger 

OK 

Figure C.9 Code generation. 

181 Macsbug Symbols 
D Profile 
D 68020 
D 68881 
181 <MacHeaders> 

( Cancel J 
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®This Project »Copy» O New Projects 

O Search Options 
O Preferences 
O Code Generation 
® Compiler Flags 
O Source Debugger 

OK 

Figure C.10 Compiler flags. 

181 Check Pointer Types 
D Require Prototypes 

( Cancel J 
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Source Debugger(Figure C.11) has three options. Use Debugger starts your 
project off with the Use Debugger item checked under the Project menu. IfUse 2nd 
Screen is checked, THINK C will place the debugger windows on a second monitor 
if the Mac being used is equipped with one. If Update Windows is set, the 
Debugger will try to update your windows for you when execution of the code is 
stopped. (This option really eats up memory, so you may want to increase the 
debugger's MultiFinder partition.) 

The Search Menu 

The Search menu (Figure C.12) has a number of functions that allow you to find 
and change text in your files. 

®This Project »Copy» 0 New Projects 

O Search Options 
O Preferences 
O Code Generation 
O Compiler Flags 
® Source Debugger 

OK J) 

Figure C.11 Source debugger. 

D Use Debugger 
181 Use 2nd Screen 
D Update Windows 

( Cancel J 
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Find... OOF 
Enter Selection OOE 
Hnd H~}<lin :u:H 
Replace OOP 
H•~Ph~C(~ (~ rind Ht.it~in :c:w 
Ht~phH~<~ HU 

Figure C.12 Search menu. 

The Find •.. menu item puts up a dialog box, as shown in Figure C.13. The Find 
dialog box allows you to enter in the string to search for and, optionally, the string 
to replace it with. The three search options, Match Words, Wrap Around, and 
Ignore Case were described in the discussion of Search Options. If Grep is 
checked, a utility similar to the Grep utility in UNIX is run. If Multi-File Search 
is checked, a dialog box is put up to allow you to select which files to search. 

Enter Selection will take highlighted code and place it in the Search for field 
in the Find dialog box. Find Again searches for the next occurrence of the Search 
For: text without bringing up the dialog box again. Replace replaces the high­
lighted string; ifthere is no string in the Replace With field, the highlighted text is 
deleted. Replace and Find Again will replace the highlighted string in the code 
and highlights the next occurrence of the Search For: string. Replace All replaces 
all occurrences of the sought string. Find In Next File is used in conjunction with 
the Multi-File Search check box; it puts up a dialog box so the next files to search 
may be selected. 

Search for: Replace with: 

......._l
1 
__ ______.II.......__ __ _____. 

D Match Words 

D Wrap Rround 

1811 gnore Case 

Figure C.13 Find dialog box. 

D Grep D f'i.1um···rn<~ ~·~l~rct~ 

1: ind m Don't Find m Cancel ) 
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The Source Menu 

The Source menu (Figure C.14) deals with the files currently in the project. Add 
and Remove will add or remove the currently selected file in the Project window. 
If Add is dimmed, the current window has not been saved, or does not have the . c 
suffix. Get Info provides a dialog that displays information about the current file, 
such as number of lines of code and data and string resources used. Other files may 
be examined by clicking on the next or previous buttons. Check Syntax compiles 
a file to check syntax without adding it to the project. Precompile ••• creates a 
precompiled header (like <MacHeaders>) for your project. It may not have code or 
data definitions. Debug sends the currently edited file to the Source window of the 
debugger. Compile will compile the currently selected file and place it in the project 
window. Load Library will take the currently edited library and add it to the 
current project. Add ••• displays a dialog box that allows you to add other files into 
the project. Make ••• puts up a dialog box listing the current files in the project. You 
can then compile any file or load libraries directly instead of having THINK C figure 
it out for you. 

Add 
Remoue 
Get Info 8€1 
Check SyntaH 8€Y 
Precompile ••• 
Debug 8€6 

Compile 8€K 
Load Library 

Add ••• 
Make ••• 8€M Figure C.14 THINK C's Source menu. 

-----------------
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The Windows Menu 

The Windows menu (Figure C.15) controls the windows of THINK C. Clean Up 
resizes and stacks currently opened windows. Zoom resizes the current window to 
fill the screen; if selected again, the window returns to the previous size. Full Titles 
puts the full path of each file on the top of its window. Close All closes all edit 
windows. Save All saves all edit windows. Project window brings the Project 
window to the front. The menu items will contain the project title (e.g., He 11 o 
pro j ). Following the Project windows is a list of all currently opened windows in the 
project. Selecting a window on the list will bring it to the front. 

This appendix is meant to provide an overview to THINK Conly. For detailed 
information about THINK C, read Think's THINK C User's Manual and Standard 
Libraries Reference. 

Clean Up 
Zoom 38/ 
Full Titles 
Close All 
Saue All 

Sample 380 
Untitled 381 Figure C.15 THINK C's Windows menu. 
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The Debugger 
Command 
Summary 

This appendix summarizes some of the 
basic operations of the THINK C source­
level code debugger. The descriptions are 

specific to Version 3.0 of THINK C. 
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THIN KC Now has a debugger that provides a powerful way to test applications. The 
Debugger runs exclusively under MultiFinder and needs at least two megabytes to 
work properly. 

When an application is run inside THINK C, and the Use Debugger flag has 
been set, the windows shown in Figure D.1 are displayed. Each of the two windows 
that are part of the Debugger has a specific function. First, take a look at the Source 
window. 

The Source Window of the Debugger 

The Source window displays the code of the file that is currently being run. In 
Figure D.l, the arrow to the left of the code indicates where the Debugger has 
stopped. At this point, you can Step to the next line, step In to the function at which 
the arrow points, or step Out of the function to the next line of the calling function. 
If you click on Go, the program will run until it hits a breakpoint or until the Stop 
button is clicked on. The Trace button is like the Step button, except that it will step 
into the current function if the code is available for it; Step stays at the same level 
of your program. 

To set up a breakpoint, just click on the diamond to the left of the statement at 
which you want to stop, then click Go (Figure D.2). The program will halt execution 
when it reaches the breakpoint. To clear a breakpoint, click on the diamond again. 
To set up a temporary breakpoint, hold down the command or option key when you 
click on the diamond of the statement at which you want to stop. When you reach 
the breakpoint and then click Go, the breakpoint is cleared. 

If you want to examine a file other than the one in the Source window, select the 
Project window to bring it to the front, choose the file you want to debug, and select 
Debug from the Source menu of THINK C. The file will then appear in the Source 
window. The field in the bottom left-hand corner of the Source window displays the 
name of the current file. 

Data 

I * 
I ••••• , 

I j 11a ln<> 

: { 

¢~ lni lMoc inloshO; 
Oj SelUpMenus< >; 
¢I Se lUplH ndool<>; 
i 
I for ( · ·) 

Oj H~~dleEvenl( >; 
¢; ) 

! / * end main */ 

• m~in 

Figure D.l Bullseye project with the Debugger running. 
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' 

I .o;oo 

i { o• oi 

•i 
1 

oi 
o! > 

lnitMacintosh<>; 
Se tUpMenus < >; 
Setupl-l i ndow<); 

for < · · > 
H~~d I eEven t <>; 

! /* end main */ 

+ m~in 

FigureD.2 Breakpoint selected. 
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The button actions can also be selected from the Debug menu of the Debugger. 
The debug menu also has some other debugging actions. Go Until Here is the same 
as setting a temporary breakpoint. If you click on a line of source code and select Go 
Until Here, the Debugger will run until that line of code is reached. Skip To Here 
allows you to skip execution of portions of your code. Be careful that whatever you 
are testing doesn't depend on the code you are skipping. 

You can step or trace continuously through your program if you click on these 
buttons with either the command or the option key depressed. To cancel the action, 
click on the Stop button. 

Monitor invokes the currently installed monitor (low-level debuggers like 
Macsbug or TMON). ExitToShell halts execution of your program and quits to 
THINKC. 

If you want to get information about the values of your variables as your code 
executes, use the Debugger's Data window. 

The Data Window of The Debugger 

The Data window lets you find out the values of your variables as the program 
runs. To use it, type in a C expression in the data entry area just under the title bar, 
and the value of the expression will be displayed in the right-hand column. For 
example, Figure D.3 shows the value of a string variable. As you can see, the string 
variable was displayed in hex format. To view the data correctly, click on the 
variable of interest in the left column, pull down the Data menu, and select Pascal 
String. The data are now displayed as a Pascal string. Figure D.4 lists the possible 
data format types with examples. 
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Figure D.3 Data window with expression. 

Decimal 
HeHadecimal 
Character 
Pointer 
Address 
C string 
Pascal string 
Floating Point 

7569994, -5000 
0HB11E1520 
'a', 'Chuck' 
0H7A7000 
[) 0H09FE44, struct 0H08FC14 
"GoodbyeCruel\nWorld\ 33" 
" \ pGoodbyeCruel\nWorld\ 33" 
90983.611 

Figure D.4 Data formats in the Debugger. 

In the Data menu, you can also Show Context, which will display the context 
for the expression selected in the Data window in the Source window.lfyou select 
a line in the Source window, you can then Set Context to change the context to the 
line highlighted in the Source window. If you want to make sure that an expression 
doesn't change its value, select Lock in the Data menu with the desired variable 
highlighted (Figure D.6). 

This appendix is meant to provide an overview of the Debugger. For more 
detailed information, read Symantec's THINK C User's Manual and Standard Li­
braries Reference. 
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Set ConteHt 
Show ConteHt 

Decimal 
HeHadecimal 
Character 
Pointer 
Rddress 
C String 
Pascal String 
Floating Point 

Lock 

Doto 

Figure D.5 Data menu in the Debugger. 

i 0 

Figure D.6 Locked variables in the Debugger. 
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Debugging 
Techniques 
One of the most frustrating experiences 

in programming is running up against a 
really tough bug. In this appendix, we'll 

discuss some techniques for hunting 
down bugs, and some others for avoiding 

them in the first place. 
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Compilation Errors 

THE FIRST BUGS you're likely to encounter will pop up during compilation, when 
you've typed in your code and select Run from the Project menu. When THINK C 
asks you if you'd like to rebuild your project, click Yes. 

THINK C is now compiling your code. You'll see a dialog box similar to the one 
in Figure E.1: 

TYPING MISTAKES 

The first sign that something's amiss is the appearance of a bug alert. The one in 
Figure E.2 crops up a lot and seems frustratingly uninformative. Syntax errors are 
usually indicative of a misspelled keyword or bad programming grammar. For 
example, if you misspell #def i n e or type something like: 

EventRecord = theEvent; 

instead of 

Event Record theEvent: 

you'll end up with a syntax error. This happens frequently. Carefully review the line 
of code with the blinking cursor in the left-hand column. If you still can't find the 
bug, check the previous line. Is there a semicolon at the end of the line? Is there 
supposed to be one? 

Compiling bullWindows.c 

Lines: 156 

Total: 156 

Figure E.1 Compiling dialog box. 

II 
A syntaH error 

II 
Figure E.2 Syntax Error dialog box. 
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Missing semicolons can cause several different types of bugs. For example, in 
Chapter 4's Event Tutor . c, we took the semicolon away from the end of three 
different lines and got three different errors-an i n v a 1 i d de c 1 a rat i on, a 
syntax error, and finally, am i s s i n g ; . C compilers are very tricky. 

Another popular error meassage is the xx x ha s not been de c 1 a red alert. 
Sometimes this is the result of a missing declaration, but often it's the result of a 
misspelled variable name. Remember, in C, upper and lower case are crucially 
different when it comes to identifiers. The variables my Pi ct u re and My Pi ct u re 
are completely different. Check your case. 

Another indicator of a typing error is the i l l e g a 1 token error message. 
Usually, this means you have a character in your code that shouldn't be there. 
Here's an example: 

myVar $ = 27: 

In this case, the $ was the illegal token. If you try repeatedly but still can't find 
the illegal token, try deleting and retyping the line in question. If that doesn't work, 
check the previous line. 

INDIRECT COMPILER ERRORS 

An example of a indirect compiler error is caused by a missing If i n cl u de file. For 
example, the printing program presented in Chapter 7 depended on the #i n c 1 u de 
file Pr i n t Mgr . h. This file is not one of the standard If i n c 1 u des automatically 
included by THINK C. If you leave out this If i n c 1 u de, you get an i n v a 1 i d 
dee 1 a ration error, and the cursor moves to the line: 

THPrint printRecordH; 

It turns out that TH Pr i n t is a special type declared in P r i n t Mgr . h. The real 
trick is to figure out which file to/fi nc 1 ude. Chapter 7 lists all the #inc 1 udes not 
automatically included by THINK C. You'll find these files in the Mac /Ii nc 1 udes 
folder on your THINK C disk. The files are well named, so picking a likely candidate 
shouldn't be too hard. Use the THINK C Find facility to search for the missing type 
or global variable. 

Another indirect compiler error stems from not closing your comment blocks. For 
example: 

/*my 1st comment * 
int i : 
/*my 2nd comment *I 
i = 10: 

This code will lead to an ' i · w a s not de c 1 a red error. The declaration ofi was 
swallowed up by the my 1 st co mm en t comment block, which was never closed. 

LINKER ERRORS 

If you call a procedure or function in your program that was never declared, you'll 
get a 1 ink failed error and a Fa i 1 ed Lin ks window will appear, listing the 
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routines that were called but that the linker couldn't locate. This error is often the 
result of a misspelled procedure name. For example: 

sysBeep< 20 ) : 

The compiler will accept this line because it will assume that you've written a 
routine called sys Beep ( ) that will be provided at link time. 

Improving Your Debugging Technique 

Once your program compiles, your next step is to get the bugs out. One of the best 
ways to debug a Mac program is to use a debugger like the THINK C Debugger 
described in Appendix D, or the TMON debugger from ICOM Simulations. Debug­
gers are real life-savers. 

No matter which debugging tool you use, there are some things you can do to 
improve your debugging technique. 

BEING A GOOD DETECTIVE 

When your program crashes or exhibits some unusual behavior, you have to to be 
a detective. Did the system error occur just before your dialog box was scheduled to 
appear? Did those wavy lines start appearing immediately after you clicked on the 
OK button? 

The key to being a good detective is having a good surveillance technique. Try to 
establish a definite pattern in your program's misbehavior. Can you pinpoint 
exactly where in your code things started to go awry? These clues will help you home 
in on the offending code. 

If you can't tell by observation exactly when things went sour, don't give up. You 
can always use the binary method of bug control. 

Tlf~ BINARY METHOD 

The key to the binary method lies in establishing good boundary conditions for the 
bug. First, you'll need to establish a lower limit, a place in your code at which you 
feel fairly certain the bug has not yet occurred. You'd like the lower limit to be as 
·close to the actual bug as possible, but make sure the bug has not yet happened. 

Next, establish an upper limit in your code, a point by which you're certain the 
bug has occurred (because the system has crashed, or the screen has turned green, 
or whatever). 

To use the binary method, split the difference between the upper and lower 
limits. If the bug still has not occurred, split the difference again. Now, if the bug 
has occurred, you have a new upper limit. By repeating this procedure, you'll 
eventually locate the exact line of source code where the bug occurs. 

There are several different ways to split the difference between two lines of 
source code. If you're using a debugger, you can set a breakpoint halfway between 
the lines of code representing the upper and lower limits. Did you hit the breakpoint 
without encountering the bug? If so, set a new breakpoint, halfway between this one 
and the upper limit. 
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If you don't have a debugger, use a ROM call like Sys Beep ( ) to give you a clue. 
Did you hear the beep before the bug occurred? If so, put a new Sys Beep ( ) halfway 
between the old one and the upper limit. The nice thing about using Sys Beep ( ) is 
that it is reasonably nonintrusive, unlike putting up a new window and drawing 
some debugging information in it, which tends to interfere with your program's 
basic algorithm. 

Recommended Reading 

In closing, we'd like to recommend some good reading material: your THINK C 
User's Manual! The User's Manual is a treasure trove of valuable tips for writing 
and debugging Mac programs. The more you know about the Macintosh and the 
THINK C development environment, the better you'll be at debugging your 
programs. 
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Building 
Hypercard 

XCMDs 
The introduction of HyperCard in 

August 1987 caused quite a stir in the 
Macintosh world. A complete program­

ming environment in its own right, 
HyperCard became even richer with the 

addition of XCMDs and XFCNs. Now 
you can access the raw power of 

THINK C from inside HyperCard. 
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HYPERCARD CoMESWITH its own powerful programming language: HyperTalk. 
The designers of HyperTalk thoughtfully provided a mechanism for adding exten­
sions to the HyperTalk command set. These extensions are code resources of type 
XCMD and XFCN. 

XCMDs (X-Commands) take a parameter block as input from HyperCard, 
perform some calculations, put the results back into the parameter block, and 
return to the calling script. XFCNs (X-functions) take the same parameter block as 
input, perform the same types of calculations, but return the results as a C or Pascal 
function would. 

We've written an XCMD (called XChooser) that puts the Chooser name in the 
parameter block and returns to HyperCard. A typical call of X Chooser looks like 
this: 

XChooser 
Put the result into card field 1 

We also created an X F C N (called F Chooser) that performs the same service. A 
typical call of F C h o o s e r looks like this: 

Put FChooser() into card field 1 

The source code for F Choose r and X Chooser is identical. One is saved as an 
X FCN and the other as an XCMD. In addition to the X FCN. c and XCMD. c files, you'll 
also need a set ofHyperCard service routines and the XCMD type definition include 
file. The service routines and the # i n c 1 u de file were kindly provided by the 
THINK C folks. We've included all the source code (as well as a HyperCard test 
stack and a resource mover stack) on the Mac Primer source code disk (use the 
coupon on the last page). All the source code is also presented in this Appendix, 
however, so the more intrepid among you can type it right in. 

There are 28 HyperCard service routines, each in its own source code file. You 
don't need to type in all 28 at once. In the example, you'll need only the routine in 
the file PasToZero. c. You may want to type that one in now. In addition, put the 
#include file, HyperXCmd. h, in thesamefolderastheotherMac/li nc 1 udes.All 
of the source code can be found later in this appendix. 

The XChooser XCMD 

Create a new project. Add MacTraps and the file Pas To Zero . c. Next, type in 
this source code, save it as X CM D . c, and add it to the project: 
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#include "HyperXCmd.h" 

pascal void main(XCmdBlockPtr); 

/******************************** main *********/ 

pascal void main( paramPtr ) 
XCmdBlockPtr paramPtr: 
I 

StringHandle chooserStr255H; 

chooserStr255H = GetString( -16096 ) : 
Hlock( chooserStr255H ); 
paramPtr->returnVal ue = PasToZero( paramPtr. *chooserStr255H ) ; 
HUnl ock( chooserStr255H ) : 

Start by loading the Chooser name from resource ST R with ID= -16 0 9 6. Lock the 
handle and pass it, along with the parameter block you receive from HyperCard, to 
Pa s To Z e r o, which converts the Chooser name from a Pascal-based string to a zero­
terminated string. Next, place the zero-terminated version of the Chooser name in 
the return Va l u e field of the parameter block, and return. 

Building the XCMD 

Before compiling X Chooser, you must first tell LightspeedC that you're building 
an X CM D. Pull down the Project menu and select Set Project Type ... When the dialog 
box appears, set the fields as they appear in Figure F.1: 

O Application 

O Desk Accessory 

O Deuice Driuer 

® Code Resource 

Name 

Type IHCMD ID 1400 

OK 

File Type I???? 
Creator I???? 
D Custom Header 

I Attrs ~ @!] 

( Cancel ) 

Figure F.1 Set Project Type dialog box. 
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I* 

*I 

Click the OK button. Pull down the Project menu and select Build Code 
Resource ... The standard file dialog will appear, asking you to name your new 
resource file. Call it X Chooser. 

Copying the XCMD Into a Stack 

Once X Chooser is built, use ResEdit to copy it into a stack. You can also copy the 
XCMD directly into HyperCard, but work with a copy to stay on the safe side. Once 
the XCMD is copied, you'll be able to access it from within any script. 

To create an X FCN, change XCMD to X FCN in the Set Project Type ... dialog box. 

HyperXCmd.h 

HyperXCmd.h Definitions for calling all standard 
HyperCard callback routines from C. 
©\pple Computer, Inc. 1987 
All Rights Reserved. 

See CFlash.C for an example of how to include this module in your 
C program. 

#include <MacTypes.h> 

typedef struct XCmdBlock 
short pa ramCount; 

Handle params[l6J; 
Handle returnValue; 
Boolean pass Flag; 

void (*entryPoint)(); I* to call back to HyperCard */ 
short request; 
short result; 
long i nArgs [8]; 
long outArgs[4J; 
I XCmdBlock, *XCmdBlockPtr; 

typedef unsigned char Str31[32J; 
/* 
typedef struct Str31 { 

char guts[32J; 

*I 

en um 

} ; 

} Str31, *Str31Ptr: 

xresSucc 0, 
xresFail, 
xresNotlmp 
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I* request codes */ 
enum I 

I; 

xreqSendCardMessage 1, 
xreqEvalExpr, 
xreqStringLength. 
xreqStringMatch, 
xreqSendHCMessage, 
xreqZeroBytes, 
xreqPasToZero, 
xreqZeroToPas. 
xreqStrTolong, 
xreqStrToNum. 
xreqStrToBool. 
xreqStrToExt, 
xreqlongToStr. 
xreqNumToSt r. 
xreqNumToHex, 
xreqBoolToStr, 
xreqExtToStr, 
xreqGetGlobal. 
xreqSetGlobal. 
xreqGetFieldByName, 
xreqGetFieldByNum, 
xreqGetFieldByID, 
xreqSetFieldByName, 
xreqSetFieldByNum, 
xreqSetFieldByID, 
xreqStringEqual. 
xreqReturnToPas. 
xreqScanToReturn. 
xreqScanToZero = 39 /* was suppose to be 29! Oops! */ 

I* Forward definitions of glue routines. Main program 
must include XCmdGlue.inc.c. See XCmdGlue.inc.c for 
documentation of each routine. */ 

typedef void (*MyProcPtr) (); 

SendCardMessage( XCmdBl ockPtr. Stri ngPtr msg): 
EvalExpr(XCmdBlockPtr, StringPtr expr): 

StringLength(XCmdBlockPtr. StringPtr strPtr): 
StringMatch(XCmdBlockPtr, StringPtr pattern, Ptr target); 
ZeroBytes ( XCmdB 1 ockPt r . Pt r ds tPt r. long l ongCount); 

PasToZero(XCmdBlockPtr, StringPtr pasStr): 
ZeroToPas ( XCmdBl ockPtr, unsigned char *zeroStr, Stri ngPtr 

StrTolong(XCmdBlockPtr, unsigned char * strPtr): 
StrToNum(XCmdBlockPtr, unsigned char *str); 

StrToBool(XCmdBlockPtr,unsigned char *str>: 
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pascal void 
pascal Handle 
pascal long 
pascal Ptr 
pascal void 
pascal Handle 
pascal void 
pasStr); 
pascal long 
pascal long 
pascal Boolean 
pascal void 
pascal void 
pascal void 
pascal void 
*mystr): 
pascal void 
pascal void 
pascal Handle 

StrToExt(XCmdBlockPtr.unsigned char *str. double *myext); 
LongToStr(XCmdBlockPtr, long posNum. unsigned char *mystr); 
NumToStr(XCmdBlockPtr. long num, unsigned char *mystr); 
NumToHex(XCmdBlockPtr, long num. short nDigits, unsigned char 

BoolToStr(XCmdBlockPtr, Boolean bool, unsigned char *mystr): 
ExtToStr(XCmdBlockPtr, double *myext, unsigned char *mystr): 

GetGlobal(XCmdBlockPtr, StringPtr globName): 
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pascal void SetGlobalCXCmdBlockPtr. StringPtr globName, Handle globValue): 
pascal Handle GetFieldByName(XCmdBlockPtr, Boolean cardFieldFlag, StringPtr 
fieldName); 
pascal Handle GetFieldByNum(XCmdBlockPtr, Boolean cardFieldFlag, short fieldNum); 
pascal Handle GetFieldByID(XCmdBlockPtr.Boolean cardFieldFlag, short fieldID); 
pascal void SetFieldByName(XCmdBlockPtr. Boolean cardFieldFlag, StringPtr 
fieldName, Handle fieldVal); 
pascal void SetFieldByNum(XCmdBlockPtr, Boolean cardFieldFlag, short 
fieldNum,Handle fieldVal); 
pascal void SetFieldByID(XCmdBlockPtr, Boolean cardFieldFlag, short 
fieldID,Handle fieldVal): 
pascal Boolean StringEqual(XCmdBlockPtr. unsigned char *strl. unsigned char *str2); 
pa sea 1 void ReturnToPa s ( XCmdB 1 ockPtr. Ptr zeroSt r. St ri ngPtr pas Str); 
pa sea 1 void ScanToReturn ( XCmdBl ockPt r. Pt r *scanHndl): 
pascal void ScanToZero<XCmdBlockPtr. Ptr *scanHndl); 

BoolToStr.c 

#include "HyperXCmd.h" 

I* Convert a boolean to 'true' or 'false'. Instead of returning 
a new string, as Pascal does, it expects you to create mystr 

and pass it in to be filled. */ 
pascal void 
BoolToStr(paramPtr,bool ,mystr) 
register XCmdBlockPtr paramPtr; 
Boolean bool: 
St r 31 mys tr : 
I 

paramPtr->inArgs[OJ = (long)bool; 
paramPtr->inArgs[lJ = (long)mystr; 
paramPtr->request = xreqBoolToStr: 

(*paramPtr->entryPoint)(); 

EvalExpr.c 

#include <MacTypes.h> 
#include "HyperXCmd.h" 

I* Evaluate a HyperCard expression and return the answer. The answer is 
a handle to a zero-terminated string. 

*/ 
pas ca 1 Handle 
EvalExpr(paramPtr.expr) 
register XCmdBlockPtr paramPtr; 
StringPtr expr: 
I 

paramPtr->inArgs[OJ = (long)expr; 
paramPtr->request = xreqEvalExpr; 

(*paramPtr->entryPoint)(); 
return (Handle)paramPtr->outArgs[OJ; 
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ExtToStr.c 

#include "HyperXCmd.h" 

I* Original comment: 
Convert an extended long integer to decimal digits in a string. 
Instead of returning a new string, as Pascal does, it expects 

you to create mystr and pass it in to be filled. */ 

/* My comment: 

*I 

I assume that an extended is supposed to be an 80-byte double. 
which is declared as double in LSC. I've changed "extended" to 
"double" to reflect this 

pascal void 
ExtToStr(paramPtr,myext,mystr) 
register XCmdBlockPtr paramPtr: 
double * myext: 
St r 31 mys t r : 
I 

paramPtr->inArgs[OJ = (long)myext: 
paramPtr->inArgs[l] = (long)mystr: 
paramPtr->request = xreqExtToStr; 

(*paramPtr->entryPoint)(); 

GetFieldBylD.c 

#include "HyperXCmd.h" 

/* Return a handle to a zero-terminated string containing the value of 
the field whise ID is fieldID. You must dispose of the handle. 

*I 
pascal Handle 
GetFieldByID(paramPtr,cardFieldFlag,fieldID> 
register XCmdBlockPtr paramPtr: 
Boolean cardFieldFlag; 
short fieldID: 
I 

paramPtr->inArgs[O] = (long)cardFieldFlag; 
paramPtr->inArgs[l] = fieldlD; 
paramPtr->request = xreqGetFieldBylD: 

(*paramPtr->entryPoint)(); 
return (Handl e>paramPtr->outArgs[O]: 

GetFieldByName.c 

#include "HyperXCmd.h" 

/* Return a handle to a zero-terminated string containing the value of 
field fieldName on the current card. You must dispose the handle. 

*/ 
pascal Handle 
GetFieldByName(paramPtr.cardFieldFlag.fieldName) 
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register XCmdBlockPtr paramPtr; 
Boolean cardFieldFlag; 
StringPtr fieldName: 
I 

paramPtr->inArgs[O] = (long)cardFieldFlag; 
paramPtr->inArgs[l] = (long)fieldName; 
paramPtr->request = xreqGetFieldByName; 

(*paramPtr->entryPoint)(); 
return (Handle)pararnPtr->outArgs[OJ: 

GetFieldByNum.c 

#include NHyperXCmd.h" 

Macintosh Programming Primer 

I* Return a handle to a zero-terminated string containing the value of 
field fieldNum on the current card. You must dispose of the handle. 

*I 
pascal Handle 
GetFieldByNum(paramPtr, cardFieldFlag,fieldNum) 
register XCmdBlockPtr paramPtr: 
Boolean cardFieldFlag; 
short fieldNum; 
I 

paramPtr->inArgs[O] = Clong)cardFieldFlag; 
paramPtr->inArgs[l] = fieldNum: 
paramPtr->request = xreqGetFieldByNum: 

C*paramPtr->entryPoint)(); 
return CHandle)paramPtr->outArgs[OJ; 

GetGlobal.c 

#include "HyperXCmd.h" 

I* Return a handle to a zero-terminated string containing the value of 
the specified HyperTalk global variable. 

*/ 
pascal Handle 
GetGlobal(paramPtr,globName) 
register XCmdBlockPtr paramPtr; 
StringPtr globName; 
I 

paramPtr->inArgs[OJ = (long)globName; 
paramPtr->request = xreqGetGlobal: 

C*paramPtr->entryPoint)(); 
return CHandl e)paramPtr->outArgs[OJ: 
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LongToStr.c 

#include "HyperXCmd.h" 

I* Convert an unsigned long integer to a Pascal string. Instead of 
returning a new string, as Pascal does, it expects you to 
create mystr and pass it in to be filled. 

*I 
pas ca 1 void 
LongToStr(paramPtr, posNum. mystr) 
register XCmdBlockPtr paramPtr; 
long posNum; 
St r 31 mys tr : 
I 

paramPtr->inArgs[OJ = posNum: 
paramPtr->inArgs[l] = (long)mystr; 
paramPtr->request = xreqlongToStr; 

C*paramPtr->entryPoint)(); 

NumToHex.c 

#include "HyperXCmd.h" 

/* Convert an unsigned long integer to a hexadecimal number and put it 
into a Pascal string. Instead of returning a new string, as 
Pascal does, it expects you to create mystr and pass it in to be filled. 

*I 
pas ca 1 void 
NumToHex(paramPtr. num, nDigits. mystr) 
register XCmdBlockPtr paramPtr; 
long num; 
short nDigits; 
St r 31 mys t r ; 
I 

paramPtr->inArgs[OJ = num; 
paramPtr->inArgs[l] = nDigits; 
paramPtr->inArgs[2] = (long)mystr: 
paramPtr->request = xreqNumToHex; 

(*paramPtr->entryPoint)(); 

NumToStr.c 

#include "HyperXCmd.h" 

/*Convert a signed long integer to a Pascal string. Instead of 
returning a new string, as Pascal does. it expects you to 

create mystr and pass it in to be filled. 
*I 

pasca 1 void 
NumToStr(paramPtr.num,mystr) 
register XCmdBlockPtr paramPtr; 
long num: 
St r 31 mys tr ; 
I 
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paramPtr->inArgs[O] = num: 
paramPtr->inArgs[l] = (long)mystr: 
paramPtr->request = xreqNumToStr: 

(*paramPtr->entryPoint)(); 

PasToZero.c 

#include "HyperXCmd.h" 

Macintosh Programming Primer 

I* Convert a Pascal string to a zero-terminated string. Returns a handle 
to a new zero-terminated string. The caller must dispose the handle. 
You'll need to do this for any result or argument you send from 
your XCMD to HyperTalk. Note that if you use C-format strings, you won't 
need to do this from C. 

*/ 
pascal Handle 
PasToZero{paramPtr,pasStr) 
register XCmdBlockPtr paramPtr: 
StringPtr pasStr: 
I 

paramPtr->inArgs[O] = (long)pasStr; 
paramPtr->request = xreqPasToZero: 

{*paramPtr->entryPoint){); 
return {Handle)paramPtr->outArgs[OJ: 

ReturnToPas.c 

#include "HyperXCmd.h" 

I* zeroStr points into a zero-terminated string. Collect the 
characters from there to the next carriage Return and return 
them in the Pascal string pasStr. If a Return is not found. 
collect chars until the end of the string. 

*I 
pascal void 
ReturnToPas(paramPtr.zeroStr,pasStr) 
register XCmdBlockPtr paramPtr; 
Ptr zeroStr: 
StringPtr pasStr: 
I 

paramPtr->inArgs[OJ = (long)zeroStr; 
paramPtr->inArgs[lJ = (long)pasStr: 
paramPtr->request = xreqReturnToPas; 

(*paramPtr->entryPoint)(); 



Appendix F: Building HyperCard XCMDs 

ScanToReturn.c 

#include "HyperXCmd.h" 

/* Move the pointer scanPtr along a zero-terminated 
string until it points at a Return character 
or a zero byte. 

*I 
pascal void 
ScanToReturnCparamPtr,scanHndl) 
register XCmdBlockPtr paramPtr; 
Ptr * scanHndl: 
I 

paramPtr->inArgs[OJ = Clong)scanHndl; 
pararnPtr->request = xreqScanToReturn; 

(*paramPtr->entryPoint)(); 

ScanToZero.c 

#include "HyperXCmd.h" 

I* Move the pointer scanPtr along a zero-terminated 
string until it points at a zero byte. 

*/ 
pascal void 
ScanToZero(paramPtr,scanHndl) 
register XCmdBlockPtr paramPtr; 
Ptr * scanHndl: 
I 

paramPtr->inArgs[OJ = (long)scanHndl: 
paramPtr->request = xreqScanToZero; 

(*paramPtr->entryPoint)(); 

SendCard.Message.c 

#include "HyperXCmd.h" 

/* Send a HyperCard message Ca command with arguments) to the current card. 
msg is a pointer to a Pascal-format string. 

*I 
pascal void 
SendCardMessage<paramPtr, msg) 
register XCmdBlockPtr paramPtr; 
StringPtr msg; 
I 

paramPtr->inArgs[OJ = Clong)msg; 
paramPtr->request = xreqSendCardMessage; 

C*paramPtr->entryPoint)(); 
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SetFieldByID.c 

#include "HyperXCmd.h" 

I* Set the value of the field whose ID is fieldID to be the zero­
terminated string in fieldVal. The contents of the Handle are 
copied. so you must still dispose it afterwards. 

*I 
pascal void 
SetFieldBylO(paramPtr,cardFieldFlag,fieldID.fieldVal) 
register XCmdBlockPtr paramPtr: 
Boolean cardFieldFlag; 
short fieldID; 
Handle fieldVal; 
I 

paramPtr->inArgs(OJ = (long)cardFieldFlag; 
paramPtr->inArgs[l] = fieldID: 
paramPtr->inArgs[2J = (long)fieldVal: 
paramPtr->request = xreqSetFieldByID: 

(*paramPtr->entryPoint)(); 

SetFieldByName.c 

#include "HyperXCmd.h" 

I* Set the value of field fieldName to be the zero-terminated string 
in fieldVal. The contents of the Handle are copied, so you must 
still dispose it afterwards. 

*I 
pascal void 
SetFieldByName(paramPtr.cardFieldFlag.fieldName,fieldVal) 
register XCmdBlockPtr paramPtr: 
Boolean cardFieldFlag; 
StringPtr fieldName; 
Handle fieldVal; 
I 

paramPtr->inArgs(OJ = (long)cardFieldFlag; 
paramPtr->inArgs[l] = (long)fieldName; 
paramPtr->inArgs[2J = (long)fieldVal: 
paramPtr->request = xreqSetFieldByName; 

(*paramPtr->entryPoint)(); 

SetFieldByNum.c 

#include "HyperXCmd.h" 

I* Set the value of field fieldNum to be the zero-terminated string 
in fieldVal. The contents of the Handle are copied, so you must 
still dispose it afterwards. 

*/ 
pas ca 1 void 
SetFieldByNum(paramPtr,cardFieldFlag,fieldNum.fieldVal) 
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register XCmdBlockPtr paramPtr; 
Boolean cardFieldFlag; 
short fieldNum; 
Handle fieldVal: 
I 

paramPtr->inArgs[OJ = (long)cardFieldFlag: 
paramPtr->inArgs[l] = fieldNum: 
paramPtr->inArgs[2J = (long)fieldVal: 
paramPtr->request = xreqSetFieldByNum: 

(*paramPtr->entryPoint)(); 

SetGlobal.c 

#include "HyperXCmd.h" 

/* Set the value of the specified HyperTalk global variable to be 
the zero-terminated string in globValue. The contents of the 
Handle are copied, so you must still dispose it afterwards. 

*I 
pascal void 
SetGlobal(paramPtr.globName.globValue) 
register XCmdBlockPtr paramPtr; 
StringPtr globName: 
Handle globValue: 
I 

paramPtr->inArgs[OJ = (long)globName: 
paramPtr->inArgs[lJ = Clong)globValue: 
paramPtr->request = xreqSetGlobal: 

(*paramPtr->entryPoint)(); 

StringEqual.c 

#include "HyperXCmd.h" 

/* Return true if the two strings have the same characters. 
Case insensitive compare of the strings. 

*I 
pascal Boolean 
StringEqual(paramPtr,strl.str2) 
register XCmdBlockPtr paramPtr: 
unsigned char * strl; 
unsigned char * str2: 
I 

paramPtr->inArgs[OJ = Clong)strl: 
paramPtr->inArgs[l] = (long)str2; 
paramPtr->request = xreqStringEqual: 

(*paramPtr->entryPoint)(); 
return CBoolean)paramPtr->outArgs[OJ: 
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StringLength.c 

#include "HyperXCmd.h" 

/* Count the characters from where strPtr points until the next zero byte. 
Does not count the zero itself. strPtr must be a zero-terminated string. 

*/ 
pascal long 
StringlengthCparamPtr.strPtr) 
register XCmdBlockPtr paramPtr: 
StringPtr strPtr; 
{ 

paramPtr->inArgs[OJ = Clong)strPtr; 
paramPtr->request = xreqStringlength; 

(*paramPtr->entryPoint)(); 
return paramPtr->outArgs[OJ; 

StringMatch.c 

#include "HyperXCmd.h 0 

/* Perform case-insensitive match looking for pattern anywhere in 
target, returning a pointer to first character of the first match, 
in target or NIL if no match found. pattern is a Pascal string, 
and target is a zero-terminated string. 

*/ 
pascal Ptr 
StringMatch(paramPtr, pattern. target) 
register XCmdBlockPtr paramPtr; 
StringPtr pattern; 
Ptr target; 
I 

paramPtr->inArgs[OJ = (long)pattern; 
paramPtr->inArgs[l] = Clong)target: 
paramPtr->request = xreqStringMatch; 

(*paramPtr->entryPoint)(); 
return CPtr)paramPtr->outArgs[OJ; 

StrToBool.c 

#include "HyperXCmd.h" 

I* Convert the Pascal strings 'true· and 'false' to booleans. 
*/ 

pascal Boolean 
StrToBool(paramPtr,str) 
register XCmdBlockPtr paramPtr; 
Str31 str; 
I 

paramPtr->inArgs[OJ = (long)str; 
paramPtr->request = xreqStrToBool: 

(*paramPtr->entryPoint)(); 
return (Boolean)paramPtr->outArgs[OJ: 
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StrToExt.c 

#include "HyperXCmd.h" 

I* Ori gi na 1 comment: 
Convert a string of ASCII decimal digits to an extended long integer. 

Instead of returning a new extended. as Pascal does. it expects you 
to create myext and pass it in to be filled. */ 

/* My comment: extended, as far as I know. is an 80-bit double, not a 
long integer. Since LSC doubles are 80-bit. I've changed myext to 
a pointer to a double */ 

pascal void StrToExt(paramPtr, str, myext) 
register XCmdBlockPtr paramPtr; 
Str31 str; 
double * myext: 
I 

paramPtr->inArgs[OJ = Clong)str: 
paramPtr->inArgs[lJ = Clong)myext: 
paramPtr->request = xreqStrToExt; 

C*paramPtr->entryPoint)(): 
l 
I* FUNCTION StrToExt(str: Str31): Extended; 
VAR x: Extended: 
BEGIN 

WITH paramPtrA DO 
BEGIN 

inArgs[lJ := ORDC@str): 
i n Ar gs [ 2 ] : = 0 RD ( @x ) ; 
request := xreqStrToExt; 
DoJsr(entryPoint); 
StrToExt x: 

END; 
END; *I 

StrToLong.c 

#include "HyperXCmd.h" 

I* Convert a string of ASCII decimal digits to an unsigned long integer. 
*/ 

pascal long 
StrTolongCparamPtr, strPtr) 
register XCmdBlockPtr paramPtr: 
Str31 strPtr; 
I 

paramPtr->inArgs[O] = (long)strPtr: 
paramPtr·>request = xreqStrTolong; 

(*paramPtr->entryPoint)(); 
return (long)paramPtr->outArgs[O]: 
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StrToNum.c 

#include "HyperXCmd.h" 

I* Convert a string of ASCII decimal digits to a signed long integer. 
Negative sign is allowed. 

*I 
pascal long 
StrToNum(paramPtr. str) 
register XCmdBlockPtr paramPtr; 
Str31 str; 
I 

paramPtr->inArgs[OJ = (long)str: 
paramPtr->request = xreqStrToNum: 

(*paramPtr->entryPoint)(); 
return paramPtr->outArgs[OJ: 

ZeroBytes.c 

#include "HyperXCmd.h" 

I* Write zeros into memory starting at destPtr and going for longCount 
number of bytes. 

*I 
pascal void 
ZeroBytes (pa ramPt r, dst Pt r. 1 ongCount) 
register XCmdBlockPtr paramPtr: 
Ptr dstPtr; 
long longCount: 
I 

paramPtr->inArgs[O] = Clong)dstPtr: 
paramPtr->inArgs[l] = longCount: 
paramPtr->request = xreqZeroBytes: 

(*paramPtr->entryPoint)(); 

ZeroToPas.c 

#include "HyperXCmd.h" 

I* Fill the Pascal string with the contents of the zero-terminated 
string. Useful for converting the arguments of any XCMD to 
Pascal strings. 

*/ 
pascal void 
ZeroToPas(paramPtr.zeroStr,pasStr) 
register XCmdBlockPtr paramPtr: 
unsigned char *zeroStr: 
StringPtr pasStr: 
I 

paramPtr->inArgs[OJ = Clong)zeroStr: 
paramPtr->inArgs[l] = (long)pasStr: 
paramPtr->request = xreqZeroToPas: 

(*paramPtr->entryPoint)(); 
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Finder flags, 369-70 

Finder resources, 356 
BNDL,369,376-80 
categories, 357 
FREF,375-76 
ICN#,371-74 
installing, 366-80 
signature, 357, 380-84, 389 
SIZE,357,390-91 
vers,357,382,386-90 

FindWindow(),137,328-29 
Flags,finder,369-70,488 
FlushEvents(),67 
Flying Line program 

code,96-101,425-28 
description of, 60, 92-95 
running, 96 

fName, 311 
Folders, 310 
Font, 56 

application, 69 
in Hello2 program, 69-70 
InitFonts(),67 
Manager, 67 
system, 69 

F r am e A r c ( ) , 82 
FrameRoundRect(),80 
FR E F (File Reference Resource), 

375-76 
FSCl ose( ), 311 
FSOpen ( ), 311 
FSRead ( ), 311 
Full Titles, 492 
FUNCT I ONs, 27 

gAppleMenu,172,175 
gClockWindow,172 
gCurrentStyle,172, 181 
gCurrentTime, 172 
gCurRow,126 
gOone,126,172 
gOragRect,126,172 
Get Clip(), 140 
GetDitem( ), 212 
GetFieldByID.c,511 
GetFieldByName.c,511-12 
GetFieldByNum.c,512 
Get Fil eName C ) , 318, 324, 470 
GetGlobal .c,512 
Get Info, 491 
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GetIText( ), 211 
GetNewWindow(),26-27,52 
GetNextEvent(), 109,110, 111-12 
Get P i c t u re ( ) , 89 
GetScrap( ), 297 
gEventWindow,113,124,126 
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gFontMenu, 172,175 
gLastFont,172 
Global coordinate system, 45 
Global variables, 67 
gMaxRow,126 
Go-away box, 49 
gOldTime, 172 
gPictureHandle,126 
gPictureWindow, 88,90 
gPictWindow,124, 125, 126 
gPopUpRect,195 
Gra fPort data structure, 54 
Grow box, 49 
GrowWindow(), 138 
g Size Re ct, 126 
gStyleMenu, 172,175 
gTheEvent, 126 
gThePicture,88 
gWNEimplemented,126,172 

HandleAppleChoice() 
in Reminder, 234, 252-53, 453-54 
in Timer, 168, 179, 441-42 
in WindowMaker, 279, 290, 464 

HandleDialogC ),236-37,254-57, 
455-56 

HandleEditChoice(),280,291 
HandleEvent(),109 

in EventTutor, 118-20, 129-30, 
431-33 

inPager,335,342,474-75 
in Reminder, 233, 250, 452 
in Timer, 165, 176-77, 439-40 
in WindowMaker, 276-77, 287, 

462 
in Zinger, 186, 194, 447 

HandleFileChoice() 
in Reminder, 235, 252-54, 454-55 
in Timer, 169, 180, 442 
in WindowMaker, 279, 290-91, 

464 
HandleFontChoiceC ),169,175, 

180-81,442 
HandleMenuChoice() 

in Reminder, 234, 251-52, 453 
in Timer, 168, 176, 178-79, 441 
in WindowMaker, 278-79, 289-90, 

463 
HandleMouseDown() 

in EventTutor, 120-21, 138, 
434-35 

inPager,335-36,342-43,475-76 
in Reminder, 233, 251, 452-53 
in Timer, 167, 176, 177-78, 440-41 
in WindowMaker, 277, 288, 463 
in Zinger, 186-87, 195, 447-48 

Index 

HandleNul 1 ( ),167,176,177,440 
Handles, 88-89, 256 
Handl eStyl eChoi ce< ), 169-70, 

181-82,443 
Hello, World program 

adding libraries, 40-41 
creating a new project, 35-37 
entering source code, 37-40 
problem with, 41 
running,41 

Hello.c,420 
Hello2.c,420-21 
Hello2 program 

adding an icon to, 370-75 
changing fonts, 69-70 
changing text size, 71 
changing text style, 70-71 
code,62-64,66-69 
completing a standalone 

application, 358-59 
running, 65 
setting up, 60-62 

Hi deWi ndow( ), 52 
Hierarchical Filing System (HFS), 

307,310 
Hierarchical menu, 146-4 7 
Hierarchical submenu IDs, 157 
HyperCard, 9 

buttons, 202 
X CM Os, 18, 505-20 

HyperTalk, 506 
HyperXCmd.h,508-10 

ICN#,371-74 
Icon 

adding an, to Hello2, 370-75 
application, 357 
mask, 371 

Icons ( ' S I C N ' ), 220 
ID, resource versus local, 376 
Ignore Case, 487 
#include statement, 28, 420 
I n fo Sc r a p ( ) , 296 
Info World, 398 
I n i t Cu r s o r ( ) , 68 
InitDi al ogs( ), 68 
Inited bit, 369 
In it Fonts C ) , 67 
In itGraf ( ), 67 
InitMenus(),67,68 
InitWindows(),67,68 
InsertMenu( ),175 
Inside Macintosh, 398-400 
Interface, 2, 3-4 
InvalRect(),138,139 
I nvertArc ( ), 82 
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InvertRoundRect(),81 
Invisible bit, 369 
IsDAWindow(),278,288,289 

keyDown. 105 
KeyRepThresh,105 
Key Thresh, 105 
keyUp, 105 

Libraries, adding, 40-41 
Lines,drawing,55 
Lineslnit( ),94,99,426 
Li n e To ( ) , 55 
Linker errors, 501-2 
Lisa, 4 
Load Library, 491 
LoadPicture() 

in EventTutor, 117, 128, 430 
in ShowPICT, 90, 424 
in WindowMaker, 276, 286, 

461 
Lo a d Sc r a p ( ) , 296 
Local coordinate system, 46 
LocalToGlobal(),195 
Locked flag, 369 
LongToStr.c,513 

MacDraw, 58 
Macintosh 

background of, 2-3 
books on, 401 
compatibility of, 5 
Developer Technical Support, 

402 
Filing System (MFS), 307, 

310 
periodicals, 398 
Programmer's Workshop 

(MPW), 7, 403 
structure of a program, 59, 

107-9 
technical references for, 

400-401 
writing applications, 10 

MacPaint, 58 
MacsBug, 403 
MacTraps, 40 
MacTutor, 398 
MacUser, 398 
MacWeek, 398 
MacWorld, 398 
main ( ) 

in EventTutor, 116, 126, 129, 
429 

in Flying Line, 93, 97, 425 

in Hello2, 66, 420 
in Mondrian, 76, 421 
in Pager, 333, 339, 4 73 
in PrintPICT, 317, 323, 469 

527 

in Reminder, 230, 246-47, 449-50 
in ShowClip, 301, 304, 466 
in ShowPICT, 89, 423 
in Sounder, 350, 352, 478 
in Timer, 164, 173, 437 
in WindowMaker, 275, 285, 461 
in Zinger, 183, 191, 444 

Main event loop, 108-9 
Mainloop() 

in EventTutor, 117, 431 
in Flying Line, 94, 99-100, 426-27 
in Mondrian, 77, 422 
in Pager, 335, 341, 474 
in Reminder, 232, 250, 452 
in ShowClip, 301-2, 305-6, 467-68 
in Timer, 166, 175, 439 
in WindowMaker, 276, 287, 462 
in Zinger, 185, 194, 447 

Make ... ,491 
MakeSound(),351,353,479 
Managers, 4-5 

See also under type of 
Match Words, 487 
MBAR, 149 

resource for Reminder, 222-23 
resource for Timer, 150-52 
resource for WindMaker, 266 

Menu(s) 
adding, 148-49 
bar, 144 
creating your own, 147 
edit,224,226-27,362,486-89 
file,224-25,362,485-86 
hierarchical, 146-47 
hierarchical submenu IDs, 157 
InitMenus(),67,68 
items, 145 
parts of, 144-46 
pop-up,147 
project, 482-85 
pull down, 146 
ResEdit, 362 
resources for Reminder, 222-27 
resources for WindowMaker, 

266-73 
search, 489-90 
source, 491 
tear-off, 148 
window, 492 

MenuBarlnit() 
in Reminder, 232, 249, 451 
in Timer, 165, 174-75, 438-39 
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Menu Ba r I n i t ( ) (cont.) 
in WindowMaker, 275, 285-86, 

294-95,461 
in Zinger, 184, 192, 445 

Minimalist, 391-94 
ModalDialog(),210 
Modal dialogs, 199-200, 201 
Modeless dialogs, 200, 201 
Mode of text, 58 
Mondrian program 

code, 76-79,421-23 
description of, 56, 57, 60, 73 
resources, 73-75 
running, 75-76 
variants, 79-83 

More Memory, 488 
Mounted volume, 361 
mouseDown,105,137-41 
mouseMoved, 106 
mouseRgn, 112 
mouseUp,105 
Multi-File Search, 490 
MultiFinder 

Aware, 483 
-friendly applications, 242 
Notification Manager and, 199 
Printer driver, 369 
purpose of, 109-10 
SIZE resource, 357 

Multi-Segment box, 484 

Name field, 484 
networkEvt,106,133, 134 
New, 486 
NewControl(),327-28 
NewHandl e( ), 312 
New Project, 482 
NewWi ndow( ), 98 
NM Inst a 11 ( ) , 214 
NMRec,213-14 
NMRemove( ), 214 
noGrowDocProc window, 49, 50 
Note alerts, 206 
Notification Manager 

MultiFinder and, 199 
purpose of, 212 
resources for, 220-22 
structure, 213-14 

Not i f y I n i t ( ) , 232, 249-50, 
451-52 

nullEvent,105,130, 176 
NumToHex.c,513 
NumToStr.c,513-14 

On Desk flag, 369 
Open, 486 

Open Project, 482 
Open Selection, 486 
Options, 487 
Owner ID, 374 
Owner Type, 37 4 

Pager 
code,333-46,472-78 
description of, 329 
how it works, 338-46 
resources for, 329-32 
setting up, 329 

P a i n t Arc ( ) , 82 

Index 

Pai n t 0 val ( ) , 78 
PaintRect(),79,99 
PaintRoundRect(),79 
Parameters, passing, 30-31, 292 
Pa ramText ( ), 211 
Pascal 

data type compared with C, 27-28 
strings, 29 

PasToZero.c,514 
PC Week, 398 
Pen, changing graphics, 53-54 
P ICTs, 58 
Pictures, drawing, 58 
Pixels, 44 
p 1 a in DB ox window, 49, 51 
Pop-up menu, 14 7 
PopUpMenuSelect(),195 
PrCl ose( ), 312 
PrCloseDoc(),312 
PrClosePage(),312 
Precompile ... , 491 
Preference, 487 
Preload resources, 37 4 
Print, 486 
PrintDefault( ),323 
Printer driver, 369 
Printing Manager, 307, 312 
Printlnit(),317,323-24,470 
PrintPICT 

code,314,316-19,322-26,469-72 
description of, 312-13 
File Manager, 307, 309-11 
how it works, 321-26 
resources for, 313-19 
running, 320 
setting up, 313 
Standard File Package, 307-9 

Pri ntPi ct Fi 1 e( ), 318-19, 325, 
471-72 

Print Setup, 486 
P r Job Di a l o g ( ) , 312 
PROCEDUREs, 27 
Profile, 488 



Index 

Projectfile,8-9,36,62 
Project menu, 482-85 
Project Window, 492 
Pr Open (), 312 
P rOpen Doc ( ) , 312 
PrOpenPage(),312 
PrPicFile(),312,323,326 
PrStlDialog(),312 
Pt o Cs t r ( ) , 29 
Pulldown menu, 146 
Purgeable resources, 374 
PutScrap(),296-97 

QuickDraw 
coordinate system, 44-48 
programs, 60-69 
purpose of, 11, 44 
toolbox routines, 53-59 

Quit, 486 

Radio buttons, 202-3 
Randomize() 

in Flying Line, 95, 100, 427 
in Mondrian, 79, 422-23 

RandomRect() 
in Flying Line, 94, 100, 427 
in Mondrian, 77-78, 422 

randSeed, 67, 77 
rDocProc window,49,51 
Recalcline(),95,101,427-28 
Rect, 30 
refNum, 311 
Regions,defining,58, 136-37 
Reminder 

adding menu resources, 222-27 
adding Notification Manager 

resources,220-22 
code,229-40,244-61,448-60 
description of, 215 
resources for, 216-28 
running,241-44 
setting up, 215 

Remove Objects, 485 
ResEdit 

creating W I ND resource, 364 
how it works, 361-66 
installing finder resources, 366-80 
making alerts in, 207 
making dialogs in, 204-5 
menus, 362 
notes on using, 360 
purpose of, 6, 25-26, 356 

Resource(s) 
adding menu, 222-27 
alert, 218-19 
bundle, 376-80 

CODE,34,484 
description of, 2, 5-6 
dialog, 216-17 
EventTutor, 114-22 
File Reference, 375-76 
forks, 34-35, 370 
hierarchical submenu IDs, 157 
ID number, 33 
Manager, 341 
map, 369 
modifying, 211 
Mondrian, 73-75 
naming, 33-34 
Notification Manager, 220-22 
Pager,329-32 
PrintPICT,313-19 
Reminder, 216-19 
ShowClip, 298-300 
ShowPICT, 84-87 
signature, 357, 380-84, 389 
SIZE,357,390-91 
Sounder,347-49 
Timer, 150-63 
type, 32-33 
vers,357,382,386-90 
WindowMaker, 265-73 
Zinger, 183-90 
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See also Finder resources 
RestoreSettings(),238,258, 

457-58 
ReturnToPas.c,514 
Revert, 486 
RgnHandle,136 
RMaker,356 
ROM (read-only memory), 32 
Routines, naming, 32 
Run, 485 

Save,486 
Save A Copy As, 486 
Save All, 492 
Save As, 486 
Sa veSet tings ( ) , 237-38, 257, 

456-57 
ScanToZero.c,515 
Scrap Manager, 295 

GetScrap( ), 297 
I n f o Sc r a p ( ) , 296 
Lo a d Sc r a p < ) , 296 
PutScrap(),296-97 
UnloadScrap(),296 
Z e r o Sc r a p ( ) , 296 

screenBits, 67, 98 
Scroll bars 

how to set up, 327-29 
purpose of, 48, 203 
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Scro 11 P roe ( ) , 336-37, 344, 
476 

ScrollRect( ), 135, 136 
Scro 11 Wi n d ow ( ) , 120, 135, 

137,434 
Search menu, 489-90 
Search options, 48 7 
SelectWindow(),137 
SendCardMessage.c,515 
Set Cl i p ( ) , 140 
SetFieldByID.c,516 
SetFieldByName.c,516 
SetFieldByNum.c,516-17 
SetGl oba 1 . c, 517 
SetIText( ), 211 
SetNotification(),240, 

260-61,459-60 
Set Po rt ( ) , 54, 99 
Set Project Type ... , 125, 482 
Set Rec t ( ) , 98 
SetUpDragRect() 

in EventTutor, 117, 128-29, 
137,430 

in Pager, 334, 340, 474 
in Reminder, 232, 249, 451 
in Timer, 165, 17 4, 438 
in WindowMaker, 276, 286, 

462 
in Zinger, 184, 192, 445 

SetupEventWi ndow( ), 117, 
128,430 

Set U p Sc r o 1 l Ba r ( ) , 334, 
341,474 

SetUpSizeRect( ),117, 129, 
430-31 

SFGetFi le(), 307, 308-9, 
311 

S F P u t Fil e ( ) , 307 
SFTypeL i st, 309 
Shapes, drawing, 56 
Shared flag, 369 
Shift left and right, 487 
ShowClip, 295 

code,300-303,304-7, 
466-68 

description of, 297 
how it works, 304-7 
resources for, 298-300 
running,303 
setting up, 298 

Show PICT 
code,88-90,423-24 
description of, 60, 84 
resources, 84-87 

running,87-88 
window setup, 90-91 

ShowWi ndow< ), 52 

Index 

Signature resource, 357, 380-84, 389 
Size box, 48, 49 
Size of text, 56 
S I Z E resource, 357, 390-91 
SizeWindow(),138,139 
sleep, 112 
Sn d P 1 a y ( ) , 353 
Sound (' snd '), 220 
Sounder 

code,350-54,478-79 
description of, 347 
resources,347-49 
setting up, 34 7 

Sound Manager, 34 7 
Source Debugger, 489 
Source files, 24 
Source menu, 491 
Source window of the Debugger, 

494-95 
Spacing, 56 
srcBic,58 
srcCopy,58 
srcOr,58 
Standard File Package, 307-9 
Stop alerts, 206 
Stri ngEqual. c, 517 
Stringlength.c,518 
StringMatch.c,518 
Strings (' STR' ), 29 

resources for Notification 
Manager, 220 

resources for Pager, 331, 332 
resources for PrintPict, 313-14, 

315 
resources for ShowClip, 299-300 
resources for Sounder, 348 
resources for WindowMaker and, 

272-73 
StrToBool .c,518 
StrToExt.c,519 
StrToLong.c,519 
StrToNum.c,520 
Style, 56 
Sub ID, 374 
Suspend and Resume Events, 483 
Syntax errors, 500-501 
SysBeep< ), 195-96 
SysEnvirons(),244 
Sys60rlater(),231,247-48,450 
System bit, 369 
System font, 69 
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System Heap, 374 
SystemTask( ), 110 

Tabs, set, 486 
Tear-off menu, 148 
Technical Notes, 401 
TEini t( ), 68 
Text 

changing size, 71 
changing style, 70-71 
drawing,56-58 

TextEdit, 68 
Text Fon t ( ) , 69 
thePort,67 
THINKC 

description of, 8-9 
documentation for, 8 
installing, 24-26 
reasons for using, 7 
standards for writing, 31-32 
strings, 29 
summary of commands, 481-92 

Timer 
ALRT (alert) resource, 159, 161, 

163 
Apple menu specifications, 152 
code, 163-70, 172-82,436-44 
description of, 149-50 
DI TL (Dialog Item List), 159, 161 
edit menu specifications, 153-55 
file menu specifications, 152-53 
font menu specifications, 159 
resources, 150-63 
running, 170-72 
setting up, 150 
special menu specifications, 

155-59 
TMON,403-4 
Toolbox 

assessing, 26-28 
buttons, 202 
description of, 2, 4-5 
QuickDraw toolbox routines, 53-59 

Tool Boxlni t() 
in EventTutor, 116, 127, 429 
in Flying Line, 93, 97, 425 
in Hello2, 66, 420 
in Mondrian, 76-77, 421 
in Pager, 334, 340, 473 
in PrintPICT, 317, 323, 470 
in Reminder, 230, 247, 450 
in ShowClip, 301, 304, 467 
in ShowPICT, 90, 423 
in Sounder, 350, 352, 478-79 
in Timer, 164, 174, 437-38 
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in WindowMaker, 275, 285, 461 
in Zinger, 184, 191, 445 

TrackBox( ), 139 
TrackControl(),329,343 
Type ofresource, 484 

UnloadScrap(),296 
updateEvt 

EventTutor and, 130-31, 132-33 
importance of responding to, 176 
queueing of, 105 
Window Manager and 123, 136 

UpdateMyWi ndow( ), 337, 344-45, 
477 

User Debugger, 485 

Variables 
global, 67 
naming, 32 

vers resource, 357, 382, 386-90 
vis Rg n, 131-32 
Volumes, 309-10 

mounted, 361 
v Re fNum, 311 

WaitNextEvent() 
calling, 110, 129 
events and, 109, 111-12 
MultiFinder friendliness and, 242 

white, 67 
White space, 37 
Window(s) 

big long window technique, 45 
drawing in, 53-59 
InitWindows(),67,68 
Manager, 48, 123 
menu, 492 
parts, 48 
setting the current, 54 
setting up, 52-53 
types, 49-53 
visibility of, 52 

Windowlnit() 
in EventTutor, 116, 127, 429 
in Flying Line, 93, 98, 425-26 
in Hello2, 66, 68-69, 420-21 
in Mondrian, 77, 421 
in Pager, 334, 340, 4 73 
in ShowClip, 301, 305, 467 
in ShowPICT, 90-91, 423 
in Timer, 165, 174, 438 
in Zinger, 184, 192, 445 

Window Maker 
code,274-81,284-95,460-66 
description of, 264-65 
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Window Maker (cont.) 
how it works, 283 
resources for, 265-73 
running, 281-82 
setting up, 265 

W I N D resource 
creating a, 52, 364 
for EventTutor, 114 
for Hello2, 60 
for Mondrian, 73-75 
for Pager, 329, 330 
for Reminder, 227-28 
for ShowClip, 298 
for ShowPICT, 84 
for Timer, 150 
for WindowMaker, 265 
for Zinger, 183 

Wrap Around, 487 

XCMDs 
BoolToStr.c,510 
building, 507-8 
copying the, into a stack, 508 
Eva lExpr. c, 510 
ExtToStr. c,511 
GetFieldByID.c,511 
GetFieldByName.c,511-12 
GetFieldByNum.c,512 
GetGl oba l . c, 512 
HyperXCmd.h,508-10 
LongToStr.c,513 
NumToHex.c,513 

NumToStr.c,513-14 
PasToZero.c,514 
purpose of, 18 
ReturnToPas.c,514 
ScanToZero.c,515 
SendCardMessage.c,515 
SetFieldByID.c,516 
SetFieldByName.c,516 
SetFieldByNum.c,516-17 
SetGl oba l . c, 517 
Stri ngEqua l. c, 517 
Stringlength.c,518 
StringMatch.c,518 
StrToBool .c,518 
StrToExt.c,519 
StrTolong.c,519 
StrToNum.c,520 
XChooser,506-7 
ZeroBytes.c,520 
ZeroToPas.c,520 

Xerox Alto machine, 4 
X FCNs, 506 

ZeroBytes.c,520 
Z e r o Sc r a p C ) , 296 
ZeroToPas.c,520 
Zinger 

code, 190-96,444-48 
description of, 182 
resources for, 183-90 

Zoom box, 48, 492 
ZoomWindowC ),139 

Index 



Macintosh Programming 
Primer: 

Hero' a $25. Send me the Disk, 
quicklll Mail it to: 

ZapfChoncery 
24 Chicogo Drive 

The Disk! 

New York, New York 01893 

I/./.! 

Pay to the order of '¥/ '¥1'( 

Amount f; II 

D 

For a complete set of Macintosh Programming 
Primer applications, resources, and projects 
send the coupon on this page (or just send 
your name and address), along with a check 
for $25.00 to: 

MIMAC 
2534 North Jefferson Street 
Arlington, Virginia 22207 

Here's my $25! 

M/MAC 
2534 North Jefferson Street 
Arlington, Virginia 22207 

Send me the Primer Disk, 
quick!!! Mail the disk to: 

Companc,._~~~~~~~~~~-

Addres ___________ _ 

City,___ __ _ State__ Zip __ _ 

Virginia Residents Please Add 4.5% Sales Tax 
No Credit Cards, Please! 

Macintosh C 
Programming 

Primer: 

The Disk 

D 

Mac Primer Disk 
2534 N. Jefferson St. 
Arlington, Vuginia 22207 

Zapf Chancery 
24 Chicago Dri\-e 

D 

New York, New York 01893 



Macintosh® Programming 
Inside the Toolbox Using THINK's LightspeedC'" 

"If you're interested in learning to program the 
Macintosh, there isn't a better place to start than with the book 
you 're holding in your hands right now." 

- From the Foreword by Stephen Chernicoff 
(author of Macintosh Revealed) 

The Macintosh Programming Primer is a tutorial in the art of Macintosh program­
ming. Programmers new to the Macintosh but with some previous programming 
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